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Chapter 1 System Introduction 

This chapter introduces how to startup the system and describes the system 
interface, and also introduces the system tool bar in detail. 

§1.1 System Startup  

You can startup the system using any of the following methods: 
1. Double click the InteriCAD T5 shortcut on the WINDOWS desktop. 
2. Select Program from start menu, and then YFCAD Software/InteriCAD 

T5. 

§1.2 System Interface 

The system main window looks as follows: 

 
InteriCAD T5 includes three components, which are Modeling, 2D Design, 
Render. 
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§1.2.1 2D Design Interface 

 Menu Bar: Where software commands are placed, you can use them by 
clicking the left mouse button. 

 Tool Bar: Where most common commands are placed, you can use 
them by clicking the left mouse button. 

 Workplace: The specific area to construct drawing. 

 

§1.2.2 Introduction to Yuan Fang VR 

Interface 

Menu Bar: Where software commands are placed, you can use them by 

clicking the left mouse button. 

 Tool Bar: Where most common commands are placed, you can use 

them by clicking the left mouse button. 

 Workplace: The specific area to construct drawing. 
 Command Window: Where you can input commands. 
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 Status Bar: Display cursor, coordinate and mode status. 

 

§1.2.3 Modeling Design Interface 

 Menu Bar: Where software commands are placed, you can use them by 
clicking the left mouse button. 

 Tool Bar: Where most common commands are placed, you can use 
them by clicking the left mouse button. 

 Drawing Window: The area you construct drawing. The system defaults 

into four-view form. The one in the left upper corner is front view, in the 

left lower corner is top view, in the right upper corner is side view, and in 

the right lower corner is isometric view. 

 Command Window: Where you can input command. 
 Status Bar: Display cursor coordinate and mode status. 

 Construction Graph Screen Menu: Most common Construction Graph 

commands. 
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Chapter 2 2D Design 

§2.1 Interface 

The interface of 2D design is shown as below:  

 

The interface includes: 

Menu: All commands can be found in menu 

Toolbar: Shortcut icons of main commands can be found 

Design Wizard: Showing the steps of design  

Drawing space: Where you can draw the floor plan  

Furniture library: includes Yuan Fang system library and manufacturer‟s 

customized library. Left click to unfold each category and call certain piece of 

furniture 
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§2.2 Common Operation  

§2.2.1 Usage of the Mouse 

Left click: Most commands are accomplished by left click. For example: 

selecting pull-down menu, clicking icon on toolbar and etc.  

 

Right click:  

Some commands are ended by right click.  

For any existing object, right click it and the edit command will be shown. 

Note: No matter what command is being executed, right click and the 

command will exit.   

§2.2.2 Two Operation Rules  

Rule No.1: Select command first. Then follow the prompt to execute further 

operation.  

Rule No.2: Select object first. Then right click, and the exclusive edit menu 

towards the selected object will be shown. Note: every object has its unique 

edit menu. This menu cannot be found in the tool bar. 

§2.3 File Menu 

§2.3.1 New File 

Create a new drawing file. 

Basic operations: 

Click File  New in menu bar. 

Note: If any changes have been made to the current file, the system will ask 

you whether to save it. Click Yes, the system will save the file. If it is a new file, 

the file will be saved as a new file. 

Click No, the system will open a new file without saving the current file. 

If Cancel, the system will not open a new file. 
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§2.3.2 Open 

Open a previously saved file, which is in *.koc file format 

Basic operations: 

Click File  Open in menu bar. Select the file. 

§2.3.3 Save 

Save the current drawing file, which is in *.koc file format. 

Basic operations: 

Click File Save in menu bar. 

If the current file has been saved successfully, a File saved dialogue box will 

appear. 

If the current file is to be saved for the first time, it will display the Save dialogue 

box. 

In dialogue box, choose the file path and input the name of the file, then click 

Save button. 

§2.3.4 Save as 

Save the current drawing as a new file in a different name. 

§2.3.5 Export Image 

Export any selected area in the workspace to a bitmap drawing which is in *.jpg 

file format. 

Basic operations: 

1. Click File Export image in menu bar. 

2. Click the left top corner and right bottom corner of the exported bitmap. 

There is a rectangle. This is the export area of the bitmap. Define a 

rectangle area using the left click, and that is the range for exporting a 

jpg file. The system will show export image dialogue box, where the dpi 

and size of the export bitmap can be modified. Click Export button, and 

then select the file path and file name to be saved. 
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§2.3.6 Print 

Print the plot drawing. This function is the same as Print function in Navigation 

panel. 

Basic operations: 

1. Click File  Print in menu bar. 

2. The system will display the Print dialogue box. There are three ways you 

can choose: 

 Whole image area: print all content in the current view port.  

 Choose scope：print certain items, in the current view port. Press 

“Choose” button. First left click to indicate a corner of rectangle, and 

then move the mouse to the proper position to indicate the other 

corner on the cross. All objects inside the rectangle will be printed. 

 Choose frame： print the content within one frame.   

Note：You have to insert a frame before you use this function. As for how 

to insert a frame, please refer to command introduction of Insert image 

frame. 

 

 Print precision: define the precision of the printed image. High 

precision means high definition and quality. 

 Position: define the position in the paper to print the image. Select 

User defined to offset. 

 Ratio: Scale ratio compare to the real dimension 

3. Before printing, click Preview button. 

4. If you are not satisfied with the print out image, please click Printing setting 
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button to adjust. 

5. Click Print button to print. 

6. Click Cancel button to exit. 

§2.3.7 Print Setting 

Setup the paper size and layout (landscape or portrait). 

Basic operations: 

Select File  Print setting in menu bar. And the Print setting dialogue box will 

appear. In the square box you can adjust the paper size and layout (landscape 

or portrait) 

§2.3.8 Shortcut Setting 

Set shortcut for 2D design system. 

Click File  Shortcut setting in menu,  

The system will display the Customize dialogue box. Select the Group and 

Command, define a shortcut in the New shortcut box, and click Effect to 

confirm 

§2.3.9 Exit  

Select File  Exit in the menu bar that means to exit 2D design system.  

Note: 

If the current file has been modified, then it will display the Save dialogue box. 

§2.4 Object Edit Function 

§2.4.1 Select Object 

When you need to move, rotate, copy, delete an object, you need to select it 

first. You can either select one object in one time, or select multiple objects in 

one time.  
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Select one object in one time 

Select one command in Edit menu. The mouse becomes a red square. Now 

move the mouse to the object you want to select. The object will be highlighted 

in yellow, meaning the object has been selected.  

Select multiple objects in one time 

You can use region selection to select more than one object.  

§2.4.2 Undo 

After executing some wrong operations, you can use Undo command to return 

to the previous operation. There is no limit to the times of undo.  

Basic operations: 

Select Undo in the Edit menu using the left button, or click  button in the 

tool bar. 

§2.4.3 Redo 

After executing the Undo command, you can use Redo command to cancel 

that operation. 

Basic operations: 

Select Redo in the Edit menu 

§2.4.4 Move 

The command can move one or more objects in one time, which is usually 

used to adjust one set of furniture. 

Basic operations: 

1. Click Move in the Edit menu, or click  button in the tool bar. 

2. Click the object to be moved, and the selected object will display a node 

with highlighted yellow color. 

3.  After selecting, click the right button to finish the current operation. 

4.  Follow the instruction, click to choose the start point. Then move the 
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mouse. At the same time, it shows the relative displacement dynamically  

Note: you can simultaneously select and move multiple objects (the difference 

to the operation of moving an object, and the latter can only move one object). 

§2.4.5 Rotate 

The command can rotate one or more objects in one time, which is usually 

used to adjust a set of furniture. 

Basic operations: 

1. Click Rotate in the Edit menu, or click  button in the tool bar. 

2. According to the instruction, click the object. The selected object will 

display a node with highlighted yellow color. 

3. After selecting, right click to finish the current operation. 

4. Follow the instruction to define the rotation center, and then move the 

mouse. At the same time, it shows the relative displacement and rotation 

angle dynamically. 

After rotating to the proper position, click the left button to determine the target 

position. 

§2.4.6 Copy 

The command can copy one or more objects in one time, which is usually used 

to adjust a set of furniture. 

Basic operations: 

1. Select Copy in the Edit menu, or click  button in the tool bar. 

2. According to the instruction, click the object to be copied, and the selected 

object will display a node with highlighted yellow color. 

3. After selecting, right click to finish the current operation. 
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4. Follow the instruction to define the start point for copying, and at the same 

time, it shows the displacement of the copied object relative to the source 

object. 

5. After copying to the proper position, click the left button to determine the 

position of the copied object. 

§2.4.7 Mirror 

The command can mirror one or more objects in one time, which is usually 

used to adjust a set of furniture. 

Basic operations: 

1. Select Mirror in the Edit menu. 

2. According to the instruction, left click the object to be mirrored, and the 

selected object will display a node with highlighted yellow color. 

3. After selecting, right click to finish the selection. 

4. Follow the instruction to define the start point for mirroring, and at the same 

time, it shows the displacement of the mirrored object relative to the source 

object. 

5. After mirroring to the proper position, left click to determine the position of 

the mirrored object. 

6. A dialog prompt Keep the original object or not?, select Yes to keep the 

original object, select No to delete it 

§2.4.8 Erase 

Select EditErase. Select the object to delete. Right click to delete or press 

[Esc] to cancel. 
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§2.5 View 

§2.5.1 Full Screen 

Function: Adjust the current workspace to display all placed objects in it. 

Basic operations: 

Click Full screen in the View menu, or click  button in the tool bar. 

§2.5.2 Zoom Window 

Function: customize a rectangle area and maximally display the objects in it. 

Basic operations: 

Click Zoom window in the View menu, or click  button in the tool bar. 

§2.5.3 Zoom 

Function: zoom in or zoom out the objects in the workspace at any moment. 

Basic operations: 

1. Select Zoom in the View menu. 

2. The mouse automatically moves into the workspace. Moving upwards 

the mouse is to zoom in the objects, while moving downwards the 

mouse is to zoom out the objects. 

3. After scaling to a proper degree, right click and then select View None 

from the properties menu. 

§2.5.4 Pan 

Function: drag the drawings in the workspace. 

Basic operations: 

1. Click Pan in the View menu. 

2. The mouse automatically moves into the workspace. The drawings 

move to the direction that the mouse points to. For example, if you 

move the mouse downwards, the drawings will be moved downwards; if 

you move the mouse to the left, the drawings will be moved to the left. 
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3. After scaling to a proper degree, click the right button and then select 

View None from the properties menu. 

§2.5.5 Zoom In 

Function: zoom in the objects in the workspace. 

Basic operations: 

Click Zoom in in the View menu, or click  button in the tool bar. 

§2.5.6 Zoom Out 

Function: zoom out the objects in the workspace. 

Basic operations: 

Select Zoom out in the View menu using the left button, or click  button in 

the tool bar. 

§2.5.7 Hide/Show Image 

Function: show or hide all images inserted by the Insert image command in the 

workspace. 

Basic operations: 

Click Show all images/hide all images in the Draw menu, and then the system 

will show or hide all images in the draw area. 

You can quickly portray a drawing without affecting the final plot effect (that is, 

use the Show image command to show all images and take them as an 

assistant when portray a drawing; when export the final 2D effect drawing, hide 

all images so that they will not influence the final effect).  

Note: Properly using the two functions, you can quickly portray a drawing 

without influencing the final plot effect (that is, use the Show image command 

to show all images and take them as an assistant when portray a drawing; 

when export the final 2D effect drawing, hide all images so that they will not 

influence the final effect). 
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§2.6 Drawing Tool 

§2.6.1 Line 

Function: Draw straight lines on the current workspace (floor). 

Basic operations: 

1. Click Line in the Draw menu. 

2. Click the workspace for a start point of the line. 

3. Move the mouse to define the length and degree of the line. You can also 

input the accurate value of the line. Length means the length of the line; 

Angle means the angle between the line and horizon; Relative angle 

means the angel between the active line and previous line (clockwise) 

4. Left click again to determine the end point. You can continue to draw lines 

one by another. Left click to finish operation. 

§2.6.2 Arc 

Three-points arc 

Function: Draw an arc on the current workspace (floor). 

Basic operations: 

Select Arc in the Draw menu and three-point arc from arc parameter dialog. 

Left click the mouse in the workspace for the start point. Move the mouse and 

left click to determine the end point. You will see an arc after you draw the end 

point. When you move the mouse, you will see the shape of the arc change 

accordingly. Left click to determine the final shape. 

 

Fillet 

Function: Fillet the angle of two connected lines. 
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Basic operations: 

Draw two connected lines first. Select Arc in the Draw menu and fillet from arc 

parameter dialog. Set value of radius and click ok. Left click to select two 

connected lines. You will see the fillet of these two lines. 

 

Define two points as the radius 

Function: Draw an arc by setting two points as the radius. 

Basic operations: 

Select Arc in the Draw menu and define two points as the radius from arc 

parameter dialog. Set value of radius and click ok. Left click the mouse in the 

workspace for the start point. Move the mouse and left click to define the 

second point. Move the mouse beside the connecting line of these two points 

and left click to finish.  

 

Define the start point, radius and angle 

Function: Draw an arc on a line. 

Basic operations: 

Draw a line first. Select Arc in the Draw menu and define the start point, radius 

and angle from arc parameter dialog. Set the values of radius and angle and 

click ok. Select a node on the line as the start point. Move the mouse and left 

click in the workplace to define direction.  

§2.6.3 Circle 

Function: Draw a circle on the current workspace (floor).  

Basic operations: 

1. Select Circle in the Draw menu. 

2. Left click on the workspace to place the center of the circle. 

3. Move the mouse to enlarge or reduce the circle. You can see the radius of 

the circle in displacement. 
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4. Left click the mouse to finish drawing. 

§2.6.4 Polyline 

Function: Draw a Polyline on the current workspace (floor). 

Basic operations: 

1. Select Pline in the Draw menu. 

2. Left click on the workspace to start drawing.  

3. With a similar way to draw line, you can continue to draw until right click to 

finish. But the different is, the polyline created in this way will be recognized 

as a continued entity while straight lines are recognized as separated 

entities.  

§2.6.5 Text 

Function: write some text in the drawing, usually used as complementary 

description for objects in the drawing. 

Basic operations: 

1. Click Text in the Draw menu. 

2. Input the text in the Input data dialogue box. Press OK. 

 

§2.6.6 Horizontal Dimension 

Function: measuring the distance between two points in horizontal line. 

Basic operations: 

1. Click Horizontal dimension in the Draw menu. 
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2. Move the mouse cursor to the workspace. Click one point as the first point. 

Then move the mouse to another position. A prompt will be displayed to ask 

you to determine the second point, and dynamically shows the distance 

between the two points. Click at a proper position to determine the second 

point. 

3. As the starting and ending points have been defined, you can click an 

empty space nearby the line. Now you can see the dimension is created.  

§2.6.7 Aligned Dimension 

Function: to get the distance between two points, also called oblique 

dimension.  

Basic operations: 

1. Click Aligned dimension in the Draw menu. 

 

2. Move the mouse cursor to the workspace. Click one point as the first point. 

Then move the mouse to another position. A prompt will be displayed to ask 
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you to determine the second point, and dynamically shows the distance 

between the two points. Click at a proper position to determine the second 

point. 

3. As the starting and ending points have been defined, you can click an 

empty space nearby the line. Now you can see the dimension is created 

and aligned with the line or wall you measured. 

§2.6.8 Angular Dimension 

Function: to get the distance between two lines. The system automatically 

measures the angle. 

Basic operations: 

1. Click Angular Dimension in the Draw menu. 

 

2. Move the mouse cursor to the workspace, and you can see a prompt 

asking you to determine the vertex. Click at a proper position to determine it, 

and then move the mouse to another position. A prompt will be displayed to 

ask you to determine the first side, and here also dynamically shows the 

distance and angle variation between the two points. Click at a proper 

position to determine the first side of the inclination; repeat the above to 

determine the second line. 

3. At that time move the mouse to an appropriate position and click the left 

button to determine the arc‟s location for angle dimension. 
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§2.6.9 Insert Image 

Function: insert an image (.jpg format) into the drawing area for drawing the 

floor plan. To use this command, you need to scan the real floor plan and save 

it as .jpg format.  

Basic operations: 

1. Create a new file. Click Insert Image command in Draw menu. 

2. In the popup Open dialogue box, choose the JPG file of the floor plan. 

3. The system will ask you to locate the image. Move the mouse to a proper 

location. Left click to locate the image. 

4. The system will automatically adjust the image to a proper size. A dialogue 

box will pop out and ask you to adjust the ratio. Click Select reference point. 

5. The system will ask you to select first point. 

6. The system asks you to choose the second point. Drag the mouse and 

choose the right endpoint of this dimension. 

7. In the popup Actual Size dialogue box, enter the actual size of this line. 

Then click OK. 
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§2.6.10  Insert Image Frame 

Function: insert an image frame into the drawing area for the floor plan. 

Basic operations: 

1. Click Insert image frame in the Draw menu. 

2. Select an image frame type. 

3. Set the map direction and select frame containing area, click OK to 

finish. 

Whole image scope: Insert an image frame fitting the size of the whole 

image automatically. 

Define scope: Click to select first point, move mouse and click another 

point to define the second point of image range. 

§2.6.11  Insert File 

Function: attach or cover the entire drawing (.koc format) on the current one. 

After exploding them you can edit any part in the current view. 

Basic operations: 

1. Click Insert file in the Draw menu. 

2. Select an image block file to be inserted (.koc format). 

§2.6.12  Free Region 

Function: create the floor in a customized area. 

Basic operations: 

1. Click Free Region in the Draw menu. 

2. Left click in the workspace to as the start point. You can see the lines while 

you continue to click and define points. You can draw triangle, rectangle or 

any shapes. 
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3. When you get the shape you want, right click to finish drawing. The shape 

you just drew will be filled with white color, which means the floor is created 

in this area. 

§2.6.13  Search Region 

Function: automatically search a room or closed shape (rectangle, circle, etc) 

to create floor inside the area. 

Basic operations: 

1. Click search region in the Draw menu. 

2. Move the mouse in the workspace, then left click inside the room or shape 

you want to create floors. The room or shape need to be closed so the 

system can recognize and search. 

3. The room or shape selected will be cover with white color, which means the 

floor is created inside.  

§2.7 Room Structure 

§2.7.1 Design Wizard 

Function: Use Build Room function to create a room in rectangle or L shape.  

Basic operations: 

1. Select Room structure Room. Or click  on the tool bar; 

2. Define the size of room.  
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3. Move the mouse to the design area. Left click to locate the room.  

 
Press Space bar to rotate the room. Press N to switch the wall corner.  

Note: In the Create room window, you can simply change the name, shape, 

and the size of the room you are building. By changing the dimension of each 

wall, you can change the inner or outer length of each wall. By ticking the check 

box of Generate room floor, you can simply create the floor when locating the 

room in workspace.  

§2.7.2 Wall 

Function: Build the wall and it will automatically fit to other walls. 

Basic operations: 

1. Select Room structure  Wall or left click Free Wall command in Design 

Wizard panel.  
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2. Base dialogue box will pop up. Move the mouse, and left click for the 

starting point of wall.  

 

3. Modify the parameter of wall. The default size of wall thickness is 120mm.  

4. When you move the mouse, the length and angle of wall will be shown in 

the Base dialogue box. You can enter a figure as the Length and Enter. The 

wall will be generated.  

5. You could also left click for the second point of wall. Now one piece of wall 

has been created. Move the mouse to draw the second one. The ending 

point of first piece of wall is the starting point of the second piece of wall. 

You can continue this operation till you finish drawing the rooms. Once all 

walls are created, right click.  

Note: you can use the snap function to locate the wall accurately. 
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§2.7.3 Insert Door, Window and Column 

Function: Insert door and window 

Door and Window 

Basic operations: 

1. Select Room structure  Door and window 

 

2. Select different type of door and window. Define its dimension, elevation, 

frame and door sills. Click OK. 

3. Left click on the piece of wall where you want to insert the door. The 2D 

sample of door will move alone the wall with the movement of mouse. You 

can press Space to change open-left/right of the door and move the mouse 

to change it facing inside/outside of the door. 

4. Left click to locate the door.  

5. Once a door is fixed, you can continue insert another door. Or right click to 

exit this command. 

Insert column 

Basic operations: 
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1. Select Room structure  Column 

2.  Input the size of L, W, H, and press OK. 

 

3. Move the mouse to a position you prefer. Then left click to finish the 

command. 

§2.7.4 Edit door and window 

Select door or window, right click. The edit menu of door or window will show. 

You can move, copy, set position, set property, delete, or change orientation.  

 

§2.7.5 Furniture List 

Function: Display the quotation list of furniture. 

Basic operations: 

1. Select Room structure  Furniture List. And the furniture list will be 
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shown. 

2. Here you could export or print the list. 

§2.8 Ceiling 

§2.8.1 Search Ceiling Frame 

Function: the system automatically searches for an enclosed area around the 

selected point and take this area as ceiling framework of the generated 3D 

scene. Usually the function is used to build a room‟s ceiling framework. 

Basic operations: 

1. Click Search ceiling frame in the Ceiling menu. 

2. Move the mouse cursor to the workspace, and you can see a Pick point 

inside room prompt. According to the prompt, click the left button inside the 

room where the ceiling framework will be generated to determine the 

position of the ceiling framework, and then the Ceiling setting dialogue box 

appears. 

 

3. In the dialogue box, you can set the elevation of the ceiling framework 

(default elevation is 2800mm). Press OK, then the system generates the 

ceiling framework in the room‟s closed area that has been previously 
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searched and displays it in a red-line framework in the draw area. 

§2.8.2 Manual Ceiling 

Function: generate individual ceiling with any shape at any place. 

Basic operations: 

1. Click Manual ceiling in the Ceiling menu.  

2. Move the mouse cursor to the workspace, and you can see a prompt 

asking you to determine the ceiling framework‟s First point. Click the left 

button to determine it. Then move the mouse to another position, a Next 

point prompt appears, and here also dynamically displays the displacement 

between the two points. Repeat the process to determine all nodes of the 

ceiling framework (Note: it needs at least three points to determine the 

ceiling framework). Click the right button to finish selecting the area, and a 

Ceiling setting dialogue box popup. 

 

 

3. In the dialogue box set the elevation of the ceiling framework (default 

elevation is 2800mm). Press OK, then the system generates the ceiling 

framework. 

§2.8.3 Ceiling Block 
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Function: generate individual ceiling in the framed rectangle area. 

Basic operations: 

1. Click Ceiling Block in the Ceiling menu 

2. Move the mouse cursor to the workspace, and you can see a prompt 

asking you to determine the ceiling framework‟s First point. Click the left 

button at a proper position to determine the first point. Move the mouse 

to another position. It appears a white preview framework for 

determining the range of individual ceiling and a prompt asking to 

determine the Second point. Here, it dynamically displays the 

displacement between the two points. According to the variation of the 

white preview framework, click at a proper position to determine an 

area for generating the individual ceiling.  

3. In the popup Ceiling setting dialogue box set the shape and elevation of 

the ceiling. In the Individual ceiling option click Select button, and then 

choose a proper ceiling shape from the ceiling library. So you can 

quickly build a ceiling with complex structure. If you select the other, you 

will get the simple one. Remember to change the elevation. It must 

different from the elevation of the ceiling framework. 

4. Meanwhile, set the elevation of the ceiling framework (default elevation 

is 2800mm). Press OK, then the system generates the ceiling in the 

selected closed area and displays it in a red-color line framework in the 

draw area. 
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§2.8.4 Ceiling Lights 

Function: arrange ceiling lights one by one in the draw area. 

Basic operations: 

1. Click Ceiling lights in the Room menu. 

2. Move the mouse cursor to the workspace, and you can see a prompt 

asking you to determine the Location of ceiling light. Left click a proper 

position to determine it. The lights will be attached to the ceiling 

automatically.  

3. Repeat the above operations to arrange other ceiling lights until finish. 

4. A ceiling light is displayed with a small red dot in the draw area.  

§2.8.5 Linear Ceiling Lights 

Function: arrange ceiling lights along a line in the draw area. 

Basic operations: 

1. Click Linear ceiling lights in the ceiling menu. 

2. Move the mouse cursor to the workspace, and you can see a prompt 

asking you to determine the First point of the line. Click the left button at 

a proper position to determine it. 

3. Move the mouse to another position. It appears a prompt asking you to 

determine the Second point. Here, it dynamically displays the 

displacement between the two points. Click the left button at a proper 

position to determine the linear track. Then the Ceiling light dialogue 

box pops up. The dialogue provides four ways for arranging ceiling 

lights including average among the line, skip start, skip end and skip 

both. Also, you can set the number of ceiling lights along the line 

(default value is 5). After setting these parameters, press OK, then in 

the draw area a set of ceiling lights is arranged along the line, each with 

a small red dot.  
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§2.8.6 Show Ceiling/Hide Ceiling 

Function: show or hide all ceiling objects in the draw area (including ceiling 

framework, individual ceiling and ceiling light, etc.). The function can facilitate 

the user‟s design through showing or hiding ceiling objects anytime and enable 

user to easily select, locate and edit objects. 

Basic operations: 

Select Show ceiling /Hide ceiling in the Room menu using the left button, and 

then the system will show or hide all ceiling objects in the draw area. 

§2.9 Layout Furniture 

Once the room design is finished, you can choose the furniture from the library 

and layout into the house.  
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Insert single piece of furniture 

1. Select the furniture from library. Double click the preview image to 

confirm the selection. You can input single piece of furniture or furniture 

sets. 

2. Move the mouse to locate the furniture. Press Space bar to rotate the 

furniture.  

 

Note: When you insert a furniture set, you can tick on the Explode check box to 

separate the components of each piece of furniture from the set. If not, the 
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furniture set will be edit as a whole set after insertion.  

§2.9.1 Edit the Furniture 

Right click the furniture, the edit menu will show.  

 
The commands of Move, Rotate, Copy, Color and Delete are same as the ones 

in edit menu.  

The command of Rotate has a step rotation of 15 degree while in the mode of 

Free Rotate, the item will move freely with the mouse movement.  

 

Change size 

Enter the new size in the Size dialogue box.  

 

If the Keep size scale is ticked, once one of the sizes is changed, the rest will 

be changed. If this item is not ticked, then you can enter length, width and 

height one by one.  

Elevation 
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In the popup dialogue box, enter the elevation of the furniture.  

 

To put this furniture on the top of the other furniture, you can either enter a new 

elevation.  

Or click Selected to select the furniture which is under the furniture.  

Left clicking Cancel will exit the edit menu. 

§2.9.2 Furniture Set 

Function: To create furniture set.  

Basic operations: 

1. Click Furniture Set. Right click and select Insert Node to add a new 

node. 
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2. Create a new set. Select the category and right click on the preview 

area. Enter the name of new furniture set. Click OK. 

 

3. Next, select the furniture to add to a set. Right click and the furniture set 

is added into the library. 

§2.10 Setting Menu 

§2.10.1  Display Mode 

Function: There are two modes to be selected, one is filling, and the other is 

wire frame. 

Basic operations: 

1. Click the Display mode in the Setting menu. A Display Mode dialogue 

box pop up. 

2. Default is Texture Mode. The furniture will be of more reality if you 

select Filling mode. 
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3. Selecting the mode of wire frame, you can see all objects are showed 

by wire frame. It not only can promote the speed of display, but save the 

ink of printer. 

 

§2.10.2  Image Quality 

Function: set image quality as requirements (this setting is obvious when the 

scene is relatively large). 

Basic operations: 

1. Click the SettingImage Quality.  

2. In the popup dialogue box set low quality or high quality. You can 

choose different quality. You are suggested to keep the default setting. 

§2.10.3  Unit 
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Function: you can choose the units used in this drawing, between metric and 

imperial, as well as the precision. The change will apply after restart the 

program.  

§2.10.4  Snap on 

Function: It is an auxiliary drawing tool. When furniture and columns are very 

close to wall, you can activate Snap on function to automatically lean them on 

the wall and reverse them appropriately. This tool greatly facilitates furniture 

setting. However, if furniture is very close to wall rather than fully lean against 

wall, activation of the Snap on will make the operation difficult.  

Basic operations: 

If there is a mark near the Snap on command in the Snap menu, it indicates 

that the function is on; otherwise it is off. You can switch the ON/OFF status of 

the Magnetic toolbar function by clicking the Snap on command in the setting 

menu. 

 

Node Snap 

Function: It is an auxiliary drawing tool. When the tool and some drawing 

commands are on, the mouse can automatically snap certain object‟s nodes. 

All blue points in the following figure are object‟s nodes. The function is very 

useful in auto-drawing, for example, drawing a line that connects to another 

endpoint line with an arc endpoint. 

 

Basic operations: 

If there is a mark near the Snap at Node Snap command in the right corner, it 

indicates that the function is on or otherwise it is off. You can switch the 

ON/OFF status of the Node function by checking or unchecking it. 

 

Length Snap 

Function: It is an auxiliary drawing tool, used to control the step value of the 
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mouse when Draw a line command is on. The function is similar to the Grid 

command, but the Length is calculated from an existing specified point. For 

example, when drawing a line or wall, the length snap is calculated from the 

first point, while grid is determined according to the current coordinate in the 

workspace. 

The default is 100mm. 

Basic operations: 

If there is a mark near the Snap at Length command in the right corner, it 

indicates that the function is on; otherwise it is off. You can switch the ON/OFF 

status of the Length function by checking or unchecking it. 

 

Angle Snap 

Function: It is an auxiliary drawing tool. It is use to control the step angle for 

rotating the line rather than to rotate with any angle when Draw a line command 

is use. The default value is 15 degree. 

Basic operations: 

If there is a mark near the Snap at Angle Snap command in the right corner, it 

indicates that the function is on; otherwise it is off. You can switch the ON/OFF 

status of the Angle function by checking or unchecking it. 

 

Wall Snap 

Function: It is an auxiliary drawing tool. When building the wall, you can see 

there is axis on the end point of wall. It not only help you to view the X direction 

and Y direction, but also snap the exactly point of the wall.  

Basic operations: 

 If there is a mark near the wall snap command in the Setting menu, it indicates 

that the function is on; otherwise it is off. You can switch the ON/OFF status of 

the Wall snap function by clicking the Wall Snap command in the Setting menu. 

 

Grid Snap 

Function: It helps you to snap at the grid in the working area. You can change 

its size from SettingGrid Setting. 

Basic operations: 

 If there is a mark near the Snap at Grid command in the right corner, it 

indicates that the function is on; otherwise it is off. You can switch the ON/OFF 
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status of the Grid Snap function by checking or unchecking it 

§2.10.5  Setting of Snap 

Default settings of three auxiliary drawing tools, including grid, length and 

angle. 

 

§2.10.6  Image Insert Point Setting 

Function: making the insert point of the graph then get the exactly position of 

graph. You can see the detail in the Insert file command.  

Basic operations: 

1. Click the Set the image insert point in the Setting menu. 

2. The system automatically switches to the current workspace, and you 

can see a prompt asking you to determine the Location. It also 

dynamically displays the displacement relative to the previous position. 

Click the left button at a proper position to determine the insert point 

(you can activate the Snap function to work with this command 

together). 

§2.10.7  Size Dimension and Style 

Function: set each dimension parameters including direction and text style, etc. 

Basic operations: 

1. Click the SettingSize Dimension and Style. 

2. Set font, text color, height, offset, arrow style and arrow size in the 

popup dialogue box. Press OK. 
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§2.10.8  Default Text Color 

Function: set default text color when using the Text function. 

Basic operations: 

1. Click the command.  

2. Input default text color in the popup dialogue box. Press OK. 

§2.10.9  Default Wall Thickness  

Function: set default thickness of wall when using Build wall function.  

Basic operations: 

Click the command using the left button. Input default thickness of wall in the 

popup dialogue box. Press OK. 

§2.10.10 Highlight Wall 

Function: set the wall shown with high light green color or not. When you draw 

the wall, it makes you easier to know which walls have been finished.  

Basic operations: 

If there is a mark near the High light the wall command in the Setting menu, it 

indicates that the function is on or otherwise it is off. You can switch the 

ON/OFF status of the function by clicking the Highlight wall command in the 

Setting menu. 
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§2.11 Enter 3D (From 2D to Virtual Reality) 

§2.11.1  How to Import from 2D to Virtual 

Reality 

There are two importing methods in InteriCAD: 

 

From 2D to Virtual Reality.  

Basic operations: 

1. Select Enter 3D menu Export to VR or Select 3D Mode in Design 

Wizard. 

2. Select a temple in the popup dialogue box. Press OK.  
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Note: There are 3 check boxes in the bottom to assist the conversion:  

Generate ceiling: If you don’t have a ceiling in the room, you can check this 

box 

Use furniture in template: can add in the furniture you see in this template 

review 

Add adorn: can add in the adorn you see in this template review  

 

3. The current 2D drawing will convert to 3D in Virtual Reality once you press 

OK. The room style will be similar with the template chosen. 

In Virtual Reality, open a saved std file.  

To open 2D file in Virtual Reality:  

A. Open Virtual Reality. Select Import 2D file. 

B. In the pop-up dialogue box, select the koc file.  
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Next, the same as the operation process of Export to VR. 

 

 

Chapter 3 Ceramic Module  

§3.1 Ceramic Module Startup 

Ceramic Module in 2D Design: 

You should startup 2D Design first using any of the following methods: 

1. Double click the 2D Design shortcut on the WINDOWS desktop. 

2. Select Program from Start menu, and then YFCAD Software/InteriCAD 

T5/2D Design. 

3. Then run the command. 

Ceramic Module in Render: 

You should startup Render first using any of the following methods: 

1. Double click the Render shortcut on the WINDOWS desktop. 

2. Select Program from Start menu, and then YFCAD Software/InteriCAD 

T5/Render. 
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3. Then run the command. 

§3.2 Interface 

The system main window looks as follow: 

 

 

The arrow-pointed parts are commands used in Ceramic Module. The ceramic 

king system is in the 2D Design part. You can refer to the 2D Design Chapter 

for detailed information. 
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The Ceramic King 3D Design is in the VR part; the arrow-appointed area is the 

command. For VR, please refer to the Virtual Reality chapter for more 

information. 

§3.3 Paving Region 

Tiles can only be paved in the paving region. Tiles beyond the regional 

boundary will be cut automatically. 

§3.3.1 Rectangular Region 

Basic Operations: 

1. Region  Rectangular Region. 
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2. Input region size, and then click OK button. 

3. Left click to define the location of this region then the region is 

generated. 

§3.3.2 Draw Region 

Basic operations: 

1. Region  Draw Region. 

2. Move the cursor to workspace. Click one point when program prompts 

First point. 

3. When program prompts Next point, move the cursor to another position 

and left click to define the second point. To keep the region closed, 

program will connect the starting point and cursor automatically from 

the third point. 

4. When the last point is defined, right click to end this command. 

Program will generate a region according to these points. 

§3.3.3 Door Region 

Basic operations: 

1. Region Door Region. 

2. The cursor is replaced by a small red box. Click on the door to 

generate region. The selected door will be highlighted. 

3. Right click to end the selection, and then a dialog box pops up. 
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4. Choose either option from the dialog box. You can check the difference 

between two options in the schematic diagram. 

5. Click OK button to generate door region. 

§3.3.4 Search Region 

1. Region Search Region. 

2. The cursor is replaced by a small red box, and program 

prompts Select one point inside the region to be 

searched. Left click in an enclosed area that is 

surrounded by lines or walls. 

3. Program will search out the area boundary and generate 

paving region. 

§3.3.5 Modify Paving Region 

The properties of paving region, such as color, name and slice gap, are 

editable. Boolean operations are also available for regions. Right click on a 
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region to display the shortcut menu. All relevant edit functions can be found in 

this shortcut menu. 

§3.3.5.1 Change Color 

Basic operations: 

1. Right click on a region to display the shortcut menu, and then choose 

Change color command in it. 

2. Choose a color in the pop-up standard color dialog box. Click OK 

button, the region color has been changed. 

§3.3.5.2 Change Name 

Basic operations: 

1. Right click on a region to display the shortcut menu, and then choose 

Change name command in it. 

2. Enter a new name in the dialog box. 

3. Click OK button, the region name has been changed. 

Note: New name should be different from any existing region name in current 

drawing. 

§3.3.5.3 Change Slice Gap 

Basic operations: 

1. Right click on a region to display the shortcut menu, and then choose 

Change slice gap command in it. 

2. Enter a new value of slice gap width in the dialog box; the unit of 

measurement is millimeter (mm). 

3. Click OK button, the slice gap width will be changed. 

Note: Modified slice gap width can only be applied to new tiles. Existing ones 

will remain unchanged. So it is strongly recommended that the slice gap width 

should be set before paving. 
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§3.3.5.4 Clean Slice 

Basic operations: 

1. Right click on a region to display the shortcut menu, and then choose 

Clean slice command in it. 

2. All existing tiles in this region will be removed. 

§3.3.5.5 Boolean Operation 

Basic operations: 

1. Right click on a region to display the shortcut menu, and then choose a 

Boolean operation command (Combine regions, Region subtract and 

Region intersect) in it. 

2. Click on another region to execute Boolean operation. 

 

The Boolean operation results are as below: 

1. Original state 

 

2. Region intersect  
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3. Region subtract  

 

4. Combine regions  

 

§3.4 Paving in a Region 

The core of ceramic module is how to pave in a region. With user-friendly 

operating interface and flexible operating method, users can almost finish the 

entire paving process only with a mouse. 
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Basic operation to place a tile: 

Choose from system database 

Basic operations: 

1. Query the database with specified conditions to get all eligible tiles. 

2. Choose a tile from query results. Use the mouse to drag it to the target 

region, and then release left button. 

3. Move the cursor in the region to get a suitable position and angle. 

4. Left click to place the tile. It will be cut automatically according to the region 

boundary and existing tiles. 

5. To modify any existing tile, right click on it to display shortcut menu. All 

relevant edit functions can be found in this menu. 

Use external Jpg format picture 

Basic operations: 

1. Find required Jpg format picture via Windows explorer or external image 

browser program then directly drag and drop it to the region. 

2. Set size in the dialog box popping up, and then move the cursor in the 

region to get a suitable position and angle. 

3. Left click to place the tile. It will be cut automatically according to the region 

boundary and existing tiles. 

4. To modify an existing tile, right click on it to display shortcut menu. All 

relevant edit functions can be found in this menu. 

§3.4.1 Worktable 

The worktable integrates the material and specification management functions 

for ceramic design project. It provides you the most convenient operation 

modes and abundant design resources, and thus makes it handier to do your 

job. The worktable interface is shown as the following image. It integrates two 

functions: Query Tiles and Tiles Quotation. 
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The Query Tiles section is divided into two parts. One is operating area, 

another is display area. At the top of display area, there is current page number 

and page switch button. At the bottom of display area, there is total page 

number and total tile number. 

Activate Worktable 

Basic operations: 

1. Choose corresponding command from Pave menu. 

2. Press Spacebar. 

Display setting of Worktable 
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At the top of display area, there‟s Detail and Setting button. The former is used 

to view the detail of selected tile, and the later is to configure the display 

setting. 

To view the detail of a tile, left click on it. And then click Detail button to display 

the dialog box. 

To configure the display setting, click Setting button to display the dialog box. 

It‟s only used to change the display area. Click OK button to apply the 

modification and quit. 

§3.4.2 Query Tiles 

In the Query tiles section, various conditions are available for tile searching, 

such as Code, Size, Type and Color. 

The meanings of query conditions are as follow: 

Code: the unique id of a tile that allocated by manufacturer. 

Input product code in the input box, or click the button beside the input box and 

choose one in the pop-up dialog box. Once this input box is filled, other input 

boxes become gray except the input box of Menu is still available for searching. 

To activate other input box, you need to remove the content in the input box of 

Code. 

Note: If the input box of Code is blank, that means do not specify code. 

Menu: name of tile manufacturer. 

Input manufacturer name in the input box, or click the button beside the input 

box to choose one in the pop-up dialog box. 

Note: If the input box of Code is blank, that means do not specify 

manufacturer. 

Size: Width X Length 

Input tile size in the input box to query. If only inputting either the value of width 

or length, all the tiles that match this value can be searched out. For example, 

by inputting 300 in the input box you can search out all the tiles that are 300mm 

wide or 300mm long. Also you can click the button beside the input box to 

choose one in the pop-up dialog box. 

Note: If the input box of Code is blank, that means do not specify tile size. 

Type: all product types can be found in the drop-down list. 

Note: By choosing Not specify, that means do not specify product type. 
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Color: all product colors can be found in the drop-down list. 

Note: By choosing Not specify, that means do not specify product color. 

Class: all product classes can be found in the drop-down list. 

Note: By choosing Not specify, that means do not specify product class. 

Note: composite conditions are available for querying. The more conditions 

that is specified, the fewer tiles can be searched out. And it might even lead to 

empty search result. Click Search button after specifying condition. Search 

result will be listed in display area. 

§3.4.3 Place Tiles in the Region 

By dragging 

Basic operations: 

1. Choose a tile from search result. 

2. Left click on the tile, and then drag it to target region. 

3. Move cursor to blank area and release left button. 

4. Move the cursor in the region to get a suitable position. When moving 

cursor close to regional boundary or existing tiles, current tile will snap to 

them automatically. Press Spacebar to rotate the tile, 15 degrees 

anti-clockwise each time. 

5. Left click to place the tile in suitable position and angle. It will be cut 

automatically according to the region boundary and existing tiles. Cutting 

result differs according to the setting of cut style. Please refer to Tiles cut 

style. 

 

By double clicking 

Basic operations: 

1. Choose a tile from search result. 

2. Double click it, and then select target region. 

3. Move the cursor in the region to get a suitable position. When moving 

cursor close to regional boundary or existing tiles, current tile will snap to 

them automatically. Press Spacebar to rotate the tile 15 degrees 

anti-clockwise each time. 

4. Left click to place the tile in suitable position and angle. It will be cut 

automatically according to the region boundary and existing tiles. Cutting 
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result differs according to the setting of cut style. Please refer to Tiles cut 

style. 

§3.4.4 Replace Tile in the Region 

Basic operations: 

1. Choose a tile from search result. 

2. Left click on the tile, and then drag it to target region. 

 

3. Move cursor over the existing tile, and then release left button. Program 

will display Replace Tile dialog box. If two sizes are different, program will 

prompt that cannot replace with different specification. If two sizes are the 

same but types are different, the replace tile dialogue box will pop up. 

There are two replacing modes. Choose one and press OK button. 

Note: replace function is only available for tiles in same size. 

§3.4.5 Region Tiling Begins from Tiles 

There are different methods to place tiles in the region. Right click on a tile, and 

then a shortcut menu will be displayed. All methods can be found in this menu. 

Note: it is suggested that all the properties, such as rotate angle and cut style, 

should be set up before placing tiles. 

§3.4.5.1 Move 

Basic operations: 

1. Right click on target tile, and then choose Move in shortcut menu. 
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2. Move the cursor in the region to get a suitable position. When moving 

cursor close to regional boundary or existing tiles, current tile will snap to 

them automatically. Press Spacebar to rotate the tile, 15 degrees 

anti-clockwise each time. 

3. Left click to place tile. It will be cut automatically according to the region 

boundary and existing tiles. Cutting result differs according to the setting of 

cut style. Please refer to Tiles cut style. 

§3.4.5.2 Rotate 

Basic operations: 

1. Right click on target tile, and then choose Rotate in shortcut menu. 

2. System will creates a dynamic line between the geometry center of the 

whole ceramic shape and the moving cursor, and the ceramic will rotate by 

the angle generated by that line. Left click to place the tile in a suitable 

angle. It will be cut automatically according to the region boundary and 

existing tiles. Cutting result differs according to the setting of cut style. 

Please refer to Tiles cut style. 

§3.4.5.3 Copy 

Basic operations: 
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1. Right click on target tile, and then choose Copy in shortcut menu. 

2. Move the cursor in the region to get a suitable position. When moving 

cursor close to regional boundary or existing tiles, current tile will snap to 

them automatically. Press Spacebar to rotate the tile, 15 degrees 

anti-clockwise each time. 

3. Left click to place the new tile. It will be cut automatically according to the 

region boundary and existing tiles. Cutting result differs according to the 

setting of cut style. Please refer to Tiles cut style. 

4. Continue to move the cursor. Repeat step 2 and 3 to copy multiple tiles. 

5. Press right button or ESC key on keyboard to end operation. 

§3.4.5.4 Continuously Straight Tiling 

Basic operations: 

1. Right click on target tile, and then choose Continuously straight tiling in 

shortcut menu. 

2. By moving the mouse, the system will show the tilling dynamically by a 

square box with the same size to that tile. The system will calculate 

quantity of the tiles automatically; press F to pave the whole region in 

current way. 

3. Left click in suitable position to generate tiles with the same size in the 

specified region; the slice gap will be generated as well according to the 

parameter setting. New tiles will be cut automatically according to the 

region boundary and existing tiles. Cutting result differs according to the 

setting of cut style. Please refer to Tiles cut style. 

§3.4.5.5 Interval Straight Tiling 

Basic operations: 

1. Right click on target tile, and then choose Interval straight tiling in shortcut 

menu. 

2. There are two interval modes in the pop-up dialog box: Interval mode of tile 

quantity and Interval mode of distance. Please note that by choosing the 

Interval mode of distance, the width of slice gap is already included. After 

selecting the interval mode and interval value, click OK button. 
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3. By moving the mouse, the system will show the tilling dynamically by a 

square box with the same size to that ceramic. The ceramics will be tiled 

along the two sides of the selected one by the ceramic size and interval 

value. The tiling mode is to spread the ceramics in horizontal and vertical 

directions until the cursor position, and the system will automatically work 

out the ceramic quantity required. Press the F key, then it will tile the whole 

region by the current tiling mode; 

                        

        A. Drag mode                          B. Select mode 

4. Left click in an appropriate position, and then the tiles will be tiled 

according to the dragging status before final selecting. New tiles will be cut 

automatically according to the region boundary and existing tiles. Cutting 

result differs according to the setting of cut style. Please refer to Tiles cut 

style. 
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§3.4.5.6 Odd-Even Tiling 

Basic operations: 

1. Right click on target tile, and then choose Odd-even tiling in shortcut 

menu. 

2. Move the mouse, and the system will show the tiling dynamically by a 

square box with the same size to that ceramic. The ceramics will be tiled 

along the two sides of the selected one by the ceramic size. The tiling 

mode is to odd-even tile the ceramics in the rectangle stretched by the 

mouse, and the system will automatically work out the ceramic quantity 

required. Press the F key, then the system will tile the whole region in 

current tiling mode; 

            

A. Drag mode                              B. Select mode 

3. Left click in an appropriate position, and then the tiles will be tiled 

according to the dragging status before final selecting. New tiles will be cut 

automatically according to the region boundary and existing tiles. Cutting 

result differs according to the setting of cut style. Please refer to Tiles cut 

style. 

§3.4.5.7 Continuously Oblique Tiling 

Basic operations: 

1. Right click on target tile, and then choose Continuously oblique tiling in 

shortcut menu. 
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2. Move the mouse, and the system will show the tiling dynamically by a 

square box with the same size to that ceramic. The ceramics will be tiled 

along the two sides of the selected one by the ceramic size. The tiling 

mode is to continuously-oblique tile the ceramics in the rectangle stretched 

by the mouse, and the system will automatically work out the ceramic 

quantity required. Press the F key, then it will tile the whole region in the 

current tiling mode; 

                

A. Drag mode                            B. Select mode 

3. Left click at an appropriate position, and then the tiles will be tiled 

according to the dragging status before final selecting. New tiles will be cut 

automatically according to the region boundary and existing tiles. Cutting 

result differs according to the setting of cut style. Please refer to Tiles cut 

style. 

Note: The biggest difference between Continuously straight tiling and 

Continuously oblique tiling lies in the generating direction. Choose 

Continuously straight tiling to generate tiles along the direction of tile edge. 

Choose Continuously oblique tiling to generate tiles along the direction of 

diagonal line of tile. 

§3.4.5.8 Interval Oblique Tiling 

Basic operations: 

1. Right click on target tile, and then choose Interval oblique tiling in shortcut 

menu. 

2. Move the mouse, and the system will show the tiling dynamically by a 

square box with the same size to that ceramic. The ceramics will be tiled 

along the two diagonals of the selected one by the ceramic size. The tiling 
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mode is to tile the ceramics at intervals in the rectangle stretched by the 

mouse, and the system will automatically work out the ceramic quantity 

required. Press the F key, then it will tile the whole region in the current 

tiling mode; 

           

3. Drag mode                                  B. Select mode 

4. Left click at an appropriate position, and then the tiles will be tiled 

according to the dragging status before final selecting. New tiles will be cut 

automatically according to the region boundary and existing tiles. Cutting 

result differs according to the setting of cut style. Please refer to Tiles cut 

style. 

§3.4.5.9 Offset Tiling 

Basic operations: 

1. Right click on target tile, and then choose Offset tiling in shortcut menu. 

2. Choose offset direction in the pop-up dialog box. The diagram shows the 

paving effect. Uncheck H-shaped Tiling to input offset distance. 
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3. Move the mouse, and the system will show the tiling dynamically by a 

square box with the same size to that ceramic. The tiling mode is shown in 

the graph in the dialogue box. The ceramics will be offset tiled by rows or 

columns according to the ceramic size in the rectangle stretched by the 

mouse, and the system will automatically work out the ceramic quantity 

required. Press the F key, then it will tile the whole region in the current 

tiling mode. 

§3.4.5.10 Free Tiling 

The Free tiling can realize almost any tile plan. According to this statement, the 

shortcut tile plans provided by the system, from Continuously straight tiling to 

Offset tiling, all can be substituted by Free tiling, except that its operation may 

be more complicated. The Free tiling function is the most essential in this 

ceramic design module. The following description will lay a strong emphasis on 

this function to have you understand its essence. 

Basic operations: 

1. Right click on target tile, and then choose Free tiling in shortcut menu. 

2. The Free Tiling Settings dialog box displays. 
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Here we preliminarily know that there are three parameters to be set in Free 

tiling, that is, two directions and additional slices. Look at the following image. 

We might as well call the ceramic slice with two derivative directions as the 

main slice. It is not difficult to find that the main slice and the Additional slices 

specified in the image is a combination unit in the above tile plan image, while 

the Direction 1 and Direction 2 point at the other two main slices are not in the 

same direction.  

3. Click Tiling direction 1 button and select the main slice for the neighboring 

unit set; 

4. Click Tiling direction 2 button and select the main slice for the other 

neighboring unit set. You should make sure that the selected direction is 

not in a line with direction 1; 

We should understand the selection principle of Tiling direction 1 and Tiling 

direction 2. The slices selected by Tiling direction 1 and Tiling direction 2 also 

are main slices. Considering the slice from which two directions are drawn, 

their unit sets must be adjacent to determine a unique position relationship. 

That is, in order to determine the position of repeated units, you should specify 

Tiling direction 1 and Tiling direction 2. 
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As what the following figure Shows, there are totally six slices in three units. 

The red arrow indicates Tiling direction 1, while the green arrow indicates Tiling 

direction 2, In this graph, we perform operation according to the bigger slice in 

the middle unit. 

 

5. Click Additional slices button, and select all the slices subjected to the 

main one to form a unit set; 

6. After selecting all the additional slices, right click to end selection; 

The additional slices are not essential to the tile plan. If you want to quickly tile 

ceramic slices by using the Free tiling function, just like the simplest 

continuously tiling mode, you can use a single slice to tile without any 

additional slice. You only need to select slices in two intersected directions, 

which is actually to specify two repeating directions and distance. 

7. Return to the Free Tiling Settings dialogue box, and Click OK button; 

8. Drag the cursor, and the system will automatically work out the slice 

quantity required, and dynamically show the range covered by slices by 

using the square boxes with the same size to the slice; 

9. Left click in an appropriate position, and then the new ceramic slices will be 

added to the region. The new slices will be automatically cut according to 

the region border and the existed ones in the region. Also, you can press 

the F key to tile the whole region. It may get different results due to 
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different ceramic cut styles set in the system.  

§3.4.5.11 Details 

Basic operations: 

1. Right click on the target tile, and then choose Details in shortcut menu. 

2. The Ceramic Slice Detail dialog box displays. 

    

§3.5 Border Line 

Program provides function to generate border line automatically. 

There are two types of border line styles: 
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Style 1                                Style 2 

Basic operations: 

1. Pave Border Line 

2. Left click on target region when the cursor is replaced by a small red box. 

3. Left click a point to specify the start position of board line. 

4. Choose a style in the pop-up dialog box. 

5. Click Select button to choose a tile in the database. 

6. Click OK button to create border line. 

§3.6 Tiles Plan 

§3.6.1 Select a Plan 

To make the ceramic design succeed once a time, the system provides a series 

of tile plans taking advantages of basic tiling modes, including instances of 

each basic tiling mode. 

 

Parametric plan 

Basic operations: 

1. Pave Tiles Plan 

2. Select Parametric plan. 

3. Choose a tiling mode in the dialog box, and then click the Select button to 

choose a tile in the database. 
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4. There are options for embedding little tile and board line. Click the Select 

button to choose a tile in the database if necessary. 

5. Click Apply to region button, and then left click on target region. 

6. Left click a point to specify the base point. The slices will be automatically 

cut by the region border. 

 

Floor Plan 

Basic operations: 

1. Pave  Tiles Plan 

2. Choose Floor Plan. 

3. Choose an item from the catalogue, and then double click on target plan. 

4. Left click on target region. 

5. Left click a point to specify the base point. The slices will be automatically 

cut by the region border. 

 

Wall Plan 

Basic operations: 

1. Pave  Tiles Plan 

2. Choose Wall Plan 

3. Choose an item from the catalogue, and then double click on target plan. 

4. Left click on target region. If you click in the left half-area, system will 
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layout tiles from left to right, vice versa. 

§3.6.2 Tiles Plan Management 

§3.6.2.1 Manage Tile Plan Group 

Program already provides many tiles plans. If 

user needs to create his own tiles plan library, 

it is suggested to separate it from system 

library. Program provides the function of 

group maintenance. Right click on existing 

group to display the shortcut menu whose commands can act on the selected 

group. 

 

New group 

Basic operations: 

1. Choose New group in shortcut menu. 

2. Input a name for the new group. 

3. Click OK button to create a new group under current one. 

 

Modify group name 

Basic operations: 

1. Right click on target group. 

2. Choose Modify group name in shortcut menu. 

3. Input new name in the input box. 

4. Click OK button to change the group name. 

 

Delete group 

Basic operations: 

Choose Delete group in shortcut menu. Click Yes button to confirm the delete 

operation. 

§3.6.2.2 New Plan 
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Create new plan to save tiles design. 

 

Floor plan 

Basic operations: 

1. Select Floor Plan. 

2. Choose a group to add new plan. 

3. Click New plan button in Plan operation area. 

4. Input plan name and comment in the dialog box, and then click Select 

slices button. 

 

5. According to the prompt, specify tiles and paving direction. Please refer to 

Free tiling. 

6. After selecting additional slice, press right button or ESC key on keyboard 

to finish selection. 

7. Choose a tile in current selection as the base point of this plan. 

8. The dialog box pops up again. Click OK button to save this plan. 

 

Wall Plan 

The tile plan of walls is different from that of floors. The main difference is that 

the tile of walls can be selectively divided into multiple regions. Generally, the 

division lines of a wall surface are skirt board at the bottom of the wall, waist 

line in the middle, and upper decorative line at the top. The tile plan of walls 

focuses on the division of the region. For each region, only two tiling modes, 

Straight Tiling and Oblique Tiling, are provided to avoid garish titling effect. 

Operations: 

1. Select Wall Plan. 

2. Choose a group to add new plan. 

3. Click New plan button in Plan operation area. 

4. The Tile plan of walls dialog box pops up. 
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The dialogue box has three main parts. The black display region on the left 

indicates the division status of the tile region. It is initialised to be a single 

region when the dialogue box pops up. The component parts are divided by the 

skirt, waist line and upper decorative line. No upper decorative line can be fixed 

if there is no waist line in the wall surface. 

5. By tick selecting the division lines, the component parts can be decided. 

The black display region can show the division status instantly; 

6. After the division, you should select ceramic slices for each part, or titling 

modes, or elevation. Click a certain component part to be edited. The 

system automatically searches for the region and shows it in highlight. In 

the blank region under the Components, the Region Parameters controller 

group appears; 

7. Click Select< button, quit the dialogue box. Select the ceramic slice for the 

corresponding region of the selected plan, and then it returns to the 

dialogue box again. In the black display region, if manufacturer and code 
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of the ceramic are shown, it indicates that the ceramic is selected 

successfully; 

8. Select the titling mode: straight or oblique. When oblique titling, the 

selected ceramic is rotated 45 degree. If the operation region is the waist 

line, then the elevation should be input or picked by the cursor; 

9. Repeat step 6~8 until all components of the wall surface have selected 

with the ceramic and the parameters have been set; 

10. Click OK button, and then the current image in the new plan region of the 

system will be used as the plan display icon. 

Note: before creating the new tile plan, generally you should first finish the 

titling of the plan, and then perform the creation operations for the new plan. It 

also can be understood as the save operation to the current plan in order to call 

it at the next time. Moreover, the plan icon displayed in the worktable can 

reflect the contents of the plan in reality, so it is easier to be managed and 

maintained. Of course, you can also use the New plan… command to construct 

the tile plan. 

§3.6.2.3 Maintenance Tiles Plan 

Right click on a plan to display shortcut menu. 

 

Copy plan 

Basic operations: 

1. Choose Copy plan in shortcut menu. 

2. Input new name for copied plan. 

3. Click OK button to create new plan. 

 

Modify plan 

Basic operations: 

1. Choose Modify plan in shortcut menu. 

2. Please refer to 3.6.2.2 New plan for the following steps. 

 

Delete 

Basic operations: 

1. Choose Delete in shortcut menu. 
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2. Click Yes to delete the plan from library. 

 

Change image 

Note: this function only changes the preview image of a plan. 

Basic operations: 

1. Choose Change image in shortcut menu. 

2. Find a Jpg format image in the pop-up dialog box. 

3. Double click on target image to replace the original one. 

 

Save image as 

Basic operations: 

1. Choose Save image as in shortcut menu. 

2. Specify storage path and name for this image in the pop-up dialog box. 

3. Click Save button to save this image. 

§3.7 Assistant Function 

Program provides a series of assistant functions to make the ceramic design 

fast and accurate. 

§3.7.1 Anchor 

The anchor is used for precise location of ceramic slice. The ceramic can use 

the anchor to determine its location. When tiling different ceramics by areas or 

tiling the waist line in the given position, etc., it will be very important to set the 

ceramic anchors, by which you can control the division of areas precisely. 

Basic operations: 

1. Pave  Anchor 

2. The Anchor location dialog box pops up. 

3. Left click to select a base point. 

Move cursor and program will display the relative location between cursor and 

base point. 

4. Left click to add an anchor. 

5. To add an anchor at specified location, input distance along X and Y 

axis in the Anchor location dialog box. 
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§3.7.2 Hide All Anchors 

After finishing the ceramic design, you can use this command to hide them 

because we don‟t use them when we print out the picture. 

§3.7.3 Show All Anchors 

This command will show all the anchors that are hidden by the Hide All 

Anchors command. 

§3.7.4 Tiles Cut Style 

In ceramic design, the ceramic cut is not the only one kind of operation mode. 

You can design flexible tile plans by the ceramic cut. The ceramic can be cut to 

various shapes, and by certain combination you can work out the distinctive tile 

plans. 

During the course of tiling, once the ceramic being dragged is intersected with 

the existed ones in the region, the superposed part should be cut. The ceramic 

cut style may be one of the two options, shown as the following dialogue box: 

            

The different cut styles may get different results. You can select either 

according to your needs. 

Basic operations: 
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1. Pave  Tiles Cut Style 

2. Choose an option and click OK button to apply the setting. 

§3.7.5 Tiles Create Method 

The ceramic create style is mainly used in the slice whose shape has been 

changed (usually been cut). It determines whether to tile the ceramic slice by 

its original shape or to keep its shape unchanged when you want to tile it in the 

region. If you want to tile it by its current shape, then the system will ignore its 

original shape. When you want to select the tiling mode for the ceramic slice 

that has been cut, you should set the create style. 

Basic operations: 

1. Pave  Tiles Create Method 

 

2. Choose an option in the dialog box according to the explanation and 

schematic diagram. 

3. Click OK button to apply the setting. 

§3.8 Tiles Quotation 
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This function is integrated in the worktable. First, press the Spacebar one time, 

and it pops up the “Worktable” dialogue box, and then select the Tiles 

Quotation tab; Second, directly click the “Tiles Quotation” command from the 

Pave menu. 

In the pull-down menu of Region, the system records all the region names 

automatically. The sheet below is the ceramic usage report list, each row of 

which records the usage of each kind of ceramic. Each time you add a region 

to the system, add ceramic slices to a region or delete ceramic slices from the 

picture, system will automatically update the ceramic usage report list. Or you 

can click the Refresh button to make the modification valid real time. 

Methods for ceramic usage statistic 

System provides two methods for ceramic usage statistic: by pieces and by 

area. 

The Count by pieces method is to sum all the ceramic slices in the drawing. 

The ceramic slice that has been cut is also considered as a whole one. 

The Count by area method is to calculate all the tiling areas for a certain type of 

ceramic slice first, and then divide the area of one slice, and then work out the 

total usage according to the conversion coefficient (wastage). 

Basic operations: 
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1. Select the required ceramic type in the list. Then the Modify Data field at 

the bottom of the dialogue box is enabled; 

2. Select a method in the Modify Data area; 

3. If you have selected the Count by area option, then you should input the 

Wastage data; 

4. Input the unit price, which is the price per piece without considering 

different methods; 

5. Press the Refresh button; 

6. System will recalculate the quantity of used ceramic slices by the new 

wastage. 

Print the usage report 

After finishing the ceramic usage statistic, you can print the usage report. Press 

the Quotation button, and then it produces the following print manager. 

            

Input user information in the report, make proper modification, and then click 

the print icon in the toolbar to print it. 

Note: before printing or the usage report has not been updated automatically, 

you can press the Refresh button to display the correct data. 

§3.9 Ceramic Database Management 

By using this function, users can use their own products into the system 

database, modify or delete the records in that database. 
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Select the Tiles Database from the Pave menu, a Products Manage Tool 

window pops up as follow: 

 

This interface is divided into two parts: the first part is the function buttons area 

at the top, which integrate all the data maintenance functions; the second part 

is the data window, which displays the data of the ceramic library. User can 

also add his own product information here. 

§3.9.1 Function Buttons 

1. Add 

Function: add new item of ceramic data to the database. 

2. Delete 

Function: Erase the selected item from the database. 

3. Query 

Function: only display the ceramic data in accordance with the query conditions 
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in the data window. 

4. Columns 

Function: set the display mode of ceramic data, for example, whether to hide 

some property columns, or change the order of property columns. 

5. Merge Database 

Function: According to the manufacturer and the product code, update the 

same products in two databases, and add new absent products. 

6. Show All 

Function: show all the data in the data window. Usually it is done after query. 

7. Show Picture 

Function: show the picture of the item selected in the data widow. 

§3.9.2 Add Ceramic to Database 

1. Click the Add button, and then a row of record will be added to the data 

window automatically. The Code column of the new record is automatically 

set to 0, and all the other properties will use the data of the last product 

recorded in the data window. The cursor is automatically located at the 

Code column. User can input the manufacturer name directly from the 

keyboard, or select it from the drop-down list. If there is no need to modify 

the Factor, then you only press the Enter key. If it is a new manufacturer, 

then its name will be saved in the drop-down list box for later use; 

Note: the data cannot be empty; otherwise it will prompt that there is an 

error and the data cannot be saved. 

2. Press Tab or Enter ion the keyboard to enter the next Code column. The 

column usually is set to 0. Make sure that this column is not empty and it 

can determine the unique product in the database by combining with the 

Factor column. After inputting its value, press Tab or Enter to enter the next 

column; 

3. Input other product properties. The recording examination of different 

product properties may be different, but their operation modes of inputting 

or saving are similar. 

The format of Spec. is ???*??? where the ? indicates a number, while * 

indicates the multiplication sign. If the format is improper, the data cannot 

be saved. For example, 300*60 is a legal input, while 3e0*60 is a illegal 
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input; 

The Price must be a number. There is only Piece option provided for the 

Unit column, so you cannot change it. 

The Picture column may be empty. User can input the corresponding 

picture path for the product by himself, or click the ... button on the right 

side of the column, select the file name of corresponding picture in the 

popup file dialogue box, and then click the Open button, so that the ceramic 

picture has been specified. 

Note: 

1. Two ceramic records with the same manufacture and code are not 

allowed to exist in the database. 

2. You should set in the Columns button as all the columns will be 

displayed to avoid missing the modification to the newly added item. 

§3.9.3 Modify Ceramic Information in 

Database 

1. Browse the data window to find out the ceramic record to be modified; 

2. Select the column to be modified, and then modify it directly in the data 

window. The modified data will be automatically saved to the database. 

§3.9.4 Delete Ceramic Record from Database 

Select record 

1. Browse the data window to find out the ceramic record to be modified; 

2. Select one record by click on it; 

3. Hold the Ctrl key while clicking other records to do multiple selection, and 

then these records will also be selected; 

4. Hold the Shift key to select all the records in between two clicks; 

5. Select all the records by the shortcut key Ctrl + A. 

Delete record 

Cursor status 

Edit status: the status when the cursor is in a certain property for editing, 

usually when you add or modify the ceramic records. 
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Selection status: the status when you can press the DOWN or UP key to move 

the blue bar to select a record. 

1. Select the record to be deleted, and then press the Delete button; 

2. Select the record to be deleted. When the cursor is in the selection status, 

press the function key Delete. 

3. Select the record to be deleted. When the cursor is in the edit status, press 

the shortcut key Ctrl + Delete. 

§3.9.5 Query Ceramic Record 

1. Press the Query button (or press the function key F3), and it pops up the 

Query dialogue box; 

2. Specify the query conditions; 

3. Press the Query button, and then all the qualified records will be listed in 

the data window; 

4. After query, press the Close button to exit the dialogue box. 

§3.9.6 Set Display Status of Ceramic 

Properties 

If there are many ceramic properties and they cannot be displayed in one 

screen, it is necessary to set the ceramic display status, so that you can hide 

the unnecessary properties to simplify your operations. You can change the 

order of the property items by dragging and placing. However, the user cannot 

change the display status or the order of serial number, code and manufacturer. 

These three items can not be changed. 

Basic operations: 

1. Press the Columns button (or press the function key F4), and it pops up 

the Column setting dialogue box; 

2. In the data window of the dialogue box, it lists all the names of property 

columns. Click the left square box by the left button. The √ symbol 

indicates the display status, and the corresponding column will be 

displayed in the data window; 

3. Select the name of one property column, press the left button and hold it to 
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drag this property item. Here a dragging bar will be displayed. When the 

dragging bar moves to an appropriate position, release the button, and 

then that property item will be moved to the position of the dragging bar. In 

the same way, you can change the order of other properties. 

4. After setting, press the OK button to validate the modification. If you press 

the Cancel button, then it will abort the modification and exit. 

§3.9.7 Sort and Column Replace 

The Sort and Column Replace is an additional function, and the system doesn‟t 

provide corresponding function buttons for them. You can activate the function 

by right button. 

Sort 

Specify the ceramic property column to be sorted, and left click on the table 

head in the data window, and then the sort function is activated and the sort 

arrows are also displayed on the corresponding table head. The upward arrow 

indicates to sort by an ascending order, while the downward arrow indicates to 

sort by a descending order. Also you can click the right button on the 

corresponding table head, and it pops up a shortcut menu. Click the Ascending 

or Descending command to sort. 

Column Replace 

The Column Replace operation is very dangerous, and the content replaced by 

this command cannot be restored, so it is recommended that the user should 

not perform this operation if not necessary. 

1. Specify the whole column to be replaced, and right click on the 

corresponding table head in the data window. It pops up a shortcut menu. 

2. Select the Column Replace command, and it pops up the Column Replace 

dialogue box; 

 

3. Input the content to be replaced, and press the OK button to replace the 
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whole column, or press the Cancel button to abort replacement. 

Note: because each code has to be unique, it is not allowed to replace the 

Code when you use the Column Replace function, so as to prevent disastrous 

result. 

Chapter 4 Basic Structures 

This chapter introduces some basic structures in InteriCAD T5, including wall, 

elevation, door and windows, ceiling, and floor, etc., and also provides detailed 

description on the setup and modification to them. 

§4.1 Modeling Interface 

 

Menu Bar: Where software commands are placed, you can use them by 

clicking the left mouse button. 

Tool Bar: Where most common commands are placed, you can use them by 

clicking the left mouse button. 
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Drawing Window: The area where you can make drawings. The system 

defaults as a four-view form. The one in the left upper corner is front view, in 

the left lower corner is top view, in the right upper corner is side view, and in the 

right lower corner is isometric view. 

Command Window: The place where you can input commands. 

Status Bar: Display cursor coordinate and mode status. 

Construction Graph Screen Menu: Most common Construction Graph 

commands. 

§4.2 Grid on Axis 

Grid on axis can provide the reference for locating and quickly build up the 

walls. 

§4.2.1 Grid on Axis 

Grid line on axis includes orthogonal grid on axis and oblique grid on axis. The 

vertical and horizontal axes of the orthogonal grid on axis are perpendicular, 

while the axes of oblique grid on axis intersect each other with an angle not 

equal to 90°. 

Basic operations: 

1． Select the grid on Axis... from the structure menu. 

2． Input definition data of the grid on axis in the Grid on Axis dialogue box. 

Press OK. 
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User can input various parameters of the axis in each field. Input dimension 

parameters in Number and Dimension field and press Add button to add these 

parameters to the end of the corresponding list. The parameters can be input 

one by one. Buttons such as Insert, Delete, Modify and Reset can be used to 

modify the parameters. 

Explanation of each field in the dialogue box: 

 South End: the section dimension labels the axis below the current 

input axis zone. 

 North End: the section dimension labels the axis above the current 

input axis zone. 

 West End: the interval dimension labels the axis left to the current 

input axis zone. 

 East End: the interval dimension labels the axis right to the current 

input axis zone. 

 Horizontal axis angle: the inclination between the latitudinal axis and 
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the horizontal direction. Normally the value is 0. 

 Vertical axis angle: the inclination between the longitudinal axis and 

the horizontal direction. Normally the value is. 

 Add: add Number and Dimension parameters to the end of the 

corresponding list. 

 Insert: if one item has been selected in the list, insert a new item 

before it. 

 Delete: if one item has been selected in the list, delete it. 

 Modify: if one item has been selected in the list, use a new one to 

replace it. 

 Reset: Reset all the data in the dialogue box. A sub-dialogue box will 

popup to prevent unintended operation. 

 Single direction: When this option is active, the generation method of 

the axis changes to single direction, and South end, West end and East 

end become unavailable. The position and angle of the grid on axis in 

the single direction is determined by the base point and horizontal 

angle. 

3． Select a point in the view port to specify the insert point of the grid on axis. 

Examples of grid on axis (the data in these examples is shown in the above 

dialogue box): 

 

 

 

Orthogonal line grid on axis 
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   Orthogonal grid on axis with rotation angle        oblique grid on axis 

§4.2.2 Grid on Center 

The grid on center is made up of some homocentric arcs and the line segments 

that pass through the center of the circle. 

Basic operations: 

1． Select grid on Center... from the structure menu. 

2． Input the parameters in the Grid on Center dialogue box. Press OK. 

 

User can input various parameters of the axis in each field. Input dimension 

parameter in Number and Dimension field and press Add button to add these 
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parameters to the end of the corresponding list. The parameters can be input 

one by one. Buttons such as Insert, Delete, Modify and Reset can be used to 

modify the parameters. 

 Explanation of each field in the dialogue box: 

 Sections: the section partition sequence determined by current rotate 

direction, shown in angle using degree as unit. 

 Interval: the interval dimension sequence ranking ascending. Use mm 

as its unit. 

 Angle: the angle of the section (represents wrap angle when divided 

equally). 

 Number: the repeat number of times of the section angle (represents 

division number when divided equally). 

 Dimension: the length parameter of the interval. 

 Number: the repeat number of times of the interval dimension. 

 Radius: the radius of the most inside grid on center. 

 Angle: the inclination between the start of grid on center and X-axis 

forward direction. 

 Shared axis: the value indicates whether to draw the axes in the 

intersection with other grids. It has four forms. 

 Locating point: the insert point of grid on center. It has three positions. 

 Equal parts: when this option is active, the section angle represents 

the whole wrap angle. 

 Direction: when this option is active, the grid on center is generated in 
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the clockwise direction. 

 Add: add Number and Dimension parameters to the end of the 

corresponding list. 

 Insert: if one item has been selected in the list, insert a new item before that 

one. 

 Delete: if one item has been selected in the list, 

delete it. 

 Modify: if one item has been selected in the list, 

use a new one to replace it. 

 Reset: Reset all the data in the dialogue box. A 

sub dialogue box will pop up to prevent 

unintended operation. 

3． Determine the locating point of grid on axis. 

The figure shown below is the grid on center based on the data in the dialogue 

box above. 

§4.2.3 Display Control of Grid on Axis 

It is convenient to control the showing and hiding of the grid on axis. 

The command of controlling the display of grid on axis is Grid, Hide and Show 

which are under the Structure menu. The entire grid on axis is hidden after 

using Hide command and will be shown again after using Show command. 

§4.3 Wall 

Wall is indispensable during the interior design. InteriCAD provides a 

comprehensive set of tools for building and modifying the wall, by which you 
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can easily build a straight wall or curve wall. 

§4.3.1 Build a Wall 

The system provides several methods to build a new wall, such as direct 

building, grid base, wall line and building a rectangular room. The new-built wall 

will use the system default height and thickness. You can change these values 

by using attributes edit function. For more information, please refer to Wall 

attributes editing.  

§4.3.1.1 Build a New Wall 

Note: Provides the simplest and most accurate ways to build a wall, including 

straight wall, curve wall, and rectangular wall, which the wall distance may be 

between inner walls, center walls, or outer walls. 

Basic operations： 

1、 Select New wall from Structure menu; 

 

2、 Select Straight wall, Curve wall or Rectangular wall. Then set the width and 

height of the wall, finally select left line, centre line, or right line as require.  

3、 Draw the wall with in the plane window and press Enter after completion. 

§4.3.1.2 Build Walls Using Grid Base 

Grid base method is a faster way to build a set of straight walls. 
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Basic operations: 

4. Select Grid base wall from Structure menu; 

5. Select grid base used to build walls. 

6. Right click to finish, and the system will analyze the selected grid base 

to 

generate 

linear 

walls. 

§4.3.1.3 Build Walls Using Line Base 

Construct a wall by using line base method either by straight or curve wall. The 

wall line can only be line or curve; any other objects will be filtered. 

Basic operations: 

1． Select Line base wall from Structure menu. 

2． Select straight line or curve to be used as line base. Press Enter. 

3． Select whether to keep line base. Input Y for yes, otherwise input N 

(command window). 

4． Select whether some wall bodies will be displaced relative to the line base. 

If no wall to be placed, click the right button to end. 

If one axis has been chosen, system will ask you to enter the displacement. 

Click the left button to identify the location. System will correct the axis 

according to the displacement. 

Shown as the following, several parts of wall bodies have been built by 
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using straight and curve wall. 

 

 

 

 

§4.3.1.4 Build Room 

For improving design, system provides the function of building rooms. You only 

need to define the base point, length and width of the room, and a rectangular 

room with walls on four sides will be setup. 

Basic operations: 

1． Select Build room from Structure menu.  

2． Choose the left lower corner of the room. 

3． Specify the length of the room. (The distance of X direction.) 

4． Specify the width of the room. (The distance of Y direction.) 

5． Input the rotation angle of the room relative to the forward direction of X axis, 

which use Counter-clockwise direction as the forward direction. Click right 

button or press Enter directly means that zero degree angles has been 

input. 

§4.3.2 Wall Editing 

The wall editing mentioned here is different from the wall attributes editing. 

Attribute editing is mainly to modify the parameters of the wall, such as height, 

thickness, start point and end point of the wall. What involves here is the 

modification of the wall‟s appearance, not the direct modification of the wall‟s 
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parameters. 

System provides a set of comprehensive tools for wall editing: Update, Move 

endpoint, Break, Trim, Cut, Extend, Fillet offset and Trim corner.  

§4.3.2.1 Update 

During the design process, you often apply operations to the wall, such as 

adding or removing a door or a window. All these operations may ruin the 

integrity of the wall. After editing, there may be some defects displayed on the 

screen. When this happens, you can use Update command to return to normal. 

Basic operations: 

1．Select Wall from Structure menu, then Edit\Update. 

2．Select the wall to be updated and press Enter.  

As shown, a door has been deleted from the wall, but the door‟s outline is 

still on the wall. For addition, another straight wall has been moved to 

intersect with it. All these lead to the error display of the intersection graphic. 

After using update command, the actual graphic of the wall is shown on the 

right side of the picture below. 

 

§4.3.2.2 Change Endpoint 

This function is to change the start point and end point of the wall. It is valid 

only for straight wall. The changing of curve wall‟s endpoint can be done with 

tools such as extending and trimming. 

Basic operations: 
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1. Select Wall from Structure menu, then Edit\Move endpoint. 

2. Select the wall to be modified and press Enter. 

3. System will automatically identify the endpoint to be changed based on 

the selected point which you use when select the wall. 

4. Specify the new endpoint.   

Note: When using this function to edit a wall, all other wall will be 

updated automatically. 

§4.3.2.3 Break 

This function is used to break a straight wall from any two points and make it 

into two parts. It is valid only for straight wall. If you want to break curve wall, 

then use such functions as trimming and truncating. 

Basic operations: 

1． Select Wall from Structure menu, then Edit\Break 

2． Select the wall to be broken. 

3． Select the first point to be broken. 

4． Select the second point to be broken. 

Shown as the following, a straight wall has been broken into two parts from 

the two specified points. 



InteriCAD T5 User Manual 

 94 

 

Note: When using this function to edit a wall, all other walls will be updated 

automatically. 

§4.3.2.4 Trim 

Use a line or a wall to trim the wall. The range to be trimmed can be specified 

by line, straight wall or curve wall. This function is applicable to straight and 

curve wall. 

Basic operations: 

1． Select Edit wall from Structure menu, then Trim. 

2． Select the range of line or wall to be trimmed. 

3． Select one end of wall to be trimmed. When selecting, the selected point 

should be near to the end to be trimmed. 

In the following example, we use a linear wall to trim another linear wall and 

an arc wall. 

 

 

 

Note: When using this function to edit the selected wall, all other wall will be 

updated automatically. 
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§4.3.2.5 Cut 

This is an expansion of the trim function. On performing this function and after 

a wall is selected, the system will automatically search for the cutting 

boundaries according to the selected point, and automatically process the wall 

intersection after cutting. 

Line, straight and curve wall can be looked as a cutting boundary. 

Basic operations: 

1．Select Edit wall from Structure, then Cut. 

2．Select a wall. The system will automatically cut the wall according to the 

selected point. 

Note: When using this function to edit the selected wall, all other walls will be 

updated automatically. 

§4.3.2.6 Extend 

This function enables a straight or curve wall to extend to the selected 

boundary. After you select a wall, the system will decide which end the selected 

point is close to, and the corresponding end will be extended. 

The extended boundary may be a line, straight or curve wall. 

Basic operations: 

1． Select Edit wall from Structure menu, then Extend. 

2． Select the extended boundary. 

3． Select the walls to be extended. 
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Note: When using this function to edit the selected walls, all other walls will be 

updated automatically. 

§4.3.2.7 Fillet 

This function can be used to fillet linear walls intersected or non-intersected 

(but unparallel). The system automatically decides which end of walls will be 

filleted according to the selected point. Whether the fillet operation will be 

successful is also relative to the fillet radius. If the radius is too big the 

operation will be failed. 

This function is only applicable to straight walls. 

Basic operations: 

1． Select Edit wall from Structure menu, then Fillet. 

2． Select the first wall. Note that the selected point should be close to the end 

to be filleted. 

3． Select the second wall. Note that the 

selected point should be close to the end 

to be filleted. 

4． Input the fillet radius. It should be calculated from the wall baseline. 

§4.3.2.8 Offset 

This function can be used to build new walls with a specified distance to the 

referenced wall.  



InteriCAD T5 User Manual 

 97 

Basic operations: 

1． Select Edit wall from Structure menu, then Offset. 

2． Input the offset value. It should be calculated from the wall axis. 

3． Select the wall to be offset. 

4． Select the offset direction. For example, if you want to offset on the left side, 

then click there. 

5． If you want to offset other walls, then repeat step 3 and 4, at which the offset 

value is same to the first time. 

6． Click right button to finish. 

If you want to offset a curve walls, you must pay attention to the offset value, 

otherwise the model will be transmuted. For example, the curve wall have 

been offset two times, the curve of the last wall has disappeared. 

 

 

 

Note: When using this function to edit the selected wall, all other walls will be 

updated automatically. 

§4.3.2.9 Trim Wall Corner 

During the design process, error may occur between the intersected straight 

walls with exceeding or lacking segments. You can use this function to improve 

their intersection.  

This function is only applicable to straight wall. 
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Basic operations: 

1． Select Edit wall from Structure menu, then Trim corner. 

2． Select the first wall. Note that the selected point should be close to the wall 

corner. 

3． Select the second wall. Note that the selected point should be close to the 

wall corner. 

 

 

§4.3.2.10 Convert Wall to Solid 

The system provides the function to change walls to solids, by which you can 

perform Boolean operations and easily process complex modeling operations. 

Basic operations: 

1． Select Convert Wall to solid from Structure menu; 

This dialogue box indicates the way to convert and decides whether to 

union all solids. If all walls belong to one timber in the virtual reality (VR), it 

is recommended to select this check box. 
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2． Select the walls to be converted. If it is All walls, then it is necessary to 

specify the path and file name to save the solids graphics file. 

§4.4 Perimeter & Skirting 

YFCAD software has a vast range of usage with perimeter, which can be used 

to create ceiling, floor, and skirting, etc. It must be a closed polyline when 

creating the floor and ceiling. We can use the Perimeter function to create a 

perimeter in a room in no time. 

Basic operations:  

1． Select Perimeter in the Structure menu; 

2． In the command window, system will ask you to appoint a point in the room. 

Left click inside the room area, and you can see the inside wall line will 

change to dotted line. Press enter to confirm selection. Then the perimeter 

of this room is created.  

Note: The room must be a closed room so the system can search the area 

successfully.  
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§4.4.1 Perimeter Offset 

After creating the perimeter, you can offset it to a different location and 

dimension. 

Operations: 

1． Select Perimeter offset in the Structure menu; 

2． Command window will instruct you to enter a length for the offset distance; 

3． Left click in the room to get the perimeter, then the perimeter will be in 

dotted line; 

4． Left click inside the perimeter or outside the perimeter to define the position 

of the new perimeter;  

5． The new perimeter will be generated immediately.  

§4.4.2 Skirting 

Creating a skirting is similar with creating the perimeter.  

Operations: 

1． Select Skirting in Structure menu; 

2． A window of Molding Parameter will pop up, asking for the parameters of 

thickness, height and elevation. If you choose Auto search baseline, 

system will ask you to pick a point in the room. Left click and it will search 

the perimeter created in the room and create a simple skirting. If you 

choose Select baseline, you will need to pick a closed polyline to create the 

skirting.  

3． To change the style of the skirting, please refer to the command of Attribute 
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Edit Library.  

§4.5 Column 

§4.5.1 Square Column on Axis 

You can use the grid on axis to generate the square columns. The square 

columns will be generated in the intersection point of the axis. 

Basic operations: 

1． Select Square Column from the Structure menu, and then On axis. 

 

2． Input the parameters in the Square Column dialogue box. Press OK. 

You can use the keyboard to input the dimension parameters of the column or 

use the slide bar on the right side to adjust the value. The result will be 

displayed in the dialogue box. 

Meaning and function of each field of the dialogue box: 

 Size Y: the width of the square column. 

 Size X: the length of the square column. 
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 Delta_X: the distance that the square column shifts horizontally from the 

intersection point of axis. 

 Delta_Y: the distance that the square column shifts vertically from the 

intersection point of axis. 

 Angle: the inclination between the square column and the base line. 

 Size Z: the height of the square column. The default value is 3000 mm. 

3.  Drag the mouse and select an area using window mode. All the 

intersection points of the grid on axis stayed in this scope will be marked with a 

cross and a square column will be generated in every position of the cross. 

Right click to finish operation.  

 

 

 

Note: in the intersection point of the grid line on axis, the column will adjust the 

rotation angle based on the axis with a smaller slope. The column in the 

intersection point of the grid on center will adjust the rotation angle according to 

the radial direction axis automatically. 

§4.5.2 Round Column on Axis 

Insert the round column according to the gird on axis. The dimension of the 

round column can be defined in the Round Column dialogue box. 
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Please refer to the Square Column dialogue box for detail information about the 

meaning and function of each field of the dialogue box. 

Inserting round column on axis is similar to square column. 

§4.5.3 Freestanding Square Column 

The location of the column is flexible and more columns can be generated at 

one time. 

Basic operations: 

1． Select Square Column from the Structure menu, and then Freestanding. 

2． Input the parameters in the Square Column dialogue box. Press OK. 

3． Select the location point in the drawing. 

4． Repeat step 3 to build more columns. Otherwise press Enter or the right 

button to finish. 

§4.5.4 Freestanding Round Column 
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You can insert the round column in any position. The operation is the same as 

the square column. 

§4.5.5 Delete Column 

This operation is for deleting the column. 

§4.6 Doors and Windows 

The system provides a variety of door/windows and accessories, and editing 

tools. The door/windows library is open to users and you can add in 

self-defined styles to it. 

 

§4.6.1 Insert Doors and Windows 

There are more than 200 types of door and windows in the system. It also 

provides various kinds of curtain, frame, doorpost, door-handle, curtain and 

partition. Now we take door and partition as examples. There are two methods 

to create door and window. 

Operations (Method A): 

1． From Door/Window menu select Library.... 
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2． Select a style of door and windows from the library and double-click it. 

3． In the Door and Window dialogue box, input the parameters of the door and 

windows. 

The meanings of each field in the dialogue box are clearly shown through 

the drawing in the picture. Select a wall in which the door and windows will 

be inserted. 

4． Along the wall, the distance from the door and windows to the wall endpoint 

is displayed dynamically. Locate the position of the door/window.  

5． A new door or windows is created on the wall in a default orientation. 

System will ask you whether to turn it inside or outside and to turn it left or 

right. The default answer is N. The position of the door and windows doesn‟t 

change while being turned. 

6． If you want to continue to insert the same door and windows into other walls, 

repeat step 4-6. Otherwise press right button or Enter to finish. 

Operations (Method B): 
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1． Select Door/Window menu  Insert 

2． A prompt to define door and windows will appear, in which you can set the 

size and offset distance. You can press Select to choose models from 

library like Method A, or press Pick value to copy a model from the existing 

doors or windows. 

3． Press OK and pick a wall to insert the door or window. The operation will be 

same as method A. 

§4.6.2 User Define Window 

User define window can be designed and imported into virtual reality.  

Operations: 

1． Draw the shape of door or window as you prefer. External contour line and 

internal line must be included and created in PLINE. Remember the 

external contour line must be closed. Example shown as below: 

 

2． Select Door/Window menu, and then User Define Window. 

3． Define Parameter, including size, outside frame and etc.  
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4． Click Pick or Select window style. Shown as below: 

 

5． Once setting is finished, click Yes. Select the wall for locating the window.  

§4.6.3 Parameterized Window 

1． Select Door/Window menu, and then Parameterized Window. 

2． Select Window design and define Parameter.  
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3． Once setting is finished, click Yes. Select the wall for locating the window.  

§4.6.4 The Cover of the Doors and Windows  

The system provides various styles of the door and windows and editing 

function. User can construct a door and windows frame with various section 

styles. 

Basic operations: 

1． Select Door/Window Cover from the Door/Window. 

2． Select the frames that will be generated. 
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3． Select the style of the section line from the Frame dialogue box and 

input the dimensions of the frame. 

4．  

User can select different frame forms and styles provided by the system 

library or customize them. 

 Draw the modeling segment of the inner and outer section line of the 

door and windows‟ frame using polyline in the plane view. You don‟t 

need to draw the actual dimension. But the direction of the Y-axis 

coordinate of the start and endpoint should be the same. 

 Select customize and the pre-draw modeling segment in the plane 

view. The system will adjust it to proper dimension automatically. 

 

5． Select OK and the frame will be generated automatically. 

§4.6.4.1 Update 
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Similar to the function of updating wall, door update will fix the display error 

after some editing works on the doors and windows. 

Operations: 

Press Door/Window menu  Update 

§4.6.4.2 Modify Open Direction 

You can change the open direction of a door or window with this function.  

Basic operations: 

Press Door/Window  Modify Open Direction, then the dialogue of changing 

the direction of in/out, right/left will appear again in the command window.  

§4.6.4.3 Edit the Cover of the Doors and Windows 

The styles and data of the frame can be modified using frame-editing 

command. 

Basic operations: 

1. Select Edit Cover from Door/Window menu. 

2. Select the cover that will be modified and modify the data and style in 

the Door-Win Cover dialogue box. Press ok after you finish. 

§4.6.4.4 Copy the Cover 

These function of copying the generated frame to other doors and windows.  

Basic operations: 
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1． Select Copy Cover from the Door/Window menu 

2． Select the cover that will be copied. 

Select the door and windows on which the cover will be generated. 

§4.6.5 Edit the Doors and Windows 

You can use the attributes to edit the basic data of a door and windows. For 

more information, please refer to Attributes editing. 

The editing tools introduced here do not involve the modeling data of the door 

and windows. 

§4.6.5.1 Copy the Doors and Windows 

This function is more powerful than ACAD. It provides the dynamic locating 

method and can automatically update the wall where a door and window is 

placed. 

Basic operations: 

1． Select Copy from the Door/Window menu. 

2． Select the door and windows that will be copied. 

3． Select a wall where the copied door and windows will be placed. 

4． Determine the position of the door or window on the wall. Please refer to 

Door and Window Locate for locating method. 

5． The copied door and windows will be placed on the default position of the 

wall. The system will ask you about the direction of the door or windows.  

6． Repeat the operations of 3-5 if you want to continue copying the door and 
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windows into other walls. Otherwise press the right button or Enter to finish. 

§4.6.5.2 Move the Doors and Windows 

The system provides more accurate function to move door and windows. This 

function is more superior to the tool of ACAD. It provides the dynamic locating 

method and can automatically update the wall where a door and windows is 

placed. 

The system provides two commands to move the door and windows: Single 

Movement and Multiple Movement. Multiple Movement tool can move multiple 

doors and windows at the same time on the same wall. 

Basic operations: 

1． Select Multiple Movement or Single Movement from the Door/Window 

menu. 

2． Locate the door and windows. When using dynamic locating, the dimension 

line of the door and windows will be displayed. 

3． Move the mouse to the proper position and press the left button to 

determine the final position of the door and windows location. 

§4.6.5.3 Display Control of the Door and Windows 

Under the ventilation mode, the hidden display of the door and windows need 

to be controlled. 

The system provides the door and windows display control tool and you can 

startup them by selecting Hide and Show from Door/Window menu. The Hide 

command can hide one or more doors and windows selected, while the Show 

command display all the doors and windows, including all currently hidden and 
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unhidden doors and windows. 

§4.6.6 Add the Door and Windows into the 

Library 

After you finish the preparation work, the door and windows drawing can be 

added into the library and becomes an element for further use. If all the six 

preparation steps mentioned above have been done, the new added door and 

windows will be the equivalent with the original in the library, and all the 

operations are same. 

Before adding the door and windows into the library, please ensure that no 

other drawing is in the Windows so that the accuracy of the slide will not be 

affected. In addition, 2D layer should be visible if there is plane icon so that the 

drawing of the door and windows plane icon can be selected. 

Basic operations: 

1． Open the system library interface, switch to the user library and press the 

right button and select Add Library. 

2． In the Selection Type dialogue box, select Door and Windows in Type, and 

press OK. 

3． In the Input Data dialogue box, assign the names of the door and windows 

and their materials. Assign the file name that will be used to save the door 

and windows drawing. Assign the customize object as door or window and 

press OK. 

4． Select the boundary curve of the door and windows. 

5． Select all the drawings that make up the door and windows, including the 
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plane icon (if available). 

6． Assign the base of the door and windows. 

The system will automatically add the drawing into the library and generate its 

slide. If necessary, you can make a new slide to cover the one generated by 

the system (the same position with the saved graph file). 

§4.7 Elevation Decoration 

The wall decoration plays an important role in the room decoration. InteriCAD 

provides a variety of solutions for wall design, including complete finishing 

types, abundant partition methods and various styles of plates, which enable 

you to decorate wall with ease. 

All of the elevation decoration methods (finish, partition and plate) are valid to 

straight walls only. For curve wall you must build an equivalent wall, and then 

decorate the equivalent wall, finally map the decoration to the corresponding 

curve wall through the Resume function. 

§4.7.1 Elevation Setup 

Generally, a wall is vertical to the world coordinate system (WCS). There are 

certain difficulties and troubles in processing the vertical walls in that position 

such as snapping a point or drawing a line on the way. However, if we set up a 

user coordinate system (UCS) and work it on the elevation, then all operations 

will be same to those in the WCS. 

§4.7.1.1 Elevation Setting 

There are two way to set elevation: set up the user coordinate system vertical 

to the world coordinate system and trim the window accordingly to the specified 

direction. 

Set up user coordinate system with two methods: first select a straight wall and 

set the UCS to the wall; second select two points to define the elevation 
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location and set the UCS to the elevation. 

After setting up the UCS, trim the elevation window according to the view 

direction. 

Basic operations: 

1． From Elevation menu select Set UCS. 

2． Select the method to set the user coordinate system. 

 If input P, then use a straight wall to set the user coordinate system, and 

the system will ask you to select a wall. 

 If select one point directly on the screen, then use two points to set an 

elevation. A shirr from the first point to the cross cursor appears on the 

screen, and the system will ask you to select the second point. 

3． Select the side to which you stand and decided the observation direction. 

How to decide the view direction: it should be vertical to the set elevation 

and its vector direction is from the standing side to the elevation. 

4． Select a window as the elevation view. 

After setup, in the elevation view only those graphs at the same side with 

the elevation relative to the observation position will be displayed, and the 

others will be hidden. The graphs in additional windows remain unchanged. 

If you want to return to the world coordinate system after finishing the 

elevation processing, then select Return WCS from Elevation menu. 

§4.7.1.2 Origin Point Setting 

Use this function to set the origin of a new coordinate system. All the 

parameters of the new coordinate system are same to the previous one except 

this origin. 

Basic operations: 
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1． From Elevation menu select Set Origin Point. 

2． Select one point on the screen as the origin of the new coordinate system. 

§4.7.1.3 Trim and Display Drawing in the Elevation 

Window 

On setting up elevation, the system applies trimming view to the elevation view, 

in which the trimming plane is the XY plane of the UCS. In the elevation view, 

those drawing at the same side of the view port relative to the trimming plane 

(the values in Z-coordinate are negative) are completely hidden. The view trims 

out all objects between the elevation and the observation point. When these 

drawing are in hidden display, the graphs on the facade will not be covered. 

For some reason, if you want to view those hidden drawing by the trimming 

view, then select Show all from Elevation menu. 

§4.7.2 Niche on a Wall 

During the interior design, it is common to niche on a wall to place door and 

windows and other decorations with special effect. YuanFang Interior Design 

System provides such an easy-to-use, convenient function for niching on a wall. 

With this function you can make a through or un-through hole of any form and 

depth on a straight wall or curve wall. 

To create a niche on a linear wall: 

1． From Elevation menu select Niche. 

2． Select a profile for the niche outline. It must be a closed shape like circle, 

rectangle, etc. 

3． Input the depth of the niche. You can input this value directly from the 

keyboard or by selecting two points using mouse. 
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4． Select the base point of the niche‟s outline. This point will be used to locate 

the niche. 

5． The system will ask you whether to locate dynamically or non-dynamically. 

Input Y or N to choose one approach for locating. 

 If you select to locate dynamically, then you can specify the position of 

the niche in an intuitive way. Move the mouse, and the niche‟s outline 

will also move following the cross cursor along the wall area. Move the 

mouse to the appropriate position and click the left button.  

 If you select to locate non-dynamically, then you must enter a value to 

designate the position of the niche. 

4. Locate when the niche is vertical to the wall: input the 

distance from the base point of the niche to the bottom of the wall. 

5. Locate when the niche is horizontal to the wall: input the 

distance from the base point of the niche to the start end of the wall. 

If you want to modify the existing niche, for example, to change its form, 

position, depth and the bisection precision of the niche‟s outline, etc., you can 

use the attributes editing. Refer to Niche Attributes Editing for more 

How to niche on a curve wall: 

1． From Elevation menu select Niche. 

2． Select a curve wall. 

3． Input the depth of the niche. You can input this value directly from the 

keyboard or by selecting two points using mouse.  

4． Select the base point of the niche‟s outline. This point will be used to locate 

the niche. 

5． The system asks you whether to locate dynamically or non-dynamically. 
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Input Y or N to choose one approach for locating. 

 If you select to locate dynamically, then you can specify the position of the 

niche in an intuitive way. 

1) Locate along the arc of the curve wall: Move the mouse, and on 

the wall the niche‟s outline will also move following the cross cursor 

along the arc of the curve wall. Move to the appropriate position and 

click the left button.  

2) Locate along the direction vertical to the arc of the curve wall: 

Move the mouse, and on the wall the niche‟s outline will also move 

following the cross cursor along the direction vertical to the arc of the 

curve wall. Move to the appropriate position and click the left button.  

 If you select to locate non-dynamically, then you must enter a value to 

designate the position of the niche. 

1)  Locate when the niche is vertical to the wall: input the distance 

from the base point of the niche to the bottom of the wall. 

2)  Locate when the niche is horizontal to the wall: input the distance 

from the base point of the niche to the start end of the wall. 

The following example shows the situation to niche on a linear wall and a curve 

wall. 
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If you want to modify the existing niche, for example, to change its form, 

position, depth and the bisection precision of the niche‟s outline, etc., you can 

use the attributes editing. Refer to Niche Attributes Editing for more details. 

§4.7.3 Decoration 

The system provides a variety of finishing as wood panel, plaster strips, marble 

tile, and marble slab, bricks layer, fabric panel and wood lath. 

The decoration form and location is relative to the following factors: 

 Type: different model units determine the forms of different finishing 

types.  

 Boundary: all kinds of finishing are applicable to a closed area. The 

closed area can be defined with line, arc, polyline, ellipse and SPLINE. 

The curve used to define such closed areas is called boundary. When 

selecting a boundary, those invalid boundaries will be automatically 

filtered by the system.  

 Inner point: the boundary can define one or more closed areas. The 

inner point indicates which closed area the finishing will be inserted into. 

 Projection point: this is a referenced point for location when arrange the 

finishing. The layout of the finishing model units in the boundary is 

based on the projection point. 

§4.7.3.1 Wood Panel 

1． From Elevation menu select Decoration, then Wood Panel. 

2． In the Wood Panel dialog box, input all required parameters, and press OK. 
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3． Select the boundaries. These boundaries will define one or more closed 

areas. 

4． Click in an area to confirm the closed area selected. 

§4.7.3.2 Terra Nova Wall Plaster 

1． From Elevation menu select Decoration, then Terra Nova Wall Plaster. 

2． In the Plaster Strips dialog box, input all required parameters, and press OK. 
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The type of stripe models can be user-defined. Do as the followings: 

1) Select the curve to define the type of stripe model. 

2) Select the base point of stripe model. 

3． Select the boundaries. These boundaries will define one or more closed areas. 

4． Click in an area to confirm the closed area selected. 

5． Select the projection point of the finishing. 

§4.7.3.3 Leather Facing 

1． From Elevation menu select Decoration, then Leather Facing. 

2． In the Leather Facing dialog box, input all required parameters, and press 
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OK. 

 

3． Select the boundaries. These boundaries will define one or more closed 

areas. 

4． Click in an area to confirm the selected area. 

5． Select the projection point of the finishing. 

§4.7.3.4 Bamboo Facing 

1． From Elevation menu select Decoration, then Bamboo Facing. 

2． In the Bamboo Facing dialog box, input all required parameters, and press 

OK. 
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The type of Bamboo Facing can be user-defined. Do as the followings: 

1) Select the curve to define the type of Bamboo Facing. 

2) Select the base point of Bamboo Facing. 

3． Select the boundaries. These boundaries will define one or more closed 

areas. 

4． Click in an area to confirm the selected area. 

5． Select the projection point of the finishing. 

§4.7.3.5 Concrete Partition Wall 

1． From Elevation menu select Decoration, then Concrete Partition Wall. 

2． In the Concrete Partition Wall box, input all required parameters, and press 
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OK. 

 

The type of Concrete Partition Wall can be user-defined. Do as the 

followings: 

1) Select the curve to define the type of Concrete Partition Wall. 

2) Select the base point of Concrete Partition Wall. 

3． Select the boundaries. These boundaries will define one or more closed 

areas. 

4． Click in an area to confirm the selected area. 

5． Select the projection point of the finishing. 

§4.7.3.6 Bamboo Partition Wall 

1． From Elevation menu select Decoration, then Bamboo Partition Wall. 
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2． In the Bamboo Partition Wall dialog box, input all required parameters, and 

press OK. 

 

The type of Bamboo Partition Wall can be user-defined. Do as the 

followings: 

1) Select the curve to define the type of Bamboo Partition Wall. 

2) Select the base point of Bamboo Partition Wall. 

3． Select the boundaries. These boundaries will define one or more closed 

areas. 

4． Click in an area to confirm the selected area. 

5． Select the projection point of the finishing. 
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§4.7.4 Tiling 

It is an often-used decoration way to insert plates on a wall. The system 

provides four types of plate, which are square, diamond, pyramid and shield. 

Basic operations: 

1． From Elevation menu select Decoration, then Tiling. 

2． In the Plate dialog box, select the required plate and set the number and 

thickness. Press OK. 

 

3． There are two ways for inserting plates; there are single plate insertion and 

multiple plates insertion. 

 Single plate insertion 

1)   Specify the plate size. For shield plate, the value is in radius, and for 

the other types of plate is in length. 

2)   Select the center point and decide the position to insert plates. 
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 Multiple plates insertion 

1)  Input the first corner point. 

2)  Input the second corner point. 

The range contained in the two corner points is the area to insert those 

plates. The system automatically inserts the plates as much as possible 

according to the selected range and the number of plates. 

§4.7.5 Curve Wall Decoration 

It is difficult to directly decorate a curve wall compare to straight wall. You can 

solve the problem the by following steps: first build an equivalent wall of a curve 

wall, then arrange the decoration on the straight wall, finally map it to the curve 

wall. 

§4.7.5.1 Building an Equivalent Wall 

An equivalent wall is a straight wall with its length same to the arc length of a 

corresponding curve wall. Since the two walls have the same length, the 

relative position and dimension will not be changed when the decoration on the 

equivalent wall is mapped to the curve wall by the function Bending. This is the 

mechanism of equivalence. 

Basic operations: 

1. From Elevation menu select Curve wall, then Convert.  

2. Select a curve wall or a curve line. 

3. If you select a curve wall, then you should specify which side the system 

will build an equivalent wall. If you want to decorate the curve wall on the 

inner side, then select inner side of the wall and vice versa. 

4. Specify the left endpoint of the equivalent straight wall and decide its 
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position. 

§4.7.5.2 Bending 

The decoration on the equivalent straight wall can be copied to the curve wall 

only by the Bending function. 

It should ensure the consistency of the wall area when using this function. The 

decoration must be mapped to the wall area that an equivalent wall has been 

built for, otherwise distortion will occur. 

Basic operations: 

1． From Elevation menu select Curve wall, then Bending. 

2． Select the decoration on the equivalent wall that will be mapped to the curve 

wall. 

3． Select two points, by which to define the length of the equivalent wall and 

the base point for decoration. 

4． The two points are better located at the bottom endpoints of the decorated 

side of the equivalent wall. Only that, the curve wall will be exactly 

decorated without any distortion.  

5． Select the curve wall to be decorated. 

6． Select the side of the curve wall that the decoration will be mapped to. 

7． Select the number of the curve parts. 

§4.7.6 Move on Elevation 

This function is similar to Move function. It is used for moving object vertically. 

While moving the object, please make sure you are using WCS. Select the 

object you want to move and then define the base point and location on the 



InteriCAD T5 User Manual 

 129 

evlevation view. 

§4.7.7 Display Control of Elevation Objects 

When drawing with complex model, you should control the preview of different 

drawing in various views to keep the workspace terse. For the elevation 

decoration, it is unnecessary to show the 3D drawing in the top view; you only 

need to show the boundary. Instead, it is necessary to show the 3D drawing in 

the isometric view, and no need to show the boundary. 

The system provides four commands for controlling the display of objects 

finishing; there are Show/Hide 3d view and Show/Hide 2d view. These 

commands can be found in the 3d View and 2d View options from Elevation 

menu. 

If you want to control the show of object finishing in some view, you should first 

make the view active, and then use the corresponding command. 

§4.8 Ceiling Board 

§4.8.1 Build the Ceiling Board 

The type of the ceiling board is various and the model is complex. YuanFang 

Interior Design System provides four kinds of ceiling boards: Plastering, Metal 

strip, Wood strip and Lattice. 

§4.8.1.1 Ceiling 

The system provides four tools for the plastering ceiling board: Make single 

surface, Dropped ceiling, Cut away and Air vent grille. 

Base Surface of the ceiling board 

Make single layer plastering ceiling board. And you can cut it away or open an 
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air ventilation grille on it. 

Basic operations: 

1． Select Ceiling from the Ceiling menu, and then Ceiling. 

2． Select the boundary, which may include several closed areas. 

3． Select a point to determine the projection area of the ceiling board. 

4． Input the distance of the ceiling board bottom from the ground. 

5． Input the thickness of the ceiling board. 

Solid Layered Ceiling 

Solid ceiling board levels can be used to make multi-level ceiling board and the 

generated ceiling board can make Boolean operation with other solids object. If 

the second ceiling board is rounded, the dividing accuracy of the circle can be 

controlled. The process is same to the dropped ceiling. 

Normal Layered Ceiling 

Ceiling board levels can be used to make multi-level ceiling board and can also 

be used to make the lamp slot. 

Select the first-level contour lines or the previous-level ceiling board 

base surface.  

Basic operations: 

1． Select Ceiling Normal Layered Ceiling from the Ceiling menu. 

2． Assign the dimensions and form of the ceiling board in the Normal Layered 

Ceiling dialogue box and press OK. 
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3． Select the plane outline of the second-level ceiling board. 

After the command has been executed, a two-level ceiling board has been 

made. If you want to make a three-level ceiling board, you can make the 

structure of the first and second level. And then call the Normal Layered Ceiling 

command again; select the second-level base board and the third-level contour 

lines. The process is the same other multi-level ceiling. 

Cut Away on the Ceiling Board: 

A hole of any shape can be cut on the ceiling board. The polyline, which is used 

to define the shape of the entrance hole should be a closed plane curve and 

cannot intersect with itself. 

Basic operations: 
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1． Select Ceiling from the Ceiling menu, and then Create Hole on Ceiling. 

2． Select the ceiling board base surface that will be cut. 

3． Select the definition curve of the shape of the entrance hole. 

The position of the entrance hole is the projection position of entrance 

hole‟s contour line on the ceiling board. 

Air Ventilation Grille on the Ceiling Board: 

The shape of the air ventilation is square, so the entrance hole of the air 

ventilation should also be square. 

Basic operations: 

1． Select Ceiling from the Ceiling menu, and then Intake. 

2． Select the base surface of the ceiling board on which the air ventilation will 

be made. 

3． Select the contour line of the air ventilation‟s entrance hole. 

§4.8.1.2 Wood Ceiling 

The system provides various wood strip designs for the ceiling board. 

Basic operations: 

1． Select Wood Ceiling from the ceiling menu. 

2． Select the combination type of the ceiling board in the Wood Strip dialogue 

box and input corresponding data. Press OK. 
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3． Select the boundary, which may 

include several closed areas. 

4． Select a point to determine the projection area of the ceiling board  

5． Assign a point to define the pattern. 

6． Pick a point in elevation view to define the bottom of the wood ceiling 

structure. 

§4.8.1.3 Coffered Ceiling  

The grid ceiling board also has several forms: Linear, Grid, Triangle and 

Honeycomb. 
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Basic operations: 

1． Select Coffered Ceiling from the Ceiling menu. 

2． Select the style of the ceiling board in the Lattice dialogue box, input 

corresponding dimensions. Press OK. 

 

In the dialogue box, Layout angle is the inclination between the assigning 

direction and X-axis forward direction. The default value is zero and the 

direction is consistent with the X-axis forward direction. 

3． Select the boundary that may include several closed areas. 

4． Select a point to determine the projection area of the ceiling board. 

5． Assign a point to define the pattern. 
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6． Pick a point in elevation view to define the bottom of the wood ceiling 

structure. 

§4.8.1.4 Trim Ceiling 

The function is used for trimming the coffered ceiling.  

Basic operations: 

Method A: 

1． Select Trim Ceiling from Ceiling menu. 

2． Select the first corner and then the second. In this way, the coffered ceiling 

will be trimmed by a rectangle shape. 

Method B: 

1． Draw any shape using polyline on the surface of the coffered ceiling. 

2． Select Trim Ceiling from Ceiling menu. 

3． Select the coffered ceiling and then the shape to trim. 

 

 

§4.8.1.5 Hole 

The function is used for creating a hole on the ceiling. 

Basic operations: 

1． Draw any shape using polyline on the surface of the ceiling. 



InteriCAD T5 User Manual 

 136 

2． Select the ceiling and then select the shape to create the hole on the 

ceiling. 

§4.8.1.6 Ceiling Cornice 

To create a ceiling cornice, you need to have a closed room or a closed 

polyline. 

Basic operations: 

1． Select Ceiling Cornice from Ceiling menu. 

2． Click inside the room and system will automatically generate a ceiling 

cornice. 

 

3. You can draw a base shape first using polyline and then use Select 

baseline to generate. 

4. To customize the section of the ceiling cornice, you need to create an 

unclosed polyline first and make sure the start point and end point of the 

polyine should have the same X coordinate. Next, select Custom from the 
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drag box and select the unclosed polyline accordingly. 

§4.8.2 Arrange the Recess Down Light 

Arranging the recess down light on the ceiling board has the functionalities of 

both lighting and decoration. The system provides three methods to arrange 

recess down light: complete installation, at any height and mounted on ceiling. 

§4.8.2.1 Complete Installation 

Arrange one or more recess down lights at one time according to the appointed 

method or path. 

Basic operations: 

1． Select Create 2D Light Symbols Automatically from the ceiling menu. 

2． Select the way to arrange the lamps in the Complete Installation dialogue 

box and input parameters. 

The Complete Installation dialogue box is shown as below. You can set the 

arrangement method, total numbers, and dimensions of a single lamp in the 

dialogue box. 



InteriCAD T5 User Manual 

 138 

 

Explanations of the parameters: 

Method: Select the method to arrange the lamps, as explained below: 

 Rectangle method: 

Internal arrangement: to arrange lamps in the rectangle area. 

Odd/even: Arrange the lamps in odd/even mode. 

Radius: Radius of the lamps. 

Numbers of lamps in horizontal: The number of lamps in the horizontal 

direction of the rectangle area. 

Numbers of lamps in vertical: The number of lamps in the vertical 

direction of the rectangle area. 

Length: the length of the rectangle area. You can directly input the 

value. You can also click Pick Point button, and select two points 

on the drawing to get the length value. 

Width: the width of the rectangle area. You can directly input the value. 
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You can also click Pick Point button, and select two points on 

the drawing to get the width value. 

Rotation angle: the inclination between the rectangle and the X-axis 

forward direction. 

 Straight Line 

Radius: the radius of the light. 

Numbers of lamps: the number of the lights. 

 Fan Shape (Sector) 

Internal arrangement: when this option is active, you can arrange 

lamps simultaneously both on the sector boundary and inside the area. 

Otherwise you can only arrange lamps on the boundary. 

Odd/even: When this option is active, you can arrange lamps in 

odd/even mode in the radius direction of the sector. Otherwise, the 

lamps will be arranged orderly. 

Radius: the radius of the lamps. 

Numbers of lamps on A: the number of lamps on the arc direction of the 

sector. 

Numbers of lamps on B: the number of lamps on the radius direction of 

the sector. 

Inner radius: the radius of the sector‟s inner circle. 

Outer radius: the radius of the sector‟s outer circle. 

From angle: the inclination between the start radius of the sector and 
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the X-axis forward direction. 

Angle: the degree of the central angle of the sector. 

 Circle: 

Internal arrangement: when this option is active, you can arrange 

lamps both on the circumference and inside the area. Otherwise you 

can only arrange lamps on the circumference. 

Odd/even: When this option is active, you can arrange lamps in 

odd-even mode in the radius direction of the circle. Otherwise, the 

lamps will be arranged orderly. 

Radius: the radius of the lamps. 

Lamps outer: the number of lamps along the outer circumference. 

Lamps inner: the number of lamps along the inner circumference. 

Inner radius: the radius of the inner circle. 

Outer radius: the radius of the outer circle. 

 Free Curve 

Radius: the radius of the lamps. 

Number: the number of lamps along the polyline. 

 Single: arrange a single lamp. 

3． System command prompt: 

 Line: Pick two points on the drawing as the endpoints of the line route. 

 Rectangle: Pick a point as the lower left point of the rectangle. 
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 Fan Shape: Pick a point as the center of the circle. 

 Circle: Pick a point as the center of the circle. 

 Free Curve: Select the polyline. 

 Point: Specify a point. 

4． System asks whether to make 3D lamp. 

 Press N or Enter, no 3D lamp will be generated. 

 Press Y, the Complete Installation dialogue box popup. And in this 

dialogue box, you can set the data of the lamp (refer to at any height 

for more information), and then the 3D lamp will be generated. 

§4.8.2.2 Convert to 3D at Any Height 

Change the lamp icon on the plane ceiling drawing into 3D recess down 

light and arrange them at any height. 

Basic operations: 

1． Select Convert to 3D at any Height from the Ceiling menu. 

2． Input the definition data of the recess down light in the Lamp Parameter 

dialogue box. Press OK. 
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Explanation of the parameters: 

 Surface-mounted: This option is used to import the lamps into VR to 

render. 

 Recessed: This option is suitable for CAD interior rendering. 

 Reflector Edge Width: The reflector edge width of the lamp. 

 Lamp Wattage: The strength unit of the light source, which is suitable 

for VR and CAD rendering. 

 Light Source Placement: The distance that the light source deeps into 

the recess down light. 

 Pendant Depth: 

3． Select a point to determine the height of the light, and use its Z coordinate 

value as the light‟s altitude. 

4． Select the 2D light symbols that define the appearance of the lights on the 

plane. The X and Y coordinate value is determined by the position of the 

selected symbols on the plane. 
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§4.8.2.3 Convert to 3D on Ceiling 

Change the plane light icon into the 3D recess down light on the plastering 

ceiling board. 

Basic operations: 

1． Select Convert to 3D on ceiling from the Ceiling menu. 

2． Select the surface of the ceiling board on which the lamps will be placed 

and determine the altitude of the lamps. 

3． Select the curve that defines the appearance of the lamps on the plane. The 

X and Y coordinate value is determined by the position of the selected curve 

on the plane. 

§4.8.2.4 Move on Elevation 

This function is similar to Move function. It is used for moving object vertically. 

While moving the object, please make sure you are using WCS. Select the 

object you want to move and then define the base point and second on the 

evlevation view. 

§4.8.3 Display Control of the Objects on the 

Ceiling Board 

In the drawing with complex models, it is necessary to control the display of 

different drawings in different views to keep the window terse. Under the mode 

of four windows, you may only need to display the plane objects in the top view. 

Anyway, the 3D drawing display is more important and the plane objects are 

usually unnecessary to display. 

The system provides four commands used to control the display of the ceiling 
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board objects, which are: display the 3D ceiling board, display the plane ceiling 

board, hide ceiling board object and hide ceiling board plane. These 

commands can be found in the Show/Hide of 3D Ceiling/2D Ceiling menu. 

If you want to control the display of the objects, please activate this view and 

then call the corresponding command. 

§4.9 Floor 

§4.9.1 Construct the Floor 

 Generate the floor slab in the specified area and requirements. 

Basic operations: 

1． Select Floor from the Floor menu. 

2． Select the area boundaries. These may include more than one closed area. 

3． Pick a point to determine the area where the floor will be generated. 

4． Specify the height of the floor. It calculates from the XY plane of the 

coordinate system. 

5． The system will ask whether to generate the floor pattern. If the answer is N, 

no pattern will be done and the slab will be generated directly. If the answer 

is Y or you press Enter, then Floor Pattern dialogue box appears. Please 

refer to Floor Pattern for detailed operations. 

§4.9.2 Floor Pattern 

No grid is needed for rendering if floor pattern has been applied. You can 

assign materials directly. 

Basic operations: 

1． Answer Yes when the system asks you whether to create pattern on floor. 
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2． Input the definition data in the Floor Pattern dialogue box. Press OK. 

 

In this dialogue box, option Inlay is only valid if the pattern is square tiles or 

checkers. 

When Square tiles is selected, the distance between the two separation lines of 

every cell is width B, and the brick‟s dimension should be based on it. 

3． Select the area boundary. These may include more than one closed area. 

4． Select a point to determine the area where the floor will be generated. 

5． Select the projection locating point, which is the alignment point of the cell‟s 

base point. 

§4.9.3 Curve Step 

Generate the step according to the path of polyline. 

Basic operations: 
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1． Select Curved Step from the Floor menu. 

2． Select the step style in the Steps dialogue box and input the definition data. 

Press OK. 

 

Explanation of the parameters: 

 Style: Totally 7 styles of tread. You can also customize a style. 

 Thread: The width of each step. 

 Riser: The height of each step. 

 Number of Steps: The number of steps. 

 Add Slip-Resistant: Slip-Resistant will be added automatically if this 

option is active. 

 Floor Thickness: The altitude of the step underside. 

 Pick Floor: You can determine the floor thickness by picking on the 

screen. 
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3. Select a plane curve, and the steps will be constructed using this curve as 

the base line. 

§4.9.4 Move on Elevation 

This function is similar to Move function. It is used for moving object vertically. 

While moving the object, please make sure you are using WCS. Select the 

object you want to move and then define the base point and second on the 

evlevation view. 

§4.9.5 Display Control of the Floor Objects 

The system provides four commands to control the display of the floor objects. 

They can control the hidden and showing the floor 3D drawing, floor plane icon 

and floor color filling status. The commands are: Show the 3D floor, Hide the 

3D floor, Show the 2D floor, and Hide the 2D floor.  

If you want to control the display of the object, please activate this view and 

then use the corresponding command. 
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Chapter 5 3D Modeling 

InteriCAD T5 provides 2D and 3D library, which enables user to design easily. 

In addition, the system delivers powerful modeling capabilities that can be used 

to construct wood line, stair, 3D Text and 3D object. 

§5.1 Modeling Function Based on Library 

§5.1.1 Handrail 

I． Handrail Library 

This function can generate the whole handrail on the curve route according to 

the given shape in the library. Also it can be used to make handrail of the stairs. 

Basic Operations:   

1. Select Showlib… from menu 3D Model. 

2. Select a handrail or unit shape from the Library Maintain dialogue box. 
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3. Input the parameters and press OK.  

4. Pick a polyline in the workspace to locate the handrail.             

 

§5.1.2 Fence 

You can build a fence on baseline according to the fence unit in the library. 

Basic Operations: 

1． Select Showlib… from menu 3D Model. 
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2． Select a style from the Library Maintain dialogue box. It‟s under the 

structure menu in the library. 

 

3． Input the definition data of the fence unit. 

4． Select a curve (polyline) as the fence baseline. 

§5.1.3 Wood Line 

Build a wood line defined by a plane curve as the baseline and profile pattern 

(library selected) as the profile. The dimensions of the wood line profile can be 

determined by the Molding dialogue box. 
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Basic Operations: 

1． Select Showlib… from menu 3D Model. 

2． Select a wood line from the Library Maintain dialogue box. It‟s under the 

structure menu in the library. 

3． Input the dimension data of the profile in the Molding dialogue box and then 

Press OK. 

4． Select a plane curve (polyline) as the baseline to generate the wood line. 

§5.2 Modeling Along the Path 

This function is used to build models by extruding a profile (close or unclose) 

along a plane path. You can select multiple profiles and the shape of the profile 

can be customized or selected from the library. 

Basic Operations: 

1． Select Extrude by Path from the 3D Model menu. 

2． Select the model baseline. 

3． Select the profile shape of the model. 

4． Select the base point of the profile. 

If you want to modify the parameters of the generated model through this 

function, such as baseline shape, profile shape, segment accuracy and rotation 

angle, you can use the Attribute Editing.  

§5.3 3D Text 

The construction of 3D Text can be divided into two steps. The first step is to 

array the 2D text on a line or a curve. The second step is to transform these 
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array 2D texts into 3D texts. 

§5.3.1 Text Along Path 

You can array the 2D text along any curve. This is the preparation for making 

3D text and the position of the text can be determined. 

Basic Operations: 

1． Select 3D Text from 3D Model menu, and then Text. 

2． Select the font, size, array rule in the 3 Dimension Text dialogue box. Input 

the text that will be displayed in the graph and select OK. 

3． If you select Align On Straight Line, you should select two points to define 

the straight line; if you select Align On Curve Line, the text will be arrayed 

along the chosen polyline. 

 The result of the text array along the curve is shown as below: 

 

§5.3.2 Transform 2D Text to 3D Text 

Basic Operations: 

1． From 3D Model menu select 3D Text, and then Extrude. 

2． Select the 2D text to be transformed. 

3． Input the thickness. 

4． The system will ask whether to delete the baseline. 
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The 3D text transform from the 2D text as shown below: 

 

§5.4 Staircase 

The system provides various methods to build a staircase. 

§5.4.1 Combine Staircases 

By combining single staircase and flat platform, user can construct various 

staircase styles and set the data to single staircase information. 

The following is an example based on the combination of three single 

staircases. 

Basic Operations (three segments): 

1． Select Combine Stairs from 3D Model menu, and then click Single 

Stair. 

2． Input data of the stairs and select the stairs style in the Stair 

Design dialogue box. 
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Select Detail button to change other settings. 

 

The following items can be set in the Stair Detail Design dialogue box: 

 Treadle: including the depth and thickness of the treadle. 

 Baffle: whether to set the baffle or not, and if so, the position and 

dimension of the baffle. 

 Sideboard: whether to set the sideboard or not, and yes, the position 

and dimension of the sideboard. 

 Accessories: whether to set the carpet and side-proofing bar, if yes, 

the dimension of them. 

 Sideline: whether to set the sideline or not, if yes, the dimension of the 

sideline. 

3． Click Insert Point button to determine the base point of the 
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stairs. 

4． Press OK, and the staircase will be generated automatically as 

shown below. 

 

 

5． Draw a rectangle in the top view and select Flat Platform from 

Combine Stairs menu. Select the rectangle and input the thickness to 

build the flat platform.  

6． Then copy two staircases and a flat platform. 
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7． Select Assemble Stair from Combine Stairs menu. 

The Stair Assembly dialogue box will define the object that will be 

used as reference part or assembly part, and determines the position 

where the reference part will be assembled and the alignment of the 

two parts. 

 Reference Part: the object that will remain static during 

assembling. 

 Assembly Part: the object that will move during assembling. 

8． Click Select Reference Part, select object 1; Click Select Assembly 

Part button, select object A; Click Assemble button, press Spacebar 

to adjust the plane assemble position of the staircase and flat platform 

to a proper position and press Enter. Then take flat platform A as the 

reference part, staircase 2 as the assembly part. Repeat these 

operations to complete the process as shown below: 

9． Select Handrail baseline from the Combine Stairs menu, select the 

staircase and flat platform that need handrail, press Enter and the 

handrail baseline has been made. The staircase and flat platform 

have been hidden for convenient viewing. 
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Select a rail style from the library, then select the rail line, a handrail will be 

made. Shown as below: 

 

§5.4.2 Staircase Base on Two Lines 

Generate the staircase by two curves on the plane. This function can be used 

to generate staircases with different special effect on two sides. 

Basic Operations: 

1． Select Create Stair by 2 lines from 3D Model menu. 

2． Select two boundaries of the staircase. The selected boundaries should be 

closed to the starting point of the staircase. When selecting the border line, 

please select the end near the starting point of the stair. Input the total 

height of the staircase. 
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3． Input the riser height (height of the step). 

4． Input the side width (width of the platform surface of both sides). The 

platform surface can be divided into 3 parts, while every part can be 

assigned with different materials (such as carpet-laying effect). 

5． Input offset value of handrail baseline. Two 3D polylines have been 

generated when building the staircase. You can use these two polylines as 

the base line to generate the staircase handrail. The polyline offset can 

either be a positive or negative value. A negative value means that the 

polyline has been drawn out of the staircase. 

 

 

 

§5.4.3 Staircase Base on Center Line 
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Construct an equal-width staircase using a given curve as the centerline. 

Basic Operations: 

1． Select Create Stair by center line from 3D Model menu. 

2． Select a curve as the centerline of the staircase. 

 

3． Input the total height of the stair. 

4． Input the height of the step. 

5． Input the side width (width of the platform surface of both sides).  

6． Input offset value of handrail baseline. 
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§5.4.4 Spiral Stair 

Construct a spiral staircase by defining relevant parameters. 

Basic Operations: 

1． Select Spiral Stair from 3D Model… menu. 

2． Input detailed info about the spiral stair in the pop-up dialog. You can also 

define the details of each step by clicking on Preference. 

3． Define a point in the working area by Pick Point. 
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§5.5 Visual Library Management Based on 

Database Management 

Library management provides common library (such as sofa, tea table), door 

and windows library and shape library (such as wood line, handrail). All models 

are displayed in the dialogue box using color pictures for visual selection. The 

entire library is based on database management, which provides a user library 

management system and is convenient for inquiry. 

§5.5.1 Startup Library Management 

1． From the Door And Window menu select Library to enter door and windows 

library management dialogue box; 

2． From the 3D model menu select Library to enter common library 

management dialogue box; 

3． Close the Library Management dialogue box. There are two ways: 

 From 3D Model menu click Hide Library command; 

 Left click X button on the upper right corner of the Library Management 

dialogue box 

§5.5.2 Library Management 
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Library dialogue box is composed of library calling area, list area, parameter 

area; preview area and symbol size button. 

§5.5.3 How to Use Library 

Double click the required model symbol in the list area and do the rest 

operations according to the system prompting. 

§5.5.4 System Manage Mode 

Selecting sofa and tea table 

1． From the 3D model menu select Showlib…, the Library Management 

dialogue box popup. 



InteriCAD T5 User Manual 

 163 

 

2． Double click Home furnitureSofa in the list area. 

3.  Drag the sliding bar in the preview and find the required sofa. Double click 

its symbol. 

4. Under the Insertion point prompting, select the position where the sofa will 

be placed in the plane view using left button. 

5. Under Rotate angle prompting, input the rotation angle of the sofa (positive 

value for anticlockwise and negative value for clockwise). 

6. From home furniture double click table, and then end table. 

7. Find the required end table in the list area and double click the symbol.  
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8. Similar to the sofa selecting, determine Insertion point and Rotate angle. 

The selecting of the tea table is completed. 

 

Example: selecting the door 

To select a door, select the point which the door is to be placed. 

a. Double click door and windowdoor wood door1 in the list area. 

b. Drag the sliding bar in the preview area to find the required door style. 
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c. Double click the symbol of that door style, the parameter dialogue box of 

the door popup. Set the width, height and ground clearance. Press Enter. 

d. Insert the door using positioning mode of door and windows. 

e. After the position of the door is fixed, the system prompts whether to 

change the door direction. Press Enter if the door direction is correct and 

input Y, press Enter and the door direction will be corrected automatically. 

The system prompts whether to change the door direction. The method is 

the same with door direction. Thus, a door is installed. If necessary, 

continue to select walls to place the same door. Otherwise, press Enter. 

 

Example: selecting wood line 

Draw the trace line (should be a polyline) of the wood line grain before 
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selecting wood line. 

 

a. Double click structure and wood line in the list area. 

b. Drag the sliding bar in the preview area and find the required wood line. 

c. Double click that wood line symbol. The parameter dialogue box of wood 

line popup. Set the Profile thickness, Profile height, press Enter. 
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d. The system prompts, Select a polyline to select the path of the wood line. 

Press Enter and the wood line making completed. 

§5.5.5 User Management Mode 

Example 1: How to copy the system management file, such as sofa, to 

User Management mode 

1． From the 3D Model menu click Showlib…. 

2． Double click system library3d librarysofa in the list. 

3． Drag the sliding bar in the preview area and find the required sofa. Single 

right click and select copy. 

4． From the library maintenance menu click user. Switch to user library. 

5． Single click using right button, select add or paste. If you select add, a new 

folder will appear under User library and you can rename it with sofa. Then 

right click the new folder and select paste. Operation completes. 
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Example 2: How to add existing DWG model to user management mode 

in two different methods 

1．Add models (furniture, decoration. Not including stairs, doors and 

windows) 

 Open the existing DWG model and input Insbase in command prompt, 

and press Enter. Single click the center of the model using left button 

and save the file. 

 From the 3D model menu select Showlib…, the library management 

dialogue box popup. 

 Click User Library to open a directory. Single click the preview area in 

the right side using right button and select Add files, the Add Files 

dialogue box popup. 

 In the file path, press Browse and select your saved DWG file. Press 

Enter and the operation complete. 

 Copy the .jpg file of the models to the  

2． Add models (All models including: furniture, decoration, stairs, doors, 

windows and etc.) 

 From the 3D Model menu select Showlib…, the library management 

dialogue box popup. 

 Click User Library to open a directory. Single click the preview area on 

the right side using right button and select add library. The Add Library 

dialogue box popup. 

 Single click the file type which DWG file belongs using left button and 
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press OK. The Input Data dialogue box popup. Set Object name, 

Specification, Height and File. The Height value should be accurate 

and File is to define the path where the DWG file will be saved. 

The system prompts Select objects. Click the DWG model that will be put 

into library and then click right button to confirm. The system prompts 

Insertion point. Single click the center of the model using left button and 

press OK. Operation completes. 

 

Chapter 6 Dimension 

InteriCAD T5 provides comprehensive dimension regarding the size of the 

axis, wall, door and windows. 

§6.1 Dimension 

The system provides various dimension methods: dimension on linear axis, 

dimension on arc center, wall windows dimension, and door windows 

dimension. 

§6.1.1 Dimension on Linear Axis  

Basic operations: 

1. Select Linear Axis from the Dimension menu. 

2. Select an axis that will be dimensioned; 

3. If the dimension direction is gradient, you should first determine the start of 

the axis number; 

4. Determine the form of the axis number. There are two forms: 1, 2 or a, b. 
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§6.1.2 Dimension on Arc Axis  

Basic Operations: 

1． Select Arc Axis from the Dimension menu. 

2． Select a axis that will be the dimension; 

3． If the selected axis is an arc, the base axis selected will be used to 

determine the dimension direction; 

4． If the selected axis is a line, then select the axis that need not to dimension. 

5． Select the position of the dimension; 

6． Determine the form of the axis number. There are two forms: 1, 2 or a, b. 

 

 

 

 

 

 

 

 

§6.1.3 Walls with Windows Dimension 

Introduction: Dimensioning a single straight wall or the curve wall with door and 

windows on them. It is only valid for the wall with door and windows. 

Basic operations: 

1． Select Wall Dimension from the Dimension menu. 

2． Select the wall that will be dimensioned. 

3． Determine the position of the dimension. 
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§6.1.4 Door and Windows Dimension 

Introduction: Dimensioning the multiple doors and windows of the same 

direction on the straight wall. If the selected doors and windows are of different 

directions, the system will automatically select the direction that most doors 

and windows have to dimension. Those doors and windows that are on the 

different directions will be ignored. 

 

 

Basic Operations: 

1. Select Door and Window 

from the Dimension menu. 

2. Select one or more doors 

and windows that will be 

dimension. 

3. Select other axis or walls 

that will be dimension. 

4. Determine the position of the dimension. 

§6.1.5 Modify Axis Number 

The modification of dimension mentioned here is not the modification of the 

number of size, but the modification of the axis number. 

After modification, the new axis number will be in the circle. 

Basic Operations: 

1． Select Modify Axis Number from the Dimension menu. 

2． Select the axis number that will be modified (the number or letter in the 
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circle). 

3． Input the new axis number. 

§6.1.6 The Area of a Room 

The area of a room can be calculated automatically. The walls should be 

closed and updated. While calculating the area, the axis of the wall will be use 

as the reference. 

Basic Operations: 

1． Select Room Area from the Dimension menu. 

2． Select multiple walls. The area of the room can only be dimension when 

these surrounding walls become a closed 

room. 

3． The current room to be dimensioned is 

highlighted. 

 If you select a point inside the room, the 

area of the room will be dimensioned in 

the position of that point. 

 Input N and the system will turn to next 

close room. 

 Input E to finish dimension. 

§6.1.7 Dimension Types  

1. Dot-base Mode：Change the dimension type to dot base. 

2. Cut-base Mode：Change the dimension type to cut base. 

Note: Dot and Cut modes are used to modify the display mode of the 

dimension node. The mode will be modified after you use the command but the 

dimensions that already exist will remain unchanged.  

§6.1.8 Common Dimension Types 
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1. Horizontal Dimension 

Specifies how far extension points are offset from origin points horizontally. 

2. Vertical Dimension 

Specifies how far extension points are offset from origin points vertically. 

3. Align Dinmension 

You can create dimensions that are parallel to the locations or objects that 

you specify. In aligned dimensions, the dimension line is parallel to the 

extension line origins.  

4. Diameter Dimension 

It measures the diameter of an arc or circle, and displays the dimension text 

with the diameter symbol in front of it. And it displays the dimension text 

with the diameter symbol in front of it. 

5. Radius Dimension 

It measures the radius of an arc or circle, and displays the dimension text 

with the letter R in front of it. 

6. Angular Dimension 

It measures the angle between two lines or three points. To measure the 

angle between two radiuses of a circle, you select the circle and specify the 

angle endpoints. 
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Chapter 7 Virtual Reality Commands in 

Modeling 

In this chapter, we will introduce some functions in virtual reality.  

§7.1 Set Light  

Basic Operations: 

1． Select Set Light from the Virtual Reality menu. 

2． Select the object you want to set as light. Multiple selections are supported. 

Note: Only those objects with Face attribute can be set as light. For example, a 

line or polyline can not be set as light. Meanwhile, models taken from the library 

need to be exploded before being set as lights. 

 
3． Fill in the value for the light in the pop-up dialog. System provides two types 

of colors: HSV and RGB. 

§7.2 Advanced Lighting 

Using advanced lighting function, users can create lamp cluster, neon light and 
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pearl light.  

`  

Basic Operations for TypeA: 

1． Draw two lines as the basic lines of lighting.  

 

 

 

2． Select Virtual Reality Advance. 

3． In the Lighting Options dialogue box, click Lighting Parameter to define the 

color and wattage of light.  

Note: the wattage is the summation of all bulbs. 

4． Click First Baseline and select one of the lines.  

5． Click Second Baseline and select another line.  

Note: once a line is selected, None will turn into Selected. 
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6． Define the number of column in the selection of Stars along paths, define 

the number of bulbs in each column in the selection of Start between Paths. 

7．  Click OK and the lighting will be created.  
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Note: the 3D model of bulb is cube. Too many bulbs will slow down the speed. 

The model of lamp cluster appears as a whole entity. 

 

 

Special effects 

1． Twist Angle of two baselines, only effective to closed 2D polyline. 

 

 

2． Drop slope. 
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3． Reverse path direction. 

 

The neon light setting uses a 2D line as baseline to create a 3D neon light. The 

3D neon light already has its properties. This setting can be used to create 

neon light and lighting decoration.  

Basic operations of creating neon light (TypeB): 

1． Set one piece of wall as elevation. Select 3D model3D TextText. In the 

popup dialogue box, enter the letters.  

  

 

2． Select Virtual Reality  Advance. 

3． In Lighting Options dialogue box, select Type B, which is neon light. Define 

lighting parameter.  

4． Click Select Baseline. Then select the region of the text on the wall.  

5． Define the Radius of Neon Tube.  

6． Click OK. The Neon tube is created. 
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Basic operations of creating neon light (TypeB): 

Pearl light uses 2D lines as baseline, and evenly set 

bulbs along baseline. 

1． Draw a 2D line.  

2． Select Virtual Reality  Advance. 

3． In Lighting Options dialogue box, select Type C, which 

is pearl light. Define lighting parameter. 

4． Click Select Baseline. Then select from left to right of 

the rectangle.  

5． Define number of pearls.  

6． Click OK to finish.  

§7.3 Edit Light 

Basic Operations: 

1． Select Edit Light from the Virtual Reality menu. 

2． Select the light to edit. 

3． Define values in the pop-up dialog. 

Note: Multiple selections are available. However, all the values will be the same. 

Meanwhile, the light attribute can not be cancelled once it is set. 
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§7.4 Export  

If there is same model in Virtual Reality, using this command will replace the 

model in modeling library with the model in Virtual Reality library. 

Basic Operations: 

1． Select Virtual Reality Export. 

2． Select the objects you want to export to VR. 

3． Define the observer point to export. 

Note: The export method is suggestted while you have placed some complex 

models from the CAD library. System will automatically replace them with the 

3d models while exporting to VR. 

§7.5 Export Merge 

If there is same model in Virtual Reality, using this command will replace the 

model in modeling library with the model in Virtual Reality library. 

Basic Operations: 

1． Select Virtual Realty Export merge. 

2． Select the objects you want to merge to VR. 

3． Define the observer point to export. 

 

§7.6 Advanced Export  

This is another way to export 3D models into Virtual Reality. 

Basic Operations: 

1． Select Virtual Reality Advanced Export. 
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2． In the popup Send Model Option dialogue box, select the precision and 

combine option to export models.  

3． Select the objects you want to export to VR. 

Note: Normal, Normal+1, Normal+2…controls the precision level for the 

objects, especially for circle, arc, etc.  

§7.7 Advanced Export Merge 

This is another way to export 3D models into Virtual Reality and Merge.  

Basic Operations: 

1． Select Virtual Realty Advanced Export Merge. 

 

2． In the popup Send Model Option dialogue box, select the precision and 

combine option to export merge models.  

3． Select the objects you want to merge to VR. 



InteriCAD T5 User Manual 

 182 

§7.8 Import and Export DWG, DXF Files 

InteriCAD can export and import and export dwg, dxf files as well as 

importing 3ds files. 

§7.8.1 Import 3DS File 

Use 3DSIN command to read 3D Studio geometric graph. 

 

Options for importing 3DS file 

1． Save to layer：To control how to allocate layer in 3DS file.  

 

 By object: To allocate a layer for each object in 3D Studio file. The name 

of the layer is the same as the object. 

 By material: To create a layer for each material in 3D Studio file. All 

objects with same materials will be saved in one layer. The name of the 

layer is the same as the material.  

 By object color: To create layer for each color in 3D Studio file. The 

name of the layer is COLORnn. Nn is the color index of 3D Studio. 

Object without color will be put on layer called COLORNONE. 

 Single layer: to create a layer called AVLAYER. All objects are put on 

this layer.  

2． Multiple Material Objects: 

3D Studio will allocate texture according to surface, element or object. BtoCAD 

will allocate texture according to object. BtoCAD needs instruction when it 

allocates a 3D Studio object with multiple textures.  

 Always prompt: For every object with multiple textures, a „Material 

Assignment Alert‟ dialogue box will show.  

 Split by material: To split multiple object into several object by its 

material.  

 Assign first material: Assign the first material of this object to the whole 

object.  

 Don‟t assign a material: In this way, the material will be lost. But it will 

save the geometric graph of 3D Studio file. The transferred object will 
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be allocated a default material in AutoCAD.  

Basic operations to import 3DS file: 

Select FileImport/Export3DS Import. 

Appoint the 3D Studio file in 3D Studio File Import Options dialogue box. 

Define the parameters in 3D Studio File Import Options dialogue box. Click OK.  

 

§7.9 Import 2D Design Files 

 Basic Operations: 

1． Select File Import 2D Design file.  
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2． In the popup dialogue box, browse for the *koc file.  

3． Define whether to generate solid wall and the height of the room. 

 

4． The system will automatically generate what you have made in 2d to 

modeling. 
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Chapter 8 Window, Edit Attribute and 

Other Functions 

§8.1 Window 

§8.1.1 New Window 

This funciton is used for creating new window in the modeling mode. Select 

New Window from the Window menu. 

§8.1.2 Close 

This funciton is used for closing the current window in the drawing. Select 

Close from the Window menu. 

§8.1.3 Close All 

This funciton is used for closing all the windows in the drawing. Select Close All 

from the Window menu. 

§8.1.4 Cascade 

This funciton is used for arranging the windows in the drawing. Select Cascade 

from the Window menu and window will be showed as below. 
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§8.1.5 Tile Horizontally 

This funciton is used for arranging the windows horizontally in the drawing. 

Select Tile Horizontally from the Window menu and window will be shown 

horizontally. 

§8.1.6 Tile Vertically 

This funciton is used for arranging the windows vertically in the drawing. Select 

Tile Vertically from the Window menu and window will be shown vertically. 
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§8.1.7 Arrange Icons 

This funciton is used for arranging the windows in 3 ways: Horizontal, Vertical 

and Cascade. 

§8.2 Others 

§8.2.1 Yuan Fang Toolbar 

This toolbar contains several functions, such as Attribute Edit, New Camera, 

Hide and Regen. 

 

§8.2.2 BtoCAD Menu 

This function is for switching to standard CAD menu. While you are using 

BtoCAD menu and want to return to T5 menu, input „mgx‟ in the command line 

and press Enter. 

§8.2.3 General Setting 

These are some basic settings for structure elements in modeling. These 

settings will not affect those exsiting drawings.  

1. Wall 

 Height: This is the default wall height in modeling. 

 Thickness: This is the default wall thickness in modeling. 

 Segments per Curve: This is default precision for curve objects while 

exporting to VR, such as curve wallhole, curve decoration, etc. 

 Hatch Style: This is the default hatch style for the wall in modeling. 

Changing the default will affect the new walls. 

 

2. Color Setting 
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 Wall Layer: This controls the display color of the wall. 

 Grid Layer: This controls the display color of the grid. 

 Window Layer: This controls the display color of the window. 

 Column Layer: This controls the display color of the column. 

 

3. Dynamic Orientation 

 

 Distance: This controls the distance while moving doors or windows 

along the straight wall. 

 Angle: This controls the distance while moving doors or windows along 

the curve wall. 
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§8.2.4 Display of Objects 

System provides functions to control the display of the objects. If you want to 

hide/show the object, please activate the relavant command and select the 

objects. 

§8.3 Summary of Edit Attribute 

Edit attribute is one of most outstanding features of CAD modeling. 

Attributes, are geometric parameters for modeling and data for defining the 

graph of object. Each attribute can define or affect one aspect of certain object, 

and at the same time every attribute is comparatively independent. 

Edit attribute is applicable to all the objects. If you select the defined object of 

BtoCAD, object editor of BtoCAD should be used, while you select the defined 

object of InteriCAD System, the Edit Attribute should be used. And this chapter 

will focus on the latter one. 

In CAD modeling of the design system, objects that can be applicable to Edit 

Attribute include wall, doors & windows, wood line, and wall hole, etc. 

§8.3.1 Start the Edit Attribute 

Here are three different methods to start the Edit Attribute: 

 Input the command MGXEA. 

 Click the Edit Attribute button in the toolbar of InteriCAD T5. 

§8.3.2 Dialog Box of Edit Attribute 

After starting the Edit Attribute, select an object and then a dialog box of Edit 

Attribute will popup. The main control functions are as follow: 

 Attribute: List all the attributes of the selected object and current 

parameter of every attribute. 
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 Edit: correspond to the editing operation of the attribute. 

 Copy: correspond to the copying operation of the attribute. 

 Extract: use to extract the parameter of the attribute. 

 

Every attribute has its own operations. Suppose you select an attribute in the 

Attribute, system can only generate the applicable operations, while the 

functional button of inapplicable one will turn gray 

Dialog box of Edit Attribute is shown as follow: 

 

§8.3.3 Attribute Edit & Common Operation 

There are three types of attribute edit, including edit, copy and extract. 

1． Edit: edit is used to modify certain attribute of the object. The operational 

procedure is indicated as follow: 

1) Choose the right attribute you want from the Attribute in the Edit 



InteriCAD T5 User Manual 

 191 

Attribute. 

2) Left click the Edit button. 

3) Input the new value. Different types of attribute can have different types 

of attribute value. The data type of the new value must match the type of 

the original one. (For an attribute value like Switch, nothing will happen 

after you left click the Edit. The graph will be changed only after the 

dialog box has been shut down.) 

4) After input the value, back to Edit Attribute and click OK to finish the 

operation. 

 

2． Copy: choose one or more different attributes and apply them to the 

object of the same type. In this way, they can be provided with same 

attribute values of the original one. The operational procedure is as 

follow: 

 

1) Choose one or more available attributes from the Attribute in the Edit 

Attribute. (Remember the Copy button in the dialog box must be 

available.) 

2) Left click the Copy button. 

3) Choose the one or more objects of the same type from the interface 

after the dialog box is hidden. 

4) Back to the Edit Attribute, and click OK to finish the operation. 

 

3． Extract: extract is applicable only when the attribute value belongs to 

the attribute of an entity, such as shape of wall hole, baseline of wood 

line and profile. It is used to extract certain components of the selected 

object and shape another graph. The operational procedure is shown 

as follow: 

 

3) Choose the attribute that is available from the Attribute in the Edit 
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Attribute. (Remember the Extract button in the dialog box must be 

available.) 

4) Left click the Extract button. 

5) Here, operation differs according to the attribute. For the attribute that is 

not necessary to extract in the original position like section, should be 

oriented in the graph. 

6) Back to the dialog box, and click OK to finish the operation. 

§8.3.4 Common Attributes 

The content of attribute differs with accordance to different type of object, but 

each type of object has its similar attributes to others, such as Name, Display, 

Color and Hide. Here, we take wall for instance to explain the said common 

attributes. 

7. Name 

Name is the attribute that is used to mark object. The only operation 

available is Edit. 

 

The operational procedure of Name edit 

 

 Choose Name from the Attribute in the Edit Attribute, and then click Edit. 

 Input a new name in the Insert, and then click OK. 

 Here, Name has already been changed the moment Edit Attribute dialogue 

box reoccurs. Click OK. 
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Display 

There are two kinds of object display: 3D and 2D. When the object is displayed 

by 3D mode, the 3D graph of the object will be displayed in the screen. 

Reversely, it will only display the plan icon when 2D mode is applied. 

Edit & Copy can be carried out for Display. 

 

The operational procedure of Display edit 

1． Start the command of Edit Attribute. 

2． Choose the wall ①. 

3． Choose Display from the Attribute in the Edit Attribute, (Here, the attribute 

value is displayed as 3D.) and then left click the Edit button. 

4． Display has already been changed into 2D when Edit Attribute reoccurs. 

Click OK to complete the Display editing of wall ①. 

5． Restart the command of Edit Attribute. 

6． Choose the edited wall ①. 

7． Choose Display from the Attribute in the Edit Attribute, (Now, the attribute 

value is displayed as 2D.) left click the Copy button. 
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8． Choose the wall ②. 

9． Left click the OK after the Edit Attribute reoccurs. 

 

6． Color 

Color of object can either stand for an index number of one color, or a 

BYLAYER as well as a BYBLOCK.  You can do the Edit & Copy to Color same 

as to Display. 

 

7． Hide 

This attribute controls object to hide or not in the graph. The attribute value is 

defined as Yes or No. You can do the Edit & Copy to Hide same as to Display. 

§8.3.5 Wall Attribute Edit 

Dialog box of Straight wall and Arc wall are shown as follow: 

       

(Dialog box of straight wall attribute edit)  (Dialog box of arc wall attribute edit) 
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1． Starting Point & Ending Point: the position of straight wall is defined by Starting 

& Ending Point. You can change the position and the length of wall by 

changing its Starting & Ending Point.  

2． Center point & Radius: the position of arc wall is defined by Center point & 

Radius. 

3． Wall Height & Wall thickness: the shape is defined by Wall Height & Wall 

thickness. 

You can easily discover the change of wall shape by changing the wall 

thickness from 120mm to 500mm, as well as changing the wall height from 

3000mm to 4500mm in the following example.  

4． Filling Option: it is used to define whether the wall is solid or vacant. 

 

5． At Doors and Windows: it is used to define whether the contour line of wall is 

open-up when the door and window is fixed in wall. 

In the following example, you can find out the differences of the graph by 

changing open-up into shut-down at doors and windows.  

 

Segment Density: it that helps to control the graphic precision is only of avail to 

arc wall. The higher segment density you adjust the higher graphic precision 
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you will get.  

6． Hide: when the Hide is edited as Yes, all the belongings in wall such as doors, 

windows and wall holes will be hidden. 

§8.3.6 Doors & Windows Attribute Edit 

Dialog box of Doors & Windows is shown as follow: 

 

 

By using the Edit Attribute, you can modify the style of doors & windows, their 

position in wall, their height & thickness and swing direction, etc.  

Style: the style of doors & windows is defined by model of the library. You can 

change the style of doors & windows into another by simply modifying Style.  

 

The operational procedure of doors & 

windows style edit 

1． Choose Style from the Attribute in 

Edit Attribute, and then click Edit. 
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2． You can choose another doors & windows style from the Show Library. 

3． Back to Edit Attribute, and click OK. 

 

For example, you can easily change the vault door into the square one. 

1． Position: 

By using the Edit Attribute, you can modify the position of doors & windows, 

which will be automatically updated after the modification. In ACAD, 

position of doors & window will not be updated even the “move” command 

has been carried out. 

2． Width & Height:  

The size of doors & windows is defined by Width & Height. 

3． Offset & Raise: 

Offset is used to measure the level distance between midline of wall and 

midline of doors & windows. The offset value can be positive or negative, 

representing offset direction of doors & windows.   

Raise is used to measure the upright distance from the bottom of doors & 

windows to bottom of wall. 

4． Swing Left or Right: 

There are two types of swing direction that can only do the Edit operation. 

One is left or right while the other is in or out.  

§8.3.7 Wood Line Attribute Edit 

Dialog box of wood line is shown as follow: 
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By using Edit Attribute, you can modify various attributes, including Profile, 

Base Shape, Profile Dimension (both profile thickness & height), Rotate, 

Smoothness of Profile & Curve Baseline and Direction, etc. 

1． Profile: 

You can pick up the profile from the library, or you can get it by choosing 

self-defined curves on the screen. There are two relative attributes of Profile 

in the Attribute of Edit Attribute. They are Library and Profile. You can find 

the profile curves available in the Library, while self-defined profile can be 

obtained in Profile. In addition, you can even extract the profile curves from 

selected woodline in Profile. 

2． Base Shape: 

Base Shape is the path to make wood line. Operation of Edit, Copy, and 

Extract can be carried out. 

3． Profile Dimension: 

There are two types of attribute: Profile Thickness & Profile Height. Profile 

Height is the profile dimension in the direction of normal from the baseline. 
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Here, both direction of baseline and direction of normal baseline are 

perpendicular to Profile Thickness. 

 

Either Thickness or Height can be edited separately. In the following example, 

you can see the Height of wood line is doubled while the thickness stays 

unaltered. 

§8.3.8 Wall Hole Attribute Edit 

Dialog box of wall hole is shown as follow: 

 

1． Profile: 

The profile of wall hole is defined by a close 2D curve. Contour lines are not 

allowed to intersect. You can do the operation of Edit, Copy and Extract to wall 

hole. 

2． Location 

Wall hole can be fixed in any location of wall, like in the middle or at the 

borderline. But you must locate it within the wall. During the dynamic 
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orientation, the location of the cross cursor is the same as to the anchor point. 

If you modify the wall hole position by other edit tool, the new wall hole can be 

displayed only by updating the wall. 

3． Depth: 

You can define the dimension vertical to wall. By setup different depth, you can 

get wall hole either in transparent or opaque form.  

4． Segments per Curve: 

Segment per Curve that helps to control the graphic precision is only of avail to 

arc wall with wall hole. The more Segments per Curve you adjust the higher 

graphic precision you will get. 

§8.4 Other Functions 

§8.4.1 System Optimizing 

§8.4.1.1 Document Cleaned up 

You can optimize the system by this function that will help you to remove the 

useless fragments like drawings, layer, line type, model file, and font style, etc. 

§8.4.1.2 Compress & Restore 

The ram consumes a lot when dealing with the complicated graph and 3D 

objects. Use the Compress function will help you to reduce the ram 

consumption and speed up the display by covert 3D graph to 2D. You can 

display them in 3D by Restore function. 

§8.4.1.3 Edit Shortcut 

Most of the time, you need to input the command in the command interface so 

as to quicken the drawing. Here, you can edit command shortcut in order to 

better save your time. This function will help you to add command shortcut 

manually. 
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§8.4.2 Camera 

Camera determines the view by simulating optical characteristic of human. We 

call the view generated by Camera as Perspective. You can not zoom-in, 

zoom-out, spin, etc. to view the graph in the Perspective. 

All the relative commands can be found in 

Camera. You can get toolbar of Camera at top 

right corner of the screen. It is shown as follow: 

 

§8.4.2.1 Set up New Camera 

You should appoint a lay-out position & an aim of the camera when editing a 

new camera. 

Operational Procedure of Setting up New Camera: 

1． Choose Camera from the toolbar, and click New. 

2． Appoint a lay-out position of the camera. 

3． Appoint an aim. 

4． The lay-out position & aim are defaulted as 1600mm. After finish setup, the 

system will automatically generate a side-glance view as the new camera‟s 

view. 

 

Chapter 9  Virtual Reality 

§9.1 Overview    

Virtual Reality (Short for VR), is the render engine of InteriCAD. It fulfills 

rendering function, whose mainly tasks are related to photo rendering in the 

system; such as renderings, animations etc. InteriCAD VR is a completely 

independent rendering platform. All the operations related to rendering, such 

as edit materials, set lighting, can be completed in InteriCAD VR. You can also 

use your own data format to save the InteriCAD VR file at any state. For 



InteriCAD T5 User Manual 

 202 

software usability, all the settings in ACAD rendering module can be read in 

InteriCAD VR, but some special materials and lighting can only be set under 

InteriCAD VR. In addition, radiosity and raytrace technology in rendering 

calculation makes the design natural and realistic.  

A procedure of Virtual Reality: 

 Build 3D model scene using Modeling Design function of InteriCAD T5 

or 2D drawing using InteriCAD 2D Design. 

 Import the 3D model scene or the 2D decoration drawing created by 

InteriCAD 2D Design into InteriCAD VR. 

 Make further design of the 3D scene in InteriCAD VR, such as 

adjusting model materials and setting light of the scene. 

 Multiplex output by raytrace and radiosity technology. 

 

 

 

 

 

 

Raytrace 

 

 

 

 

 

§9.2 InteriCAD VR Interface and Command 

Function 

This chapter introduces InteriCAD VR interface, functions and all the 

commands. 
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InteriCAD VR interface: 

The InteriCAD VR interface is composed mainly of menu bar, tool bar, 

workplace, and command window, control panel and status bar. 

 

 

 

 

 Menu Bar: left click to use the command. 

 Tool Bar: where most common commands are placed, you can left click 

to use the command. 

 Workplace: where you can operate the InteriCAD VR scene. 

 Command Window: where you can input command directly. 

 Status Bar: Display cursor position and mode. 

 

 

Menu Bar Tool Bar 

Status Bar 

Command 

window 

Workplace 
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Basic Operations of the Software: 

Common Command  

   InteriCAD VR provides several methods to use the command: 

1. Left click the command in menu bar 

2. Left click the command in tool bar 

3. Input command directly in the command window using keyboard 

4. Use hot key, such as F2. 

 

The use of the mouse: 

Left button: most operations are completed using left button, e.g.: select 

the command in the dropdown menu, click the command in the tool bar, 

select the object and determine the base point of the object. 

Right button: 

1. During the operation of some commands, you need to use right 

button to operate. For example, in pitching movement command, 

you can use the right button to control the height of the viewpoint. 

2. In some commands, you can use the right mouse button to 

terminate the current command. 

3. In most object editing commands, the function of the right button 

and Enter is the same. 

 

Two Basic Operation Rules: 

Rule 1: Select the command and follow the command prompts. For 

operation convenience, most common-used commands have 

been integrated in the tool bar. 

Rule 2: You can directly select the command first and then select object 

to operate. 

 

Introduction to the Command on the Menu Bar: 

File ： 

Open:                 Open InteriCAD VR file and the file format is .mrs 
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Save:                  Save the InteriCAD VR file using .MRS format. 

New:                  Create an empty scene 

Import From Modeling: Import 3D model from Modeling. 

Merge From Modeling: Merge the 3D model imported from Modeling to 

the current InteriCAD VR scene. 

Import 3DMax Model:     Import .mtf file output by 3DMax. This file type 

can be output only when you have installed the 

plug-in for 3DMax. 

Merge 3DMax Model:     Merge .mtf file output by 3DMax to the current 

InteriCAD VR scene. 

Import 3ds Sketchup model:   Import .3ds, .skp, .mtf files output by 

3DMax or sketchup. 

Import 2D File:          Intelligent import the .STD and .KOC file drawn 

by InteriCAD 2D Design. 

Template Setting: The intelligent import of 2D interactive STD file 

is controlled by STD template. And this 

command is used to add and adjust existing 

STD template. 

Save Mvr:               Save Mvr file for VRViewer. 

Slope ceiling:            Create slope ceiling for current scene 

Setting / Unit:            Choose inch or meter as measurement 

Setting/Auto Brightness:     Turn on/off auto brightness function 

Setting / Vr Option:       Define the precision of imported models 

Setting / Use Animate cursor: InteriCAD VR provides a series of animate 

cursors to display different status of the 

software. Recommend for use. 

Toolbar Manager:        Define the display of toolbar. 

Exit: Exit InteriCAD VR. 

View： 

Display Mode / Texture:    Display all the texture maps and color 
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materials. 

Display Mode / Color:   Display texture map and color materials in 

pure color mode.                                  

Display Mode / Wire Frame:   Display all the models using wireframe. 

The display speed is fast. 

View / Top View:              Switch to top view. Default is to show the 

whole scene. 

View / Bottom View:           Switch to bottom view. 

View / Front View:             Switch to front view. 

View / Back View:             Switch to back view. 

View / Left View:            Switch to left view. 

View / Right View:             Switch to right view. 

View / SW Perspective:     Switch to SW Perspective. 

View / NW Perspective:     Switch to NW Perspective. 

View / NE Perspective:      Switch to NE Perspective. 

View / SE Perspective:      Switch to SE Perspective. 

Walkmode:                    Make horizontal plane move in the scene. 

You can adjust the position of the 

viewpoint under special views such as 

plane view and right view. 

Elevate:                       To rise and lower of the movement 

Spin:                         Spin around a camera object point. 

Pan:                        To move entire object to relative viewing 

point 

Look at:                       Click any surface in the scene using the 

mouse and the camera will automatically 

aim at this surface. The link line between 

the viewpoint and target point will be 

perpendicular to this surface. 
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Zoom Mode / Zoom:           You can zoom in or zoom out the view 

under special views such as plane view and right 

view. 

Zoom Mode / Zoom window:   The five special views mention above can 

use this command to zoom in and zoom out the 

window and make partial view. 

Zoom Mode / Zoom extend: The five special views mention above can 

use this command to display the whole scene. 

Zoom Mode / Zoom rotate:  Rotate the view, and every time the 

command is executed a 30 degrees angle will be 

rotated. 

UCS / Set UCS: Left click any surface in the scene and the current 

space coordinate will be built based on this surface, 

using the green axis as the X-axis and the red axis 

as the Z-axis. (UCS: User Coordinate System). 

UCS / Rotate X Axis: Rotate the UCS around X-axis (green axis). 

UCS / Rotate Y Axis: Rotate the UCS around Y-axis (blue axis). 

UCS / Rotate Z Axis: Rotate the UCS around Z-axis (red axis). 

UCS / Move UCS: Rotate the UCS on the XY plane. 

UCS / UCS On: Display the current space coordinate system and a 

blue grid will be generated on the XY plane. 

UCS / UCS Off: Hide the current space coordinate system. 

Camera / Edit Camera:     Edit the position of the camera, the position of 

the target point and the focal length of the camera 

lens. 

Camera / Save Camera:     Save the current view to the camera list. 

Camera / First Camera: Switch to the first camera view in the camera list. 

Camera / Last Camera: Use the last camera in the camera list and return 

to perspective status. 

ShowCamera list:          Display all the saved camera lists. Double 

click to switch the camera. 



InteriCAD T5 User Manual 

 208 

Products Library： 

Show library:             Using the InteriCAD VR library interface. 

Hide library:             Hide the InteriCAD VR library interface. 

Library Manager:         Add models to library. 

Library Backup:            Backup, restore and merge the library of 

InteriCAD T5.  

Import VR block:            Insert InteriCAD VR block file, and the file 

format is *.mrm. 

Export Surface:             User can willfully select some surfaces in 

the current scene and output these selected surfaces 

to an InteriCAD VR block file. and the file format is 

*.mrm. 

Export Object:           Export objects in the current scene as VR 

blocks, which can be saved in the format of *.mrm. 

Renew VR Block: After you have finished modifying .mrm VR 

blocks, overwrite the original one or save as a 

new file. 

Export Whole Scene:   Entirely output the current scene to an 

InteriCAD VR block file, and the file format is *.mrm. 

Create Entity:         Define a group of surfaces as an object. 

Explode Entity:       Explode an object so each of its surfaces become 

an object. 

Clone Object:          Copy objects from an existed scene. 

Export Clone Object:           Export .vrt file as a clone object scene 

Furniture List:          Show all the furniture of the scene. 

Kitchen Design： 

Show Library:           Show library of kitchen design. 

Close Library:           Close library of kitchen design. 
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Unit Redrop:            Move a cabinet unit to a place next to another 

object 

Change Size:         Change the width, depth and height of an object 

based on 3 bases. 

Create Worktop:       Create worktop for cabinet units. 

Create Worktop Manually:    Create worktop manually for cabinets units. 

Create Plinth:           Create plinth for cabinet units. 

Create Pelmet:          Create pelmet for cabinet units. 

Create Cornice:         Create cornice for cabinet units. 

Change Handle:       Change all doors and drawers of all cabinet units. 

General Panel:        Generate a simple panel. 

Shelves Panel:        Generate a shelves panel between two vertical 

panels. 

Dividing Panel:        Generate a vertical panel between two horizontal 

panels. 

Parameter Settings:     Set the parameter of different elements. 

Select Current Room:     Select a room for current designing. 

 

Object： 

Single Selection:          Select mouse clicked objects only 

Box Selection:        Select all objects contained in the selection box 

Surface repair:           All the 3D models will be transformed to 

single face object before and after they enter 

radiosity. This tool can control the orientation of the 

single face. Note: this function can only be used 

before you use radiosity. 

Align Object:                   Align objects 

Snap On:               Snap all the vertexes of the small triangles 

during object edit operation. 

Edit Object/Array:         Array objects    
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Edit Object/ Copy Object along Line:   Copy objects in specified direction 

Edit Object/Move:         Move selected object 

Edit Object/Rotate:        Rotate selected object           

Edit Object/Scale:         Resize selected object       

Edit Object/Mirror:         Mirror selected object 

Edit Object/Delete:        Delete selected object 

Edit Object/Copy:         Copy selected object 

Edit Surface:              Move, delete, copy, mirror, rotate and resize 

the surface before using radiosity. 

Dettach:                 Separate selected coplane surface or patch. 

Measure Distance:       Measure distance between two selected points 

Distance from Object to Wall:  Measure distance between object and wall  

Distance between Objects:    Measure distance between objects 

Nearest Distance:           Measure nearest distance on four directions 

Accurate Edit: Select the object, surface, common surface and 

triangle and then execute corresponding edit 

operations. 

Clear Selection: Clear the existing selection. 

Object display:           The model in the view will be displayed in a 

black wireframe or be hidden directly. 

Hide Unselected:         Hide all unselected objects. 

Hide Object:            Hide selected object. 

Hide Surface:            Hide selected surface. 

Show All:               Show all objects. 

Material: 

MaterialEditor:           Build new material, assign material to a 

model and adjust the material. All the 

material parameters can be adjusted before 

using radiosity. And most parameters can be 
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adjusted after using radiosity. 

Material library:       Execute operations such as save the 

material and assign the material. 

Fit map:  Fit the texture map size same as surface 

size. 

Editmap:  Adjust the existing texture map coordinate, 

such as move, rotate, scale and mirror. 

Resetmap:  Set the texture mapping type as default. 

Random material: Adjust the entire scene or the individual 

object.  You can apply the match-color plan 

from the library and add new one. 

Tiling 

Tiling Design:                   Select a surface to design. 

Clear Tiling:                    Clear previous tiles. 

Apply Tiling Plan:                Use saved tiling plan. 

Replace Tile:                    Replace single tile or all tiles. 

Split Surface:                   Split a surface in Render module. 

Extrude Surface:               Extrude a surface in Render module. 

Quotation:                      Quotation of tiles, such as price, 

number, and wastage. 

 

Light Setting： 

New Light:               Specify one object in the scene as a light 

source. You can control the parameters such 

as light source type, brightness and light 

color. 

Clear Light Property:               Cancel the object as light source. 

Edit Light:           Adjust the light source parameters of the 

scene, such as light source type, brightness 

and light color. 
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Sunlight Setting:                Set sunlight and relative parameters. 

Lighting List:                       Show all lights in scene, and enter 

light-edit menu. 

Smart Light:                     Automatically create lights in the 

scene. 

Smart Light Setting:               Decide whether to keep the existing 

light in the scene. 

Special Light 1:              Set an invisible light. Wattage is 40. 

Special Light 2: Set an invisible light. Wattage is 500. 

Delete Special Light: Delete special light. 

Render： 

Start Radiosity：         Perform radiosity calculation of the current 

whole scene. 

Raytrace：         Do raytrace calculation of the current 

perspective workplace. 

Partial Raytrace Do partial area raytrace calculation of the 

current perspective workplace. 

Stop:                       Stop the calculation of radiosity, raytrace 

and animation preview. 

Instant Render On/Off:             Turn on/off instant render. 

Instant Render Refresh:           Refresh rendering after adjustments 

of lights, objects and materials. 

Set Background: Set the exterior background  

Light Adjustment:           You can only adjust the whole brightness 

before you use radiosity. And after you use 

radiosity, the effect after using raytrace can 

be previewed and the brightness and 

exposure of the entire environment can be 

controlled. 

Light Adjustment without Radiosity: The effect after using raytrace can be 

previewed before and after using radiosity 
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and the brightness and exposure of the entire 

environment can be controlled. 

Environment Setting:      The scene will automatically set an 

environment light if you use raytrace before 

using radiosity. And this command can 

control the brightness of the environment 

light. 

Reset Radiosity:           Clear the calculation result of radiosity, and 

return to the time before you use radiosity. 

Plot Area Preview:                Show how the image will look like 

when it is saved. 

Save Image：                Save the image file of effect drawing, 

full view drawing and 3D drawing. 

Additional Scan:                  Continuous Scan based on the 

previous result. 

Batch Render: Select the camera of the scene, make auto 

calculation and save the effect drawing. 

Channel Picture:              Export channel pictures. 

Hand Drawing:                 Export picture in wire frame mode. 

Export DXF:                     Export .dxf files. 

Net Render Monitor:            Monitor of Net Render. 

Net Render Server:               Start Net Render Server. 

Animation： 

Record:                        Record the mouse motion trace as the 

path of the animation. 

Select path:                     Set the relative polyline as the path or 

target of the animation. 

Set Path:       Create the path for camera in VR.  

Load Path:      Load saved path file, and the file format is 

*.pth. 

Save Path:                      Save the current animation path that 
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has been set to a file. 

Preview Animation:              Preview the animation. 

Make animation:                 Save the animation file. 

Optimize： 

Optimize Surface:              Reset patches on surface. 

Optimization Option:             Set the minimum length of patch. 

Optimize Model:                Reduce the surface of the model. 

Optimize Display:     Use cuboid to substitute part of or all models to 

optimize display speed. 

Surface Radiosity Setting:   Set radiosity of a single surface to get 

optimized outcome. 

Help 

Support:        Help document of InteriCAD 

About:                  Copyright information. 

 

Some Common Used Commands Integrated on the Tool Bar: 

Load From Modeling Stop Raytrace Reset Radiosity Light Adjustment Color Mode Move Spin pan Edit Camera 

 

 

 

Merge From Modeling Radiosity Raytrace Partical Raytrace Texture Mode Wireframe Mode Elevate Face to 

 

Light Property Object Display Select Mode Object Surface Patch Mapping Clear Selection  

 

 

 

Material Edit Surface Orientaion Copy Map Matrix Coplane Surface Preview Record Save Image 



InteriCAD T5 User Manual 

 215 

 

top           right       3d         zoom extend   last view 

 

 

    

  front            bottom      zoom window 

Default keyboard shortcut command: 

F2   Show Library 

F3   Raytrace 

F4  Auto Light Adjustment 

F5   Delete Object 

F6   Material Editor 

F7   Edit Light 

F8   Last Camera 

 

§9.3 File Menu 

§9.3.1 Open 

Open a previously saved file, which is in *.mrs file format 

Basic operations: 

Click File  Open in menu bar. Select the file. 

§9.3.2 Save 

Save the current drawing file, which is in *.mrs file format. 

Basic operations: 

Click File Save in menu bar. 

A Save as dialogue box will appear. In dialogue box, choose the file path and 

input the name of the file, then click Save button. 
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§9.3.3 New 

Create a new drawing file. 

Basic operations: 

Click File  New in menu bar. 

Note: if any changes have been made to the current file, the system will ask you 

whether to save it. Click Yes, the system will save the file. If it is a new file, the 

file will be saved as a new file. 

Click No, the system will open a new file without saving the current file. 

If Cancel, the system will not open a new file. 

§9.3.4 Import from Modeling 

 Enter InteriCAD VR from main interface. 

 From the File menu select Import from Modeling command or you can 

click the  button on the tool bar. 

 Then it will switch to InteriCAD Modeling part. According to the prompt 

of Select objects, you can select the corresponding object. If you want 

to select all the objects, you can input ALL and then press Enter. 

 Now the system will make some corresponding transformation of the 

model and all the faces will be transformed to Single face (one face 

can be seen only from that side, but can not be seen from the other 

side). And then all the faces will be divided equally. 

 After all the process has been done, the model will appear in the 

perspective workplace of InteriCAD VR. 

 If you don‟t need to continue merging models, you can close Modeling 

part to save system resource. 

§9.3.5 Merge from Modeling 

 Click File Merge from Modeling in menu bar 
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 The system will switch to InteriCAD Modeling part. According to the prompt 

of Select objects, you can select the corresponding object, right click to 

confirm and appoint the observer point. 

 After all the process has been done, the model will appear in the 

perspective workplace of InteriCAD VR. 

§9.3.6 Import 3DMax Model 

1. Insert SetMaxPlugin  

1. Make sure that you have installed 3ds Max software in the 

computer you run the SetMaxPlugin (suitable version: Discreet 

3dsmax 6, Discreet 3dsmax 7, Autodesk 3ds Max 8, Autodesk 3ds 

Max 9, Autodesk 3ds Max 2009) 

2. In the InteriCAD installing process, the installation program 

automatically runs the SetMaxPlugin; if you want to manually run the 

plugin, please double click the SetMaxPlugin.exe icon to install. 

3. Appoint the 3ds Max version and installation path in the pop-up 

dialogue box, then click Setting to complete the set-up. 

 

4. The following dialogue box shows that you have successfully 

installed the plugin. 
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2. Export MTF format file in 3ds Max 

1. Open 3ds Max model. 

2. Select export from File menu; choose Export Selected if you want 

to convert some parts. 

3. In the pop-up dialogue box, appoint the saving path and a name. 

4. Select 3DMax-YF mtf (*.mtf) in the Save as type menu, click Save 

to complete the conversion. 

3. Import MTF files in VR: 

1. Enter InteriCAD VR from main interface. 

2. From the File menu select Import 3DMax Model command, the 

system will ask you to clear the current scene, click OK to continue. 

And then select a MTF file in the pop-up dialogue box. 

3. Left-click Open button, the model will appear in the perspective 

workplace of InteriCAD VR. 

 

§9.3.7 Merge 3dMax Model 

 Click File Merge from 3DMax in menu bar.  

 Select a MTF file in the pop-up dialogue box. 

 Left-click Open button, the model will appear in the perspective workplace 

of InteriCAD VR. 

§9.3.8 Import 3ds Sketchup Model 

 Prepare .mtf, .3ds or .skp files. 

 Enter InteriCAD VR from main interface. 
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 From the File menu select Import 3ds Skethchup. 

 An Import MTF/3DS/SKP dialog will be pop up. Select the file needed to 

be imported. Set the Unit Option and Merge Option and choose an 

insert point. If you want to explode, tick the Explode selection. Click OK 

to finish. 

§9.3.9 Import 2D File 

 From File menu click Import 2D File. 

 Select *.koc file in the appeared dialogue box. 

 The system will pop up the dialogue box of selecting template. The 

preview picture of the template is on the right side of the dialogue box. 

You can select a template according to your need and then press OK 

button. 

        

C. The system will read the wall structure of the selected plane file and 

preview using yellow lines. Click the left button in the room that needs 

to generate 3D scene and the room will be displayed in yellow dotted 

line. Press Ok. 
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D. The system will automatically generate the 3D scene of this room in 

InteriCAD VR. 

 

§9.3.10  Template Setting 

InteriCAD provides an advanced function for you to create your own templates. 

Template is the style or atmosphere of the room you want to generate in 3D. 

Most of the elements in the template are basic features of interior design, such 

as door and window styles, floor maps, skirting, cornice, etc.  

You can modify or create your own template using Template Editor. The 

template format is “*.mrt”, which is put under path X:\interiCADT5\vr\mrt(X is 

the disk where you have installed InteriCAD T5. 

 

Basic operations to modify an existing template: 

1 Open 3D, select Template Setting from File menu or input “mt” in the 

command line. Next, click Open button in the pop up dialog box. 
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2. Select a template to modify that is stored under IntericadT5/vr/mrt. 

 

 

Next are the instructions for each item in the template setting dialog box. 

Template file 

Name: You can type your preferred name. 

Class: You can either select a type or create your own folder under InteriCAD 

T5/VR/MRT. The folder you created will be shown in the drag box. 
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Preview: You can either choose a JPG image or put an image under Intericad 

T5/vr/mrt with the same name as the template file. In this way, you will make a 

preview for the template. 

Note: You can save a rendering image before editing or creating a template. 

Description: You can describe the template as you want in text. 

 

General setting 

Elevation: The value controls the height of the room while export from 2D to 

VR. But it will not be activated while you have set ceiling in 2D. 

Wall Lamp: System will automatically layout wall lamps in certain position such 

as both sides of the bed.  

Sunlight: System will automatically activate sunlight effect.  

Brightness: The value controls the strength of the sunlight effect. The higher 

the value is, the stronger the sunlight will be. 

Additional mrm Directory: You can define a directory for your own *mrm files. 

System will firstly search for the mrm files in X:\interiCADT5\vr\vrlib and then in 

the additional mrm directory. 
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Wall 

Default: System will automatically define material for wall if you activate this 

option. 

User defines: User can define their favorite material for the wall. 

Note: Click “…” you can select material from the library.  You can also use the 

material in the scene by clicking Pick up<< button. 

 

 

Wall decoration rule 
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You can define the material of wall behind the object you select. You can also 

set the map size of the texture you defined. 

Note: this function will only work when you have put the relative objects (for 

example, TV cabinet) next to the wall. 

 

 

 

Single door 

Default: System will automatically generate single door after selecting a 

template. This door is made of a door panel with a texture on it. 

Frame: Decide whether to generate frame for the single door. 

Door sill: Decide whether to generate sill for the single door. 

User defines: This option enables user to define thickness, material and even 

handle model (*mrm) for the single door. 

Door model: You can define a VR model (*.mrm block) instead of using only 

door panel. 
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Door frame 

Default: System will automatically generate a door frame for the single door.  

By parameter: You can define width, thickness, section as well as material for 

the frame. 

Fit map: System will automatically adjust the map size for the frame material. 

Model file: You can define a VR model (*.mrm block) for the frame and set the 

relevant values. 
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Door ground 

Default: System will automatically define material for the door ground. 

Material: You can define your favorite color for the door ground either selecting 

from the library or picking up from the scene. 

 

The rest types of doors share the similar setting with the single door. 

 

 

Window 

Default: System will automatically generate windows with the default mrm 

model. 

Frame: Decide whether to generate window frame. 

Sill: Decide whether to generate window sill. 

Curtain: Decide whether to generate curtains for the window. 

Sash width: Decide the length of single window model. For example, if the 

sash width is 1000 and you have created a 3000mm window in 2d, system will 

automatically divide it into 3 parts (3 single windows). 

Window model: You can define a VR model (*.mrm) for the window. 
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Window frame 

Please refer to settings of single door frame. 

 

 

Window sill 

Built-in depth: This value controls the depth that extends to the wall. 

Material: You can define material for the window sill. 
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Curtain 

Default: System will automatically generate curtain with the default model. 

Note: System will not generate curtain in the kitchen and bathroom. 

User defines: System will automatically generate a piece of sheet in front of 

the window. You can define its material and size.‟ 

Side space: Decide the distance between side edges of the curtain and the 

wall. 

Distance to wall: Decide the distance between the curtain and the wall. 

Upper Space: Decide the distance between the upper edge and the wall. 

Bottom Space: Decide the distance between the bottom edge and the wall. 

Material: You can define material for the curtain. 

Model file: You can define a VR model (*.mrm) for the curtain. 
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The setting of the Bay window is similar to the setting of the single 

window. 

 

Whole hole 

Default: System will automatically generate whole holes according to the 

default setting. 

Generate Lamp: Decide whether to generate lamps in the upper edge of the 

wall hole. 

Generate Sill: Decide whether to generate sill for the wall hole. 

Wall Hole MRM: You can define your own model (*mrm) for the wall hole. 
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For frame and sill setting of wall hole, please refer to the similar settings of the 

single door. 

 

Ground 

Material: You can define material for the ground as well as setting its size. 

 

 

Ground stage 

Material: You can define material for the ground stage (second, third…) as well 

as setting its size. 



InteriCAD T5 User Manual 

 231 

Border Material: You can define material for the boarder. 

 

 

Ceiling 

You can define the ceiling type as well as its material. 

Note: This function will be activated when there is no ceiling in 2d. The ceiling 

block will generate according to the position of sofa, table and TV cabinet.  

There won’t be ceiling block generated if system can not find the furniture. 
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Ceiling Cornice 

Default: System will automatically generate ceiling cornice according to the 

default setting. 

Generate: System will automatically generate ceiling cornice and you can also 

define its size and material. 

User Defines: You can define your favorite parameters for the ceiling cornice. 

Shape: You can define the section shape of the ceiling cornice. 

Distance: This controls the distance between the ceiling and the cornice. 

 

Chair rail  

Default: System will not generate waistline while activating this option. 

Generate: System will automatically generate waistline and you can also 

define its size and material. 

User Defines: You can define your favorite parameters for the chair rail. 

Shape: You can define the section shape of the chair rail. 
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Skirting 

Default: System will not generate skirting while activating this option. 

Generate skirting: System will automatically generate skirting and you can 

also define its size and material. 

 

Base Board 

Default: System will not generate base board while activating this option. 

Generate: System will automatically generate skirting and you can also define 

its size and material. 
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User Defines: You can define your favorite parameters for the base board. 

Material: You can define material for the base board. 

Shape: You can define the section shape of the base board. 

 
 

Lamp 

Default: System will generate lamps while activating this option. 

Living room: System will generate pendant lamp according to the position of 

sofa set and TV cabinet. 

Dining room: System will generate pendant lamp according to the position of 

dining set. 

Ceiling lamp: System will generate pendant lamp in all rooms except living 

room. 

Wall lamp: System will generate arbitrary wall lamps. (For example, sides of a 

bed). 

Floor lamp: System will generate floor lamp created in 2d. 

Desk lamp: System will generate desk lamp created in 2d. 

Note: System will not generate ceiling lamp if you have made ceiling in 2d. 
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User defined rule 

You can define certain rules for the room decoration. 

Here is an example showing you how to set a painting in the wall behind the TV 

cabinet. 

1. Select a position to the model (*.mrm) you want to set. For example, 

select the wall behind a TV cabinet. 
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2. Click  button and select a painting model. 

. 

3. Input elevation for the painting. 

 

4. Define the vertical and horizontal size for the model. 

 
5. Finally, click Add button to add the new rule. 



InteriCAD T5 User Manual 

 237 

 

 

Specify furniture 

You can define a model (*mrm) file for the relative furniture type either selecting 

from the library or your own models (they should be *mrm format). 

 

§9.3.11  Save Mvr 

Save Mvr file for VRViewer, which is in *.mvr file format. 

Basic operations: 

1. Click Render Start Radiosity to run radiosity first. 

2. Click File Save Mvr in menu bar. 

A Save as dialogue box will appear. In dialogue box, choose the file path and 
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input the name of the file, then click Save button. 

§9.3.12  Slope Ceiling 

From the File menu select Slope Ceiling. System will turn to top view 

automatically. 

 

Slope ceiling parameter: Set the proportion between the height and the 

hemline of the slope ceiling. The default parameter of the hemline is 10. For 

example, if you set the value of Slope ceiling parameter as 5, and the length of 

the hemline is 1000, then the ratio is 5/10, and the height of the slope ceiling is 

500. 

       

Ceiling height: The height of the ceiling. This option 

will be invalid when using method 1.    

Elevation: The elevation of the ceiling.  

Slope ceiling: Set the ceiling as slope ceiling. 

Plain ceiling: Set the ceiling as plain ceiling. 

Ceiling list: Display the ceilings in existence. You can 

right click the ceiling listed, and select delete to delete 

the ceiling. 

Snap: Turn on/off the snap. 

Add ceiling: When all the settings are finished, click 

Add ceiling to draw a ceiling. 

Edit selected ceiling: Edit the parameter of an existed 

ceiling. Select an existed ceiling in the Ceiling list, and 
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modify the parameter of it, then click Edit select ceiling to confirm the 

modification. 

Patch base line: Change the base line of the ceiling. Select an existed ceiling 

in the Ceiling list, click Patch base line, and you will see the base line will be 

changed. 

Merge wall: When you finish the ceiling, select Merge wall to extend the wall to 

the ceiling. 

                  

There are two methods to create a slope ceiling. 

Note: Plain ceiling can only be created by method 2. 

Method 1: By parameter 

1. Select Slope Ceiling and select method 1. 

2. Select slope ceiling parameter, you could also input a value to define the 

parameter.  

3. Input the figure as the elevation. 

4. Click Add ceiling, and then pick point according to the prompt in the 

command window, right click to finish, and the ceiling will be generated in green. 

You could turn to perspective view to check it. 
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5. Create another slope ceiling on the left side. 
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6. Click Merge wall to extend the wall to ceiling. 

7. Click  to Switch to the perspective view, and you will see the final effect 

as following. 
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Method 2: By ceiling height 

1. Select Slope Ceiling and select method 2, or select Plain Ceiling. 

2. Input the values of the ceiling height and the elevation. 

3. Click Add ceiling, and then pick point according to the prompt in the 

command window, right click to finish, and the ceiling will be generated in green. 

You could turn to perspective view to check it. 
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4. Create another slope ceiling or plain ceiling on the left side. 
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5. Click Merge wall to extend the wall to ceiling. 

6. Click  to Switch to the perspective view, and you will see the final effect 

as following. 
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§9.3.13  Setting 

Unit 

Choose inch or meter as measurement. 

Basic operations: 

Click File Setting UnitDecimal. If you change the size of the object, you‟ll 

see the dimension of the object will be shown in inch. 

Click File Setting UnitArchitectural. If you change the size of the object, 

you‟ll see the dimension of the object will be shown in meter. 

 

Auto Brightness 

Turn on/off auto brightness function. 

Basic operations: 

Click File Setting Auto BrightnessOn to activate it. Click File Setting 
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Auto BrightnessOff to turn off it.   

 

Vr Option 

Reset the parameter of VR 

Basic operations: 

Click File Setting Vr Option to open the VR option dialogue.  

Mesh Size: It is to reset the size of mesh in VR.  

Grid Factor: It is to control the render speed of VR. It has been set to be the 

optimum location.  

Delay Redraw: It is to reduce the refresh of VR drawing. By use this function 

the software can run faster in computers with low configuration.  

AutoSave: It is to activate the auto save function.  

AutoSave Time: It is to reset the time for auto save.  

AutoSave Prompt: It is to set whether to show the prompt or not before saving. 

 

Use Animate Cursor 

InteriCAD VR provides a series of animate cursors to display different status of 

the software. Recommend for use. 

Basic operations: 

Click File Setting Use Animate Cursor. You could use object editor to see 

the effect of animate cursor. 

§9.3.14 Toolbar Manager 

1． From the File menu select Toolbar Manager. 

2． Tick off the toolbars from pop-up dialog box, the relative toolbars will be 

disappeared. 

§9.3.15 Exit 

Select Exit in the menu bar that means to exit 3D design system.  

Note: 

If the current file has been modified, then it will display the Save dialogue box. 
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§9.4 View 

§9.4.1 Display Mode 

The model in the perspective workplace can be displayed in three modes: 

Left click Texture Mode button , and then all the texture maps and pure 

color materials will be displayed. This is the system default setting. But the 

display speed may be slow if the amount of models is large. 

Left click Color Mode button , and then all the texture maps will be 

displayed as pure color material. You can view the match-color status of the 

scene. 

Left click Wireframe Mode button , and then all the models will be 

displayed using wireframe and the speed is fast. 

§9.4.2 View 

Click the Top View button 

 The system will automatically switch to top view and the height of the 

viewpoint will maintain the same with the perspective viewpoint. 

 You can press the left button to drag upward and downward to change the 

height of the viewpoint of the top view. 

Click the Bottom View button 

 The system will automatically switch to bottom view and the height of the 

viewpoint will maintain the same with the perspective viewpoint. 

 You can press the left button to drag upward and downward to change the 

height of the viewpoint of the bottom view. 

Click the Front View button 

The system will automatically switch to front view and the position of the 

viewpoint will maintain the same with the perspective view. If the position of 

the perspective viewpoint is behind the scene, there will be no object in the 

front view. You can press the left button to drag upward and downward to 
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change the viewpoint of the front view to get ideal result. 

Click the Back View button 

The system will automatically switch to back view and the position of the 

viewpoint will maintain the same with the perspective view. If the position of 

the perspective viewpoint is in front of the scene, there will be no object in 

the back view. You can press the left button to drag upward and downward 

to change the viewpoint of the back view to get ideal result. 

Click the Left View button 

The system will automatically switch to left view and the position of the 

viewpoint will maintain the same with that of the perspective view. If the 

position of the perspective viewpoint is on the left of the scene, there will be 

no object in the left view. You can press the left button to drag upward and 

downward to change the viewpoint of the left view to get ideal result. 

Click the Right View button 

The system will automatically switch to right view and the position of the 

viewpoint will maintain the same with that of the perspective view. If the 

position of the perspective viewpoint is on the right of the scene, there will 

be no object in the right view. You can press the left button to drag upward 

and downward to change the viewpoint of the right view to get ideal result. 

Click the Last View button 

The system will automatically switch to the last view in perspective status. 

Click the SW Perspective button 

The system will automatically switch to SW Perspective. 

Click the NW Perspective button 

The system will automatically switch to NW Perspective. 

Click the NE Perspective button 

The system will automatically switch to NE Perspective. 

Click the SE Perspective button 

The system will automatically switch to SE Perspective. 

§9.4.3 Walk Mode 

System defaults to activate Walk Mode button  
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Move Forward: press left button to drag from upward to downward. 

Move Backward: press the left button to drag from downward to upward. 

Move left: press the left button to drag from left to right. 

Move Right: press the right button to drag from the right to left. 

Note: if the data amount of the scene is huge, or your display adaptor 

doesn’t support OPENGL, you may not move smoothly using the default 

texture map color mode. In this case, you can switch to wireframe mode. 

§9.4.4 Elevate 

Single Click Elevate to activate it: 

Rise Up: press the left button to drag from upward to downward. 

Lower Down: press the left button to drag from downward to upward. 

Lift Off: press the left button to drag from upward to downward 

Descend: press the left button to drag from the downward to upward. 

§9.4.5 Spin 

Single Click Spin to activate it 

Rotate Clockwise: press the left button to drag from left to right. 

Rotate counter-clockwise: press the left button to drag from right to left. 

§9.4.6 Pan 

Single Click Pan to activate it 

Press the left button to drag; you can pan the drawing display in real time. 

§9.4.7 Look at 

Single Click the Look at button 

Left click the surface that will be viewed. The camera will automatically aim 

at this surface. 
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§9.4.8 Zoom Mode 

Zoom 

Select ZoomZoom in the View menu. 

The mouse automatically moves into the workspace. Moving upwards the 

mouse is to zoom in the objects, while moving downwards the mouse is to 

zoom out the objects. 

Zoom Window  

Note: this command is invalid under perspective view status. 

Select ZoomZoom Window in the View menu. 

Click to select the first point of a rectangle area. Move the mouse and click to 

specify the second point. And the selected objects will be maximally displayed 

in the rectangle area. 

Zoom Extend 

Note: this command is invalid under perspective view status. 

Select ZoomZoom Extend in the View menu. And the system will adjust the 

current workspace to display all placed objects in it. 

Zoom Rotate 

Select ZoomZoom Rotate in the View menu. And the system will adjust the 

current workspace to display all placed objects in it. Move left or right to rotate 

the scene.  

§9.4.9 UCS 

Set UCS 

Set a surface to set UCS. 

Basic operations: 

1. Select UCSUCS On in the View menu to turn on UCS. 

2. Select UCSSet UCS in the View menu. 

3. Left click any surface in the scene and the current space coordinate 

will be built based on this surface, using the green axis as the X-axis 

and the red axis as the Z-axis. (UCS: User Coordinate System). 

 

Rotate X Axis 
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Rotate the UCS around X-axis (green axis). 

Basic operations: 

1. Select UCSUCS On in the View menu to turn on UCS. 

2. Select UCSRotate X Axis in the View menu. 

3. Move cursor to rotate x axis, left click to confirm, and right click to 

cancel. 

 

Rotate Y Axis 

Rotate the UCS around Y-axis (blue axis). 

Basic operations: 

1. Select UCSUCS On in the View menu to turn on UCS. 

2. Select UCSRotate Y Axis in the View menu. 

3. Move cursor to rotate y axis, left click to confirm, and right click to 

cancel. 

 

Rotate Z Axis 

Rotate the UCS around Z-axis (red axis). 

Basic operations: 

1. Select UCSUCS On in the View menu to turn on UCS. 

2. Select UCSRotate Z Axis in the View menu. 

3. Move cursor to rotate z axis, left click to confirm, and right click to 

cancel. 

 

Move UCS 

Rotate the UCS on the XY plane. 

Basic operations: 

1. Select UCSUCS On in the View menu to turn on UCS. 

2. Select UCSMove UCS in the View menu. 

3. Move cursor to move UCS, left click to confirm, and right click to 

cancel. 

 

 

UCS On 

Display the current space coordinate system and a blue grid will be generated 

on the XY plane. 
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Basic operations: 

Select UCSUCS On in the View menu. 

 

UCS Off 

Hide the current space coordinate system. 

Basic operations: 

Select UCSUCS Off in the View menu. 

§9.4.10  Camera 

Edit Camera 

From the view menu select CameraEdit Camera. 

 

Changing the coordinate of the camera location can control the position of 

the camera. 

Changing the coordinate of the target point can control the position of the 

camera target point. 

Changing the focal length of the lens can control the focal length display of 

the camera. 

When moving in the scene and getting an ideal perspective angle, you can 

save the current camera. 

Left click Edit Camera button  on tool bar, a dialogue of camera editing 

will appear, shown as picture on the right: 
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Preview： Drag camera and target spot to change view. 

Depth:  Drag a slider to adjust the depth of view.  

Cam. Height: Set camera height and change vertical direction of view, only 

effective in camera view. 

Tar. Height: Set target height and change vertical direction of view, only 

effective in camera view. 

Focus: Change the focal length of camera. 

Save Cam: Save current camera setting. 

Cam. List: Show saved camera settings. 

Save Camera 

From the view menu select CameraSave Camera command. 

Press OK button after you enter the name of the camera. 
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The system has no limits to the number of the camera and you can switch 

willfully.  

First Camera 

From the view menu select CameraFirst Camera command. The system will 

switch to the first camera view in the camera list. 

Last Camera 

From the view menu select CameraLast Camera command. The system will 

switch to the last camera in the camera list and return to perspective status. 

§9.4.11  Show Camera List 

From the view menu click Show Camera List command, the camera list 

dialogue box appears. 

This dialogue box will display all the cameras, and all of 

them have preview pictures. Every time you switch from a 

perspective view to a special view such as plane view, the 

system will automatically save the camera. 

Double click (continuously and rapidly click the left button 

twice) the camera preview picture that needs to be 

switched, and then the workplace will be switched to that 

camera. Right click this preview picture. Two options 

popup: the function of Show is the same as double clicking 

the left button; Remove can delete the current camera. 

The function of Redraw is to refresh the preview picture 

according to current scene. For example, the current 

scene has used radiosity and the camera preview picture 

set before radiosity can be updated to the effect achieved 

after using radiosity. 

§9.5 Products Library 

§9.5.1 Show Library 

From the Products Library menu select Show Library command. The 

following interface appears: 
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Introduction to the commands on the tool bar (from left to right)  

 

Attribute: System will show you the attribute of the model you selected. 

Sort: Order the model in Library area by name; 

Insert Model: Enter model status; 

Replace Model: Enter model replace status; 

       No Collision Check: Disable Collision Check function; 

 Collision Check: In Lnsert Mode, automatically detect existing model 

to prevent overlapping; 

Basic Operations of the Library 

 Insert the model: 

Open library, select  button on the tool bar; 

Select the model type in the directory area; 

Double click the needed model preview picture in the Library area; 

Move the mouse; the model will be automatically absorbed to the 

surface pointed by the mouse. Left click the position where the model 

will be placed. 

Directory area 

Tool Bar 

Library Area 



InteriCAD T5 User Manual 

 256 

 Replace the library model that already exists in the scene: 

Open library, select  button on the tool bar; 

Select the model type in the directory area; 

Double click the needed model preview picture; select the model that 

will be replaced. 

§9.5.2 Hide Library 

Click Hide Library from Products Library menu, or click  on the top right 

corner of library window. 

§9.5.3 Library Manager 

§9.5.3.1 Preparation 

§9.5.3.2 Prepare the Texture Files(JPG) 

Note: The requirement of JPG: seal less, color is even, and the size is at least 

400X400 pixels, recommending 800X800 pixels. 
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§9.5.3.3 Prepare the 3D Models 

Please see the example below. Users need to prepare 4 files for one model. 

They are respectively mrm, jpg, mod and _2d jpg files. xxx.Mrm and the 

preview picture (xxx.jpg) is a must. If you want to layout the models in 2D you 

have to prepare two other files, the xxx.mod and xxx_2D.jpg. And put these 

files all together in one folder.  
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§9.5.3.4 Create Catalog Tree in User Library. 

The system library cannot be edited. Users can only edit the user library. For 

example, Ergo shown in the picture below is the user library. 

Double click Mdbmanage.exe to open mdbmanage, and the photo below is the 

interface of mdbmanage: 

 

§9.5.3.5 Add a Directory 

To add subdirectory to the root or a directory, you can right click on it, and then 

select New Group. A pop-up dialog will show, and then input the name for the 

new driectory in the dialog box, then click OK. A new subdirectory is inserted. 
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§9.5.3.6 Move a Directory 

There are two ways to move a subdirectory to another directory. The first one is 

to drag-and-drop. The second one is to use the Move to function in right click 

menu. If there are already textures or models in the directory, the directory can 

not be move any more. In the latter part of this document, there are detailed 

instructions about right click menus. 

 
After we finish building the directory structure, we can start to add textures and 

models into the library. 
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§9.5.3.7 Add Textures 

Select a directory, then right click in the working area. Select Import texture 

 

Find the target pictures in dialog box. Then click OK. The number of the 

selected files is not limited. 
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After that, the texture files have been added into the library. 

 

When you select one of the textures, you can see the properties of that texture 

in the information bar or in the working area. You can double click the cells to 

edit the contents. 

Below are rules and formulas of each column of the working area: 

ID: It will create automatically, and the ID is exclusive and cannot be edited. 

Name: It can‟t be input over 50 bytes. The default name is the file name of the 

JPG file. 

Type: SN of the model. It can‟t be input over 50 bytes. The default name is the 

file name of the JPG file. 

Class: It is only used for models. So please disregard it. 

Brand: It can‟t be input over 50 bytes. 

Manufacturer: It can‟t be input over 50 bytes. 
Price: It can‟t be input over 50 bytes. 
Size: The height, length and width are meaningless for textures. They are only 
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used for models. So please disregard them in this section. 

§9.5.3.8 Add Models 

There are two ways to add models: One is Import Models (Single) the other is 

Import Models (Multi).  

§9.5.3.9 Add Models One by One 

When you select Import Models (Single) , a window will appear.  

 
Select Browse and then select the mrm file in the pop-up file dialog.  
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After you click Open in the file dialog, another dialog will show.  

 

In this dialog, users need to select a catalog for the model, for example, the 



InteriCAD T5 User Manual 

 264 

model is a sofa, or a chair. After selecting the model‟s catalog, you can see 

the ID is generated automatically and it won‟t be repeated. User can input 

more attributes for the models in the dialog box. 

 

§9.5.3.10 Add Multiple Models 

When you select Import Models (Multi), the file selection dialog box will appear, 

and the number of selected mrm files is not limited. 
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And the catalog selection dialog box will appear.  

 

After choosing the catalog, similar to adding texture, you can edit the attributes 
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of each model in working area by double click. 

 

Below are rules and formulas of each column of the working area: 

ID: It will create automatically, and the ID is exclusive, it won‟t be repeated. 

Name: It can‟t be input over 50 bytes.  
Type: SN of the model. It can‟t be input over 50 bytes. 
Class: The class of the model. When double click the cells of this column the 

catalog selection dialog box will appear and user can choose the type from the 

dialog box. 
Note: Models of different catalogs will have different layout methods. 

Brand: It can‟t be input over 50 bytes. 
Manufacturer: It can‟t be input over 50 bytes. 
Price: It can‟t be input over 50 bytes. 
Size: It can be divided into 3 parts: height, length and width, user can select 

these one by one according to the model. 

Double click any cell of working area, you can edit the content of the cell. And 

its corresponding property will change. 
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§9.5.3.11 Right Click Menu 

And you can see, there is a right click menu appears when you right click on 

any directory. 

§9.5.3.12 Right Click on the Root 

 

New Group: Create new subdirectory in this directory 
Sort: Show the group that under this directory: 

 

(Group ID is ID of this group in the .mdb file. 

Name is the name of the group that shows on the catalog tree. 

Sort Index is the order of the group that shows on the catalog tree, while 0 

means the first.) 

Rename: User can edit the name of the directory by this function. 
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§9.5.3.13 Right Click on Subdirectory 

 
Compared to the right click menu of root directory, there are 3 more items in 

that of subdirectory. They are Copy to… Move to… and Delete option. 

 

Copy to…: Copy the directory and all the subdirectories to another library. For 

example, copy one directory from the system library to user directory. Users 

are not allowed to copy directories to a same library, for example, copy a 

directory in user library to another directory of user library.  

Operations: After you click Copy to.. and choose the destination directory from 

the window below.  
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Move to…: Move the directory and all the subdirectory to another library. For 

example, move one directory from the system library to user directory. Users 

are not allowed to move directories to a same library, for example, move a 

directory in users library to another directory of users library.  

Operations: After you click Move to.., choose the destination directory from the 

window below. 

Delete: Delete the directory and all the subdirectory under this directory. 

§9.5.3.14 Right on an End Directory 
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Besides New Group ,Rename, Copy to… ,Move to… and Delete, you can see 

Import Model (Single) ,Import Mode l(Multi) and Import Texture. It means that 

you can import texture and models by right click the directory, too. 

§9.5.4 Library Backup 

Use this command to backup the library in system. 

Select Library Backup from Products Library. A Library Management dialog will 

pop up. 

§9.5.4.1 VR Library Management 

Backup 

Select a library from the directory and click Backup. A Browse for Folder dialog 

will pop up. Select a folder to save VR library, click Ok to confirm. The system 

will back up the selected library automatically. 

Restore 

Select a library from the directory and click Restore. A dialog will pop up to ask 
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you whether overwrite the library. Click Yes to confirm, click No to cancel.  

Merge 

Select a library from the directory and click Merge. Select an mdb from the 

pop-up dialog. The system will merge the mdb to the selected one 

automatically.  

 

CAD Library Management 

Backup 

Select a library from the directory and click Backup. A Browse for Folder dialog 

will pop up. Select a folder to save CAD library, click Ok to confirm. The system 

will back up the selected library automatically. 

Restore 

Select a library from the directory and click Restore. A dialog will pop up to ask 

you whether overwrite the library. Click Yes to confirm, click No to cancel.  

Merge 

Select a library from the directory and click Merge. Select an mdb from the 

pop-up dialog. The system will merge the mdb to the selected one 

automatically.  

§9.5.5 Import VR Block 

Use this command to import independent VR Block. 

1. Select Import VR Block from Products Library. 

2. Find the VR Block you wish to import in the popped up dialog. 

3. Click OK, and move cursor to the position you wish to insert the block. 

§9.5.6 Export Surface 

You can save your own block as importable VR block, and add to the library. 

There are two methods to export: export surface and export object. You can 

use this command to export specified surface as VR Block. 

1. Select Export Surface from Products Library. 

2. Select Snap On from Object menu, activate snap mode to select insert 

point. 
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3. Select the surface you wish to export, hold Shift to add more, right click to 

finish. 

 

4. Select insert point of VR Block. Move cursor in snap mode will capture 

nodes of objects, the nearest node to the cursor will be highlighted in 

yellow lines. Find the appropriate node, left click to set as insert point. 

5. Type in path and file name in the popped up save dialog, click OK to finish. 

§9.5.7 Export Object 

You can save your own block as importable VR block, and add to the library. 

There are two methods to export: export surface and export object. You can 

use this command to export specified objects as VR Block. 

1. Select Export Object from Products Library. 

2. Select Snap On from Object menu, activate snap mode to select insert 

point. 

3. Select the object you wish to export, hold Shift to add more, right click to 

finish. 

 

4. Select insert point of VR Block. Move cursor in snap mode will capture 
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nodes of objects, the nearest node to the cursor will be highlighted in 

yellow lines. Find the appropriate node, left click to set as insert point. 

5. Type in path and file name in the popped up save dialog, click OK to finish. 

§9.5.8 Renew VR Block 

Use this command to change attributes of VR block in the library. 

1. Select Renew VR Block from Products Library. 

2. Select modified block, a save dialog will pop up. You can handle blocks 

one at a time. 

3. The software will find the block‟s path in the library automatically. Click 

Save to finish. 

§9.5.9 Export Whole Scene 

Use this command to export all objects in the scene as a VR block. 

1. Select Export Whole Scene from Products Library. 

2. Select Snap On from Object menu, activate snap mode to select insert 

point. 

3. Select insert point of VR Block. Move cursor in snap mode will capture 

nodes of objects, the nearest node to the cursor will be highlighted in 

yellow lines. Find the appropriate node, left click to set as insert point. 

4. Type in path and file name in the popped up save dialog, click OK to finish. 

§9.5.10 Create Entity 

Select Create Entity from Products Library, and then a dialog shows as 

below: 
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The dialog consists of 3 parts: Directory structure, List view and Preview 

window.  

§9.5.10.1 Directory Structure 

Right click on an item of the directory structure, users could delete the item, 

modify the item or add a sub-item. 

§9.5.10.2 List View 

Load an existing entity: Left click on the icon in the List view, and then click 

Apply: InteriCAD T5 will load the group into 3D view. The models will move 

along with your cursor. Left click to confirm position. Objects loaded in the 

group will be treated as one object unless they are broken apart by Explode 

Entity function. 

List View 

Directory 

structure 

Preview 

Window 
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Add my entity: Left click Add button, and then input name of the group in the 

pop-up dialog. InteriCAD T5 will switch to 3D view. Select the objects, hold shift 

key and left click for multi-selection, right click to finish. 

             

§9.5.10.3 Preview Window 

By left clicking on the preview window you can enlarge the picture in a pop up 

window. 
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§9.5.11 Explode Entity 

Select Explode Entity from Products Library, and then left click the objects 

of a entity you have loaded. The entity will be broken apart into objects. 

§9.5.12 Clone Object 

1. Select Copy Object in the Products Library menu, it will pop up a dialog 

box: 

 

2. Click My Proposal, the file list will show preview of all the project files under 

the directory. Click the preview, the right window will show the panorama of 

the selected file. User now can walk virtually in the scene. 
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3. Functions of the 5 buttons: 

 ：Allow you to move freely, but you can not select an object. 

 ：Allow you to copy models into the scene. The available 

models are in green and the selected models are in red. Hold down 

Shift to select multi-objects. 

 ：Allow you to copy materials into the scene. The selected 

surface is in flashing red. Not support multi-selection. 

 ：Allow you to copy lighting elements into the scene. The 

available light sources are in green and the selected light sources are in 

red. Hold down Shift to select multi-objects. Multi-selection is not 

supported. 

 ：Select Object in the Object mode, turn to View mode to 
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move and copy the selected object to another place. 

 Detail information of three modes 

 

Object mode: No preview, but with model information. 

 

 

Material mode: With preview and configuration of the material.  

 

 

 

Lighting mode: No preview, but with lighting configuration. 

 

 

 ：To show and hide the preview and information. 

4. After selecting an object and click Apply, dialog box will be shut down and 

the plane turn into  

Copy model: move the plane to the position for the model, do the same 

operation as inserting library model. Right click to end. 

Copy material: Click the surface of the targeted object; repeat the operation 
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for different objects for the same material. Right click to end. 

Copy light source: Click the surface of the light source; repeat the operation 

for different lights for the same configuration. Right click to end. 

  

5. If you want to copy different object, please select Copy Object from the 

Products Library menu. 

Note: 

 The same as the other operation, material and light editing can be done 

after radiosity, but object editing needs to be done before radiosity.  

 In the object mode, select the object and press F12 will enable you to 

replace the object in the same dimensions.  

§9.5.13 Export Clone Object 

1.  Open a rendered VR scene, put camera to the right position. 

2. Click Products Library on the menu, select Export Clone Object. The 

default save path is: IntericadT5\vr\showroom\My Proposal 

 

3. Click Output button, it will be saved as a panorama file with record of the 

mrm files into the project file. 

§9.5.14 Furniture List 

Select Furniture List from Products Library. The system will automatically 

list all the products and generate the List. You can now check the price, 

size, quantity etc. 



InteriCAD T5 User Manual 

 280 

 

: Export the list to text format. In the popup dialogue, designate the 

location and input the file name. Then click OK. 

 

: Export the list to HTML format. In the popup dialogue, designate 

the location and input the file name. Then click Save. 
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: Export the list to excel format. In the popup dialogue, designate 

the location and input the file name.  If the list is more than one page, you 

can Then click Save. 

 

: Print out the list. It‟s better to set the printer before you try to print. 
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: Preview the printing result. 

 

: Detail settings of the list, including the printer setting. 
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: Erases the last change done to the list. 

: Reverse the undo command. 

: Delete the selected line. 

: Add a line to the last line. 

: Save the changed template. 

§9.6 Kitchen Design 

§9.6.1 Show Library 

This part mainly introduces how to perform the arrangement design of the 

kitchen cabinets and accessories such as base unit, wall unit, sink unit and 

cooking range. 
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Step: 

1. Click Kitchen Design  Show Library, 

2. The product dialogue box appears (shown in 

the right picture). You can change the width, 

depth, height and its locating method of the 

unit that will be arranged as requirements. 

Then click the Layout -> button or double 

click the product to start Layout. 

3. After you click the Layout button, move the 

mouse into the 3D room (or we can call it 

Drawing area). The system has intelligent 

location function. It will snap the cabinet to a 

proper location. When you find the cursor 

turn into an arrow, it means this location is 

proper. Now you can left click to locate the 

item. When the cabinet is interfering with doors or windows, the system will 

popup an error prompt. 

 

 Intelligent Location Function 

When locating the cabinet, the system will automatically find the proper 

location for the cabinet according to the size the cabinet, the position of 

door and window. When the cabinet is highlighted in green, it means you 

can left click the mouse to locate the cabinet.  

Align: When locating the cabinet, moving the mouse forward and backward 

will help you to align the cabinet with other objects in the room  

 

 Useful Key When Locating Cabinet 

1. Space Bar: when Layout the unit, the space bar has two functions: (1) 

pressing Space bar you can rotate the unit; (2) to those units that have 

several possible places, as shown in the figure below, by pressing 

space bar you can change the arrangement direction. 
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2. SHIFT: Cancel the snap function of this unit with other units except wall. 

Press SHIFT again to resume all the snap functions. 

3. CTRL: remove all the snap functions of the unit, which means the unit 

will not snap to any object. Press CTRL again to resume all the snap 

functions. 

 

 Arrangement of the kitchen cabinet unit when there is a corner of 

non-90 degrees 

There are two conditions of the non-90 degrees corner: less than 90 

degrees and more than 90 degrees. Next we will introduce their 

arrangement method separately. 

As shown in the figure, when select the Create worktop command, the 

system can find the corner automatically and deploy the worktop correctly. 

Other components such as the plinth can also be deployed automatically. 

 
 Filler panel 

When layout the cabinet, there are some places where we need to use 

the filler panel. Choose the filler panel from the kitchen library, you can 
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define the width of filler panel in order to fit the space.  

 Product Search 

The system provides the function of finding the product by using the 

code and the model. In the middle place of the Select product dialogue box, 

there is space to display the Code and Model. When the user selects 

different products, the code and model will be displayed here. User can 

also press the Find button command after input the code and model of the 

product. If the product meets the code and the model is found, the system 

will find the product automatically and place the cursor onto it. Otherwise, 

the message that prompts no such product will appear. The accurate query 

provided by the system now is the combination of Code and Model. If either 

of them is not available (not space), only the available one will be used as 

the query condition. 

 

 Quick Select of the Product 

For your convenience to select some frequently used products, the 

system provides the function of quick select of the product. When you 

select Quick Select command button from the Select Product menu, a 

popup menu appears, as shown in the figure below. This menu lists some 

frequently used products. When you select one product, for example the 

Nacelle, the system will automatically find out the nacelle product and 
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move the cursor onto it automatically to make known this product is 

selected.  

 

Select the last item of the popup menu Self-define shortcut, the Custom 

Shortcut dialogue box appears. You can customize the quick select items. 

After using Add, Modify, Delete, Move Up and Move Down commands, Ok 

button must be pressed so that the customized shortcuts will be valid.  

 

Add: Add one customized shortcut. After select Add command button, the 

User defines dialogue box appears. Input the name of the shortcut behind 

the Shortcut Name. 
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Select specific product category from the First Level Catalogue, Second 

Level Catalogue and Third Level Catalogue separately. Press OK and one 

customized shortcut is added. 

Modify: Modify the selected shortcut. The operation is similar to that of 

Add. 

Delete: Delete the selected shortcut. 

 Move up and Move down: Arrange the shortcuts according to the user‟s 

requirement. After select one shortcut, select the Move Up and Move Down 

command button to complete the new arrangement. 

 

 Modify the Size of Product 

The products within the system product library have the fixed width, 

depth and height. You can also modify size of selected unit in case of 

necessary. 

Step: 

1. Select the kitchen cabinet unit from the Select Product dialogue box; 

2. The width, depth and height of this product will be displayed in Select 

Product dialogue box. User can modify them as requirements. 

3. Select Layout to deploy the kitchen cabinet unit. And the unit size is 

the new size input by the user. 

 

 Locating Method of the Product 

The system provides total 19 product locating methods. For different 

product, there are one or several locating methods. First select one locating 

method then click Layout to layout the product. Below is detailed 

description of the 19 locating methods: 

1. On the ground: the bottom elevation of the product is 0 from the 
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ground. This locating method is suitable for dining chair, table, and freezer 

and so on.  

2. On toekick: the product will be located on the plinth. (The height of 

the plinth can be edited in SettingParameter setting.) This locating 

method is suitable for base unit, tall unit, island and so on.  

3. At wallunit elevation: the bottom elevation of the product will be the 

same as the bottom elevation of wall unit. (The bottom elevation of wall unit 

can be edited in Setting Parameter setting.). This locating method is 

suitable for wall-unit, extractor hood and so on  

4. On worktop: the product will be placed on the worktop. (The 

defaulted height of worktop is 850mm). This locating method is suitable for 

cup, dishes, and cattle and so on. When locating the product, you can also 

input the Elevation height. 

5. On worktop (by unit): the bottom elevation of the product is the same 

as the height of the selected worktop. When locating, select the unit that 

you want to put the product on, then the product will be put onto its worktop. 

E.g: cup and so on.  

6. In worktop (by unit): the upper surface of the product will be above 

the selected worktop. When locating, select the unit that you want to put the 

product. This locating method is suitable for items which are in the worktop. 

For example: sink, gas cooker and so on.  

7. Under worktop (by unit): the upper surface of the product equals the 

lower space of the Worktop of the selected unit. When locating, you need to 

select the unit in which the object will be installed. The product will be 

located under the worktop of the selected cupboard. 

8. Over selected object: when locating product, you need to select one 

object. The product will be deployed above this object automatically. For 

example, the cupboards above the half-height cupboard.  

9. Under Selected Object: when locating product, you need to select 

one object. The product will be deployed under this object automatically. 
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For example, the decoration cupboard under the wall unit. 

10. At Special Height: when locating product, you need to select the 

position point. The distance between the ground and the bottom of the 

product equals the specified height. When deploy, you can also input the 

Bottom elevation 

11. At Special Height (by unit): When locating product, you need to 

select the cupboard unit and the location where the product will be placed 

in the cupboard. The distance between the ground and the bottom of the 

product equals the specified height. When deploy, you can also input the 

Bottom elevation 

12. Under Special Height: when locating product, you need to select the 

position point. The distance between the ground and the top of the product 

equals the specified height. When deploy, you can also input the Bottom 

elevation. 

13. Inside Electrical Appliance: when locating product, you need to 

select the diaphragm or the baseboard to place the object and the product 

will be deployed on the selected diaphragm or the baseboard. For example, 

the electric oven, etc. 

14. Free Orientation (by surface): when locating product, you need to 

select the position point. One specific installation surface will automatically 

snap with one surface of another object in the scene. And the product will 

automatically absorb on this surface. For example, the wall map and the 

decoration plant, etc. 

15. Auto fit size: when locating product, you need to select the door 

panel which is parallel to the product. This is suitable for „Roster‟ and so on.  

16. Over (under) Shelf board selected: When locating product, select 

the shelf board that you want to put the product on, the product will be 

located on the selected shelf board.  

17. Shelf board: When locating, select the shelf board which are on the 

right side of the object. Then input the number of height. 
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18. Special position on wall: when locating product, select one piece of 

wall. In the pop-up dialogue box, input the reference point and distance 

from the product to the wall. Then click Finish. Then this product will be 

located on wall.  

 

19. Special position on floor: when locating product, select one piece of 

wall. In the popup dialogue box, input the reference point, distance to wall 

and elevation. Then click Finish. The product will be put on the location.  

 

For every product in the library, there is one defaulted locating method. 

When locating certain product, you can change its locating method.  

 

 How to Deal when the Cupboard Unit Encounters with the Pillar 

When the deployed cupboard unit encounters with the pillar of the room, 

the system will automatically snap the cupboard to the suitable place 

according to the size and location of the pillar. There are two conditions: 

1. The pillar is smaller than the cupboard: shown at the left side of the 

figure below, the cupboard can be arranged near one side of the pillar 

and the pillar can be seen as a common wall; besides, the cupboard 

can be arranged to the corner. Under this condition, the view must be 

switched to the one that can see the location of the corner (such as the 

top view). When arrange the auto-installed worktop and the 
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waterproofing panel, it will be arrange along the wall. 

2. The pillar is bigger than the cupboard: shown in the right side of the 

figure below, the pillar is arranged along the wall and the pillar can be 

seen as a common wall. 

 

 

§9.6.2 Close Library 

Click Kitchen Design  Close Library, user can close the kitchen library. 

§9.6.3 Unit Redrop 

Command: Kitchen DesignUnit Redrop 

Use Unit Redrop to move a cabinet unit to a place next to another object, e.g. a 

wall or another unit. Use your mouse to locate the unit you want to move. There 

will be a green shadow the place is suitable for that unit. 

§9.6.4 Change Size 

Free 

Change the width, depth and height of an object based on 3 bases. 

Basic operations: 

1. Select Kitchen DesignChange Size 

2. Choose object you want to modify 

3. The system will pop up Change Size dialog box 
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4. Change Size by modifying the values in the dialog box; choose bases 

to change size from different direction. 

5. Click OK the end the setup. 

§9.6.5 Create Worktop 

After a floor cupboard is set, select Kitchen DesignCreate Worktop, then the 

system will automatically search for all the floor cupboards and install a 

Worktop on them. The system can automatically generate a full block of 

Worktop on the continually arranged floor cupboards that have the same depth.  

§9.6.6 Create Worktop Manually 

1. Select Kitchen DesignCreate Worktop Manually 
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System will automatically pop up Draw Polygon Worktop dialog box. 

Top view of working area is on the left part. The right side is the command 

bar. Walls are showed in white lines while cabinets are in yellow. User can 

finish the worktop design by clicking the left mouse in the working area. 

Point snap setting: 

                 

    Show Base Unit: Show base unit in the working area. 

    Show Wall Unit: Show wall unit in the working area. 

    Show Tall Unit: Show tall unit in the working area. 

  Cabinet Side offset: Draw offset line to extend or cut worktop edge. 

Operations are as follows: 

 

a. Click Offset of cabinet side and then the cursor will become a small 

white pane. 
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b. Select the broken line as the base line. 

 

c. Then system will pop up Offset dialog box, and there is a green arrow 

on the chosen line. Input the offset value in the box while using minus value 

to offset in opposite direction. Intersect with wall is to control the connection 

between offset line and wall.  

d. Click OK, then the generated offset line will be showed in blue.                        

1. Point setting: 

                   

   Snap: Control the point snap function which will be showed in green 

pane.            

 

    Orthomode: Control ortho function when draw a line. 
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    Point offset: After defined all the points, system will pop up Point 

offset dialog box. The chosen point will be set as (0,0). 

 

 

2. Line Mode 

Line: To draw a line. 

 

 

 

3.  Arc: To draw an arc. 

                   

There are two ways to draw an arc.           

a. Select the first point and then the central point to define the radius 

of the arc. Draw an arc clockwise or anticlockwise.  

Clockwise: 
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Anticlockwise: 

                     

          

b. Select two points to define an arc: 

                 

             

4.  Define coordinate: Define the first point (0, 0) and then input coordinate to 

define the next point. 
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5.  Back: Cancel current operation and return to the last one. 

   Redo: Return to the last operation. 

   Clear: Delete all the lines except offset line. 

   Close: Connect the nearest two points. 

 

6. OK: Turn to next step. 

Cancel: Cancel the current operation and exit. 

 

 

   User set the elevation and thickness for the worktop and click OK to 

finish. 

Besides automatically generating Worktop, the system also allows the user to 

manually generate it.  

 

§9.6.7 Create Plinth 

After finished the base unit layout, we can install the plinth now. Select Kitchen 

DesignCreate Plinth menu, then the system will automatically search for all 

the base unit and install plinth at the bottom of them. As the same as the 

Create Worktop, the system can take the continually arranged base unit as a 

group to deal with, which will generate a complete piece of Plinth for the 

combined parts. The height of the Plinth is that one set by the Parameter 

setting command from the Settings menu 

Similarly, if creating a Plinth with the Manually generate Plinth command before 

auto creating a Plinth, a warn dialogue box will pop up and ask user whether to 

delete the manually generated Plinth when auto generating a Plinth. 
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§9.6.8 Create Pelmet 

§9.6.8.1 Style of Pelmet 

Select the Kitchen DesignParameter setting menu. In the popup Parameter 

Setting dialogue box, you can set the required style of Pelmet. 

§9.6.8.2 Auto Create Pelmet 

After selecting the command, the system will search for all the installed 

wall-cupboards and automatically arrange the selected style of Pelmet on them 

according to their relevant position and size, etc. 

Basic operations: 

1. Select the Kitchen DesignCreate Pelmet menu; 

2. The system will automatically install the Pelmet on all the wall units. 

§9.6.9 Create Cornice 

§9.6.9.1 Style of the Cornice 

Select the Kitchen DesignParameter Settings menu. In the pop-up 

Parameter Settings dialogue box, you can select the style of the Cornice 

required by the user. 

§9.6.9.2 Auto Create Cornice  

If this command is applied, the system will first search all the installed 

wall-cupboards, and then automatically install the selected style of Cornice 

above them according to their relative positions and sizes, etc. 

Basic operations: 

1. Select the Kitchen DesignCreate Cornice menu; 

2. The system will automatically install the Cornice above all the wall units. 
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§9.6.10  Change Handle 

Change all doors and drawers of all cabinet units. 

Basic operations: 

1. Select Kitchen Design Change Handle 

2. It will pop up a handle dialog box, set up all the parameter. 

 

 

3. Select OK to refresh all the handles in the 3D scene. 

§9.6.11  General Panel 

The system provides the function of making a simple panel. Select Kitchen 

Design General Panel and the Panel modeling dialogue box will pop up in 

which you can input parameters of a panel, such as length, width, thickness, 

etc. Select Horizontal or Vertical and then click the Ok button. According to the 

system prompt, select the corner point position, and then a panel will be 

generated. 
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§9.6.12  Shelves Panel 

This command enables you to generate a shelves panel between two 

vertical Panels.  

Basic operations: 

1. Select Kitchen Design Shelves Panel;  

2. According to the prompt of system command line, select the left panel, 

right panel and back panel (optional) in order, and then 

press Enter or right click to end the selection; 

3. The system will pop up a dialogue box in which you can set the shape 

of the panel and other parameters. Input the information, 

and click OK to create the panel.  
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4. Left click to set the base point of the panel, the panel will be created.  

§9.6.13  Dividing Panel 

This command enables you to generate a vertical panel between two horizontal 

panels  

Basic operations: 

1. Select Kitchen Design Dividing Panel, 

2. According to the prompt of system command line, select the left panel, right 

panel and back panel (optional) in order, and then right click or press Enter;  

3. The system will pop up a dialogue box in which you can the panel 

parameters. Input the information, and click OK to create the panel.  

§9.6.14  Parameter Settings 

Select Kitchen Design Parameter Settings. 

Tab Handle: For changing the handles. 
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Tab Worktop: For setting the worktop.  

 

In this section, user can change the thickness and style of the worktop. 

In the red frame, there are two new functions. One is to set the distance of 

cabinet back to the wall. For example, when we set the distance to be 300mm, 

if the cabinet back is 150mm far from the wall, the worktop will still be created 

to attachment to the wall. 

The other is to create worktop that will have distance from other objects, 

such as wall, column and cabinet. Here we set it to be 7. That means the 

distance between worktop and other objects are 11. 
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Tab Lines: Setting the plinth, pelmet and cornice. 
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Tab Others: User can set the default elevation of the wall cabinet. 

            Here we have added three new functions. One is to set the 

dynamic orientation. The setting allows user to align the cabinet with their front 

side or back side when putting the cabinets to the scene. 

            Second one is to set the filler profile. Some of the fillers will have 

profile on them. But if filler is too small, it will not have profile. So, here allow the 

user to set the width of filler for creating the profile. 

            The last one is a tips function. For example, if user select To 

design water position after fixing sink, the system will remind user  to set the 

water position when he/she have lay-out a sink into the scene. 
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§9.6.15 Set Current Room 

InteriCAD T5 can import more than one room to VR. So user must use Select 

Current Room function to select the room for designing.  

Select Set Current Room from Kitchen Design, and then in the pop-up dialogue 

left click to select a room to design the cabinet. Also, user can rename the 

room. 
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§9.7 Object 

§9.7.1 Single Selection 

Function: Select mouse clicked objects only. 

Select Single Selection from Object. And then we could select objects one by 

one. 

§9.7.2 Box Selection 

Function: Select all objects contained in the selection window. 

Select Box Selection from Object. Press Shift and left click to select different 

objects. In this way, all objects contained in the selection window will be 

selected. 

§9.7.3 Surface Repair 

After entering InteriCAD VR, all the model faces 

will be transformed to single face to decrease 

data amount. So-called single face is: Each face 

only deals with the face of one orientation, and 

we call the face of this orientation as Front face. 

When we face the front face, we can see it. If we 

walk to the back of this face, the system will not 

deal with the orientation of that face and we cannot see it any more. When the 

system load a model, it will automatically deal with the orientation of the single 

face, but sometimes the orientations of very few faces are not right. This makes 

the model seems to be transparent or lack of some faces. When this happens, 

you need to use surface orientation to adjust. 

Single click  . It provides three tools: 

Options: 

1. Reverse connected face：Directly single click the reverse face using left 
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button. The system will forcedly adjust the orientation 

of this surface and all the connected surfaces to the 

camera. This option is especially suitable for wood 

line and screen. 

2. Check connected face：The function and operation is basically same as 

the option above. But the option above may cause 

some problems when the model has connection 

errors: one surface is adjusted properly but another 

surface that has right orientation is adjusted to wrong. 

When this happens, you can use this option to solve 

the problem. 

3. Scan at viewpoint ：Scan the whole scene automatically using the 

current position as the center, so that the orientation 

of every face is in the direction of center. The faces 

that have been sheltered completely or partially 

cannot be adjusted. 

 

Recommendation: you can first adjust the front face, back face and material 

of common 3D model, then save the InteriCAD VR block, finally save it to the 

InteriCAD VR library. 

§9.7.4 Align Object 

You can align any objects in Render, arrange and combine objects easily. 

Basic operations: 

1. Select Align from Object menu, as shown below: 
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2. Click Move Object button to select the object you wish to move, click 

Target Object to select reference object. 

3. Select different modes of align. The software provides three modes: 

 Use coordinates and object surface as orientation. 

 Use object outline as orientation. 

 Use moved distance as orientation. 

4. Choose different align mode to see instant change of object position. 

5. Click Apply to finish. 

§9.7.5 Snap On 

Select Snap On from Object menu. Snap mode will be activated. 

§9.7.6 Edit Object 
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Array 

Array objects on x, y, z axes according to 

pre-specified rules. There are linear array and 

rectangle array. 

Basic operations: 

1. Select Array from Object menu, a dialog will pop 

up as shown right: 

2. Click Select Object to select the object you wish 

to array. 

3. Enter value in Relative Second Point for distance 

between original object and relative object on x, y, 

z axes. This decides the direction and space 

between objects of the array. Enter value in 

Number column for the number of objects on the array. 

4. Click preview, as shown below. 

     

5. Click Apply when you‟re satisfied with the result. 

Note: 

If you enter value for either Second Point or Third Point, the software will 

perform linear array; if you enter value for both, it will perform rectangle 

array. 

 

Copy Object Along Line 
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You can control the distance between copied 

object and the origin, and copy multiple objects in 

a single operation. 

Basic operations: 

1. Select Copy Object Along Line from Object 

menu, a dialog will pop up as shown right: 

2. Click Select Object to select the object you 

wish to copy. 

3. Enter value in Relative Second Point for 

distance between original object and relative 

object on x, y, z axes. This decides the 

direction and space between objects of the 

copy. Enter value in Number column for the 

number of objects you wish to copy (including the origin). 

4. Click preview, as shown below: 

 

5. Click Apply to finish. 

Move the Object 

Basic operations: 

1. From the Object menu select Edit Object, and then Move. 

2. Left click the object that will be edited. After selection, right click to confirm 

the selection. This selection operation is the same as that of ACAD. 

3. Left click one point as the move base point or start point. 

4. Move the mouse and you can see the object dynamically moves following 
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the mouse. Left click to confirm. 

 

Rotate the Object 

Basic operations: 

 From the Object menu select Edit Object, and then Rotate. 

 Left click the object that will be edited and right click to confirm the 

selection.  

 Use the left button to single click one point as the rotate center point. 

 Move the mouse and you can see the object dynamically rotates 

following the mouse. Press the left button to confirm. 

 

Scale the Object 

Basic operations: 

1. From the Object menu select Edit object, and then 

Scale. 

2. Click the object that will be edited using the left button 

and use the right button to confirm the selection.  

3. Use the left button to single click one point as the 

scale base point and single click the other point as the 

scale reference point. 

4. Move the mouse and you can see the object 

dynamically scales following the mouse. Press the left 

button to confirm. 

 

Mirror the Object 

Basic operations: 

1. From the Object menu select Edit Object, and then 

Mirror. 

2. Click the object that will be edited using the left button 

and use the right button to confirm the selection. 

3. Use the left button to single click one point as the 
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first point of mirror center line and single click another point again as the 

other point of mirror center line. 

 

Copy the Object 

Basic operations: 

1. From the Object menu select Edit Object, and then Copy; or from 

Object menu select Copy Object. 

2. Click the object that will be edited using the left button and use the right 

button to confirm the selection.  

3. Use the left button to single click one point as the copy base point, and 

then move the mouse to an appropriate position. Left click to finish. 

 

Delete the Object 

Basic operations: 

1. From the Object menu select Edit Object, and then Delete; or from 

Object menu select Delete Object. 

2. Click the object that will be edited using the left button and use the right 

button to confirm the selection.  

3. A dialogue box appears and asks you whether to delete. Press Y to 

finish. 

§9.7.7 Edit Surface 

Move Surface 

Basic operations: 

1. From the Object menu select Edit Surface, and then Move. 

2. Left click the surface that will be edited. After selection, right click to 

confirm the selection. This selection operation is the same as that of 

ACAD. 

3. Left click one point as the move base point or start point. 

4. Move the mouse and you can see the surface dynamically moves 
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following the mouse. Left click to confirm. 

 

Rotate Surface 

Basic operations: 

1. From the Object menu select Edit Surface, and then Rotate. 

2. Left click the object that will be edited and right click to confirm the 

selection.  

3. Use the left button to single click one point as the rotate center point. 

4. Move the mouse and you can see the surface dynamically rotates 

following the mouse. Press the left button to confirm. 

 

Scale Surface 

Basic operations: 

1. From the Object menu select Edit Surface, and then Scale. 

2. Click the object that will be edited using the left button and use the right 

button to confirm the selection.  

3. Use the left button to single click one point as the scale base point and 

single click the other point as the scale reference point. 

4. Move the mouse and you can see the surface dynamically scales 

following the mouse. Press the left button to confirm. 

 

Mirror Surface 

Basic operations: 

1. From the Object menu select Edit Surface, and then Mirror. 

2. Click the object that will be edited using the left button and use the right 

button to confirm the selection. 

3. Use the left button to single click one point as the first point of mirror 

center line and single click another point again as the other point of 

mirror center line. 

 

Copy Surface 
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Basic operations: 

1. From the Object menu select Edit Surface, and then Copy. 

2. Click the object that will be edited using the left button and use the right 

button to confirm the selection.  

3. Use the left button to single click one point as the copy base point, and 

then move the mouse to an appropriate position. Left click to finish. 

 

Delete Surface 

Basic operations: 

1. From the Object menu select Edit Surface, and then Delete. 

2. Click the object that will be edited using the left button and use the right 

button to confirm the selection.  

3. A dialogue box appears and asks you whether to delete. Press Y to 

finish. 

 

§9.7.8 Detach 

Detach Coplane Surface: 

 From the Object menu select Detach, and then Coplane Surface. 

 Click the coplane surface that will be detached using the left button. Press 

Enter to confirm after selection. 

Detach Patch: 

 From the Object menu select Detach, and then Patch. 

 Click the patch that will be detached using the left button. Hold Shift to add 

more. Press Enter to confirm. 

§9.7.9 Measure Distance 

 Select Measure Distance from Object. 

 Left click to select the first point, move cursor to another point and left click. 
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The command window will show the distance between these two points. 

§9.7.10  Distance from Object to Wall 

 Select Distance from Object to Wall from Object. 

 According the prompt in the command window, select the object needed to 

be queried. The distance from the object to wall will be displayed in blue.  

 Select another object needed to be queried, right click to finish. 

 

§9.7.11  Distance between Object 

 Select Distance between Object from Object. 

 Select the based object according the prompt in the command window. 

Select another object, and the distance between the based object and the 

second object will be displayed in blue.  

 Select the third object, and the distance between the based object and the 

third object will be displayed in blue. Right click to finish. 

§9.7.12  Nearest Distance 

 Select Nearest Distance from Object. 

 Select the object needed to be queried according the prompt in the 

command window. 

 Select another object needed to be queried, right click to finish. 

§9.7.13  Accurate Edit 

 Select Accurate Edit from Object, a dialogue box will appear as shown on 

the right. 

 The default operation is Move. Click the object you want to edit. Take the 

double-seat sofa below as an example, we can see the sofa displayed in 

green wireframe is selected, and three axes are in green, blue and red. 
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 Now input value in the edit panel, the object will move 

accurately. For example, enter 1000 for x (green) means the 

object moves 1000mm in positive direction on green axis. 

The object will move simultaneously as you input the value. 

Remember to click Apply button on the panel after your 

adjustment, otherwise it won‟t be saved. (Note: You cannot 

use Reset button to cancel your changes after you click 

Apply.) Also, you can use mouse to drag the object. Move 

the cursor to the yellow square on the axis; it will become a 

blinking yellow cross. Hold left key of your mouse and drag, the object will 

move along the corresponding axis. (If you drag the yellow square at the 

origin point, the object will move along the plane containing the green axis 

and blue axis.) 

 Click Rotate button in the Edit dialogue box; or right click in workplace, 

select Rotate in the menu.  

                                   

 A red circle indicates the object‟s rotation. You can enter value in the edit 

panel, or drag yellow points on the red circle to rotate. 
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 Press space bar to switch rotating axis, as shown below. Drag the yellow 

origin point to change rotation center. When rotation is done, click Apply to 

save. 

 

  Click Size button in the 

Edit dialogue box; or 

right click and select 

Scale, a red rectangle 

will appear. You can 

input values in the panel 

for your desired size, or 

drag yellow squares on 

the red rectangle to do 

instant scaling.  

Note: When you change 
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scale by inputting values in the panel, the scaling center is located at the 

bottom center and you can only change the whole scale of the furniture;  

when you change scale by dragging with the mouse, you can set the 

scaling center to any point and change scale of any specify part of the 

furniture. Besides that, the yellow square on the corners can be dragged 

along two axes while those at the middle of lines can only be dragged along 

one axis. While activating Keep Proportion, the size of the object can only 

be changed in proportion. 

 Press space bar to switch scaling rectangle. Click Apply to finish scaling. 

 Click Mirror button in the Edit dialogue box or right click on the object to 

select, the rectangle will disappear. There are 3 options under this mode 

and you can mirror it along X, Y, Z axis. 

 

 

     x axis mirror                        y axis mirror                   

z axis mirror  
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There are two methods to select objects in VR: Single Selection and Window 

Selection。 

 Single Selection is the default select mode. Hold Shift to add more. Only 

clicked objects will be selected in this mode. 

 You can select scattered objects by Window Selection. The sofa below 

was exploded in modeling before import; every cushion is an independent 

object in VR. 

 

First of all, select Window Selection from Object menu. Then choose  

button from tool bar. 

Select one of the sofa‟s 

armrests, and hold Shift 

to select backrest on the 

other side. The software 

will automatically use one 

container to highlight the 

two selected objects, as shown below. You can easily select the whole sofa by 

this way. 

 

Note: if there is other 

objects that you do not 
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wish to select in window selection, switch back to Single Selection from Object 

menu, hold Shift and left click to deselect them one by one. 

§9.7.14  Clear Selection 

Select Clear Selection from Object, All the existing selection will be cleared. 

§9.7.15  Object Display 

You can hide the object under InteriCAD VR or use black wireframe to 

display. The hidden object still functions during radiosity calculation. The 

hidden object will not be displayed during raytrace calculation. 

Basic Operations: 

Single click on the object display button .  

1. A dialogue box appears. Left click on the object 

that will be processed. 

2. There are two modes to hide or show objects. One 

is Select Object and the other is Select Surface.  

3. While using Box command, the selected object will 

be shown in wireframe. Hold Shift key to do multi 

selection.  

4. Press Hide button and select the object or surface 

you want to hide. Hold Shift key to do multi 

selection. 

The object that is hidden or displayed in wireframe can be displayed in 

normal form using two methods: 

1. Single click on the Show All button to show all the objects that are 

hidden. 

2. If you just want to show one or two objects, you need to activate Select 

Hidden option first, and then single click on the position of the object. The 

selected object will be showed in green. Right click to confirm your 

selection. 
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Note: You must activate Select Hidden option when you want to show the 

hidden or wireframe objects. Otherwise you will not be able to select them. 

§9.7.16  Hide Unselected 

Select Hide Unselected from object menu, click to select the object you don‟t 

want to hide, right click to confirm. 

§9.7.17  Hide Object 

Select Hide Object from object menu, click to select the objects you want to 

hide, right click to confirm. 

§9.7.18  Hide Surface 

Select Hide Surface from object menu, click to select the surface you want to 

hide, right click to confirm. 

§9.7.19  Show All 

Select Show All from object menu, and all hidden objects will be shown. 

§9.8 Material 

The material information of BtoCAD can all be loaded into InteriCAD VR. 

BtoCAD cannot set some special materials, such as stencil texture map, 

transparency map, etc. We can easily change the model material in InteriCAD 

VR, and use suitable material from the library to assign to the model directly. 

Also, the diffuse reflection texture maps of all the materials can be displayed 

immediately. All the operations are simple and visual. So we recommend that 

you don‟t need to do material operation under modeling interface since all the 

corresponding operations can be done under InteriCAD VR. This chapter 

introduces how to process materials under InteriCAD VR. 

 

A. Introduce the basic composition elements of material, such as color, texture 
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map, etc. 

B. Basic operations of material, such as build new material, assign material; 

edit color and texture map, etc. 

C. The making of common materials and special materials 

D. Intelligent Match-color  

 

Basic Feature Parameters of Material 

All the natural matters have some basic attributes. For example, the green 

plate glass has three attributes: First, it is green; second, it has mirror reflection 

and third, it is transparent. And smooth marble has two attributes, marble 

pattern and mirror reflection. 

§9.8.1 Material Editor 

Material Editor makes several labels according to the attributes of object: 

 

Single click , and the material editor appears. Shown as below: 

 

§9.8.1.1 Basic Label 

Name: the name of the current material. You can enter a name, e.g. 

floor. It enables you to conveniently manage the material. 

Type: Classify different types of materials according to their 
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different attributes in the physical world. For example, if you 

select Glass, the material will have attributes such as 

transparent and mirror. This option is intelligent and 

convenient. In most cases, you only need to select different 

types if you want to change the material attribute. 

Transmission: This is a material attribute. If light shoots to the front side 

of an object, it will through the object and generate diffuse 

reflection. If you see from the backside, the object is alight.  

The most typical example is the material of lampshade. Value 

0 indicates that the object is nontransparent; Value 1 

indicates that the object is completely transparent.  

Reflection: When doing radiosity calculation, this parameter controls how 

much luminous energy will be reflected by the material. To a 

pure white material, value 0.8 means 80% luminous energy 

will continuously be diffuse reflected. You should be 

experienced to use this parameter. Usually this parameter 

needs no adjustment. 

Map Size: This parameter can re-adjust the value of the auto-axis 

texture map coordinate.  

(refer to next section for texture map coordinate). 

§9.8.1.2 Color Label 

 

RGB: Tone color using the Red, Green and Blue system. This 

color means the diffuse reflection color of the material 
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when there is no color texture map. 

HSV:   Use the Hue, Saturation and Value system for toning. 

Color Blending: In the physical world, the reflection light of different 

materials is also different. For example, the red paper will 

make the white wall around it become red. But to a 

smooth red marble, the red saturation of the wall around 

is much lower than that made by the red paper. This 

parameter can be used to control the color saturation of 

the reflection light. If the value is 1, the color saturation of 

the reflection light is the same as that of the material. If 

the value is 0.5, the color saturation of the reflection light 

is only half of that of the material. If the value is 0, the 

color saturation of the reflection light is 0, which means it 

is neutral color: white. 

Brightness: After using radiosity, this parameter can control the 

brightness of the texture mapping. For example, if the 

texture is red, and its saturation is high but the brightness 

is small, this texture will appear to be dark red. But if you 

give this material strong light, it will display the bright red. 

You can use this parameter to make this texture display 

its original dark red. The value can be 0 to infinite. Value 

1 means normal display and values above 1 will increase 

the brightness of the texture map. Value 0 means the 

texture is completely dark. And this parameter can be 

applied to pure color material. For example, you can set 

the texture brightness of the white wash basin to 1.3. 

After using raytrace, this white wash basin will appear to 

be more bright and limpid. 

Texture: Use an image file to the object, e.g. marble material. 

This texture supports file-dragging operation. It currently 

supports three image file format: jpg, bmp and tif. 

§9.8.1.3 Reflection Label 
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Reflection: It can be viewed in the mirror that it reflects other objects. 

This feature is called mirror reflection. Value 1 means 

pure mirror and value 0 means it has no reflection 

feature. 

Smoothness: It means the smoothness level of an object surface. This 

parameter is only valid when the reflection level is not 0. 

It is used to make the effect of diffuse reflection. Usually 

the value is from 0.1 to 0.4. In default setting, the value 

has connection with Gloss and Gloss Size. To deactivate 

can do separate setting. 

Gloss: Used to adjust the reflection intensity of specula material. 

The larger the value, the stronger the reflection. 

Gloss Size: Used to adjust the reflection scope. The larger the value, 

the wider the scope. 

Texture: Use texture mapping to control the reflection area. You 

can create some special effect and we will give examples 

later. 

§9.8.1.4 Transparency Label 
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Transparency: The feature that you can see objects behind glass is 

called transparency. Use texture map to control 

transparency. You can make some special effects with it, 

and in the following we will illustrate that. 

Refraction: Transparent objects, for example, magnifier, can produce 

ray refraction. Some thicker glass may produce unreal 

color. Refraction settings include red, green and blue. 

Usually default value is 1. 

Also, we can make some special effects by using stencil, bump, emit and 

wave labels. In the following we will respectively illustrate them. 

 

Basic operations for material processing 

Basic operations are shown in the following: 

1．Choose the existing material on the model, then change its color and apply 

to other models 

 Click , Material Editor appears. 

 Here the default Select button is activated, and the mouse turns 

to a sucker shape. Left click to distill the material used by the 

model at the mouse position.  

 Switch to Color label in the Material Editor, then move the color 

slider and you can see the changing color of objects.  

Note:  

1. Only pure color materials can be changed color, while texture 
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materials cannot.  

2. All models using this material will change with it. 

 You can move the mouse when editing material. Click Move at 

the bottom of the dialogue box, then you can move. 

 Click Apply, then the mouse changes to an oblique arrow. That 

means the current material will be applied to the other models. 

 

2．Create a new material and apply it to other objects. 

 Click the Select item in the material tool bar to distill the objects‟ 

material.  

 Switch to Basic label in the Material Editor. Click New button, and 

input a new name. Click OK. 

 

 Click Apply item in the material tool bar, and apply this new 

material to objects. 

 

3．Set color texture mapping for material. There are two methods: 

Method 1: 

 Click Select button, and then 

select object‟s surface and pick 

up all materials from that object.  

 Switch to Color label, and click 

Texture button. 

 The Mapping dialogue box appears.  

 Click Browse, and select the image file in relevant directory. Then 

click Ok 

Method 2: 
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 Open a image browser by WINDOWS Explorer 

 Select the image 

 Drag and drop the selected image to object‟s surface, and then the 

material will be automatically changed.  

Conclusion: 

Editing and applying of material is very simple. 

 The first step is to click Material Editor. 

 The second step is to choose the required material. 

 The third step is to switch to corresponding label and modify relevant 

parameters. 

 The forth step is to apply this material to other object‟s surface. 

 

Common materials and special materials edit 

1．Common materials edit 

There are some common materials in real life such as glass, metal, 

wood, plastic and leather, etc. these materials have their own typical 

features. For example, glass is transparent and can be used to mirror. 

In the Material Editor dialogue box these objects have been initially 

classified. The editor is an easy-to-use tool as long as you select 

material type from it, the system will automatically set detailed 

parameters for that material. For example, if you select glass, then its 

reflection is 0.9, transparency 0.8 and color transmission 0.6. 

 

So, you can use this category to directly adjust common materials, and then 

you only need to set the material‟s color and color texture mapping.    
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2．Special materials edit 

 Transparent material 

Its feature: if light shoots to the front side of object, it will through the 

object and generate diffuse reflection on the object‟s backside. If you 

see from the backside, the object is alight. Value 0 indicates that the 

object is nontransparent; Value 1 indicates that the object is 

completely transparent. This material usually is used in lampshade, 

lamp-box surface, sunlit window screen and ground glass with lamp 

hidden in, etc. 

 

The edit method is very simple, and you only need to set an 

appropriate value for transparency in the Material Editor. 

      

Transparent material‟s lamp-box 

 

 Reflection texture mapping 

Reflection texture mapping is a kind of black and white picture, whose 

supporting formats include JPG, BMP and TIF. It requires the black 
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part of the picture be pure black, while the white part be pure white. 

It can use the black and white picture to control surface reflection area. 

The black part cannot reflect light, while the white part can reflect light 

according to reflection parameter setting. For example, suppose to 

make an engraved mirror. The graved part of mirror cannot reflect 

light, while other parts without pattern can normally reflect light. 

Reflection texture map can easily realize the function. 

Basic operations: 

1． Open the Material Editor. 

2． Switch to Reflection label. If you want to make pure mirror, 

you can set the reflection to 1. (Note that if you want to use 

reflection texture mapping, the reflection must not be 0, 

otherwise reflection texture mapping has no effect). 

3． Click the Texture button of reflection texture mapping. 

 

4． Select the required black and white picture by browsing. 

5． Function of Inverse: the system makes an inversion process 

to the black and white picture, that is, interchanges white color 

and black color. It results that original reflection area cannot 

reflect any more, while original non-reflection area can reflect 

now. 
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Effect of graved mirror 

 Transparency texture mapping 

Transparency texture mapping uses a pattern file to control the 

transparency of different areas of object surface. First the system 

turns this picture to a black and white one, among which the pure 

black area is shown using default transparency, while the pure white 

area is completely nontransparent. The gray level between pure black 

and pure white is represented by transparency grade. That is, we can 

make a glass from completely transparent to completely 

nontransparent. 

Basic operations: 

1． Open the Material Editor. 

2． Switch to Transparency label. If you want to make pure 

transparent material, you can set the transparency to 1. (Note 

that if you want to use transparency texture map, the 

transparency must not be 0, otherwise it has no effect). 

3． Click the Texture button of transparency texture map. 



InteriCAD T5 User Manual 

 333 

  

4．Select the required black and white picture by browsing. 

Function of Inversion: the system makes an inversion process of 

gray level. 

 

 Stencil texture map 

Stencil texture mapping is similar to reflection texture mapping. You 

need a color texture picture and its according black&white picture. For 

black & white picture, it is also a kind of black and white picture, which 

supporting formats include JPG, BMP and TIF. It requires the black 

part of the picture be pure black, while the white part is pure white. 

It can use the black and white pattern to control whether the object 

surface will be displayed or not. The black part will be displayed 

normally, while the white part will disappear completely. Usually you 

can combine texture mapping with color and stencil texture mapping 

to process some complex models, for example, plant, handrail and 

human, etc. Now we will make a plant in the following.  

Basic operations: 

1． Open the Material Editor. 

2． Switch to Color label.  

3． Click the Texture button of color texture mapping. 

4． Select the required normal plant pattern file by browsing. 

5． Switch to Stencil label. Click the big button of stencil texture 

map. 

 

6． Select to get the correlative black and white picture of plant. 
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Note: all texture mappings can be used together, among the 

stencil type is the first to be processed. For example, a 

transparency and a stencil texture mapping can be used together, 

and the system will first process stencil texture mapping, then 

process the transparency. In addition, all texture mappings use 

the same coordinate (please refer to next section for texture map 

coordinate). 

 

The integrated effect of plant through stencil and color texture 

mappings 

 

 Bump texture mapping 

It can use pattern to simulate concavo-convex effect on the object 

surface. Presently, the system only support reflective bump texture 

mapping. It needs to meet one of two conditions to make bump 

texture mapping work: 

Condition 1: the reflection parameter of material must not be 0. 

Condition 2: the light source with Calculate direct illumination option 

open can shoot the object surface  

Basic operations: 

1． Open the Material Editor. 

2． Switch to Bump label.  

3． Click the Texture button of bump texture mapping. 

4． Select the bump pattern file by browsing. 

5． Set the bump parameter. The bigger the value, the greater the 
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bump. 

 

 Emit texture mapping 

Emit texture mapping is a kind of black and white picture, whose 

supporting formats include JPG, BMP and TIF. It requires that the 

black part of the picture be pure black, while the white part is pure 

white. 

It can use the black and white pattern to control whether to display 

source light or not. The black part can display it, while the white part 

cannot display it. 

Basic operations: 

1． Open the Material Editor. 

2． Switch to Emit label. 

3． Click the Texture button of emit texture mapping. 

4． Select the required pattern file by browsing. 

 

 Wave effect 

Wave effect can be used to simulate water wave effect. 

Basic operations: 

1． Open the Material Editor. 

2． Switch to Wave label, and set the following parameters. 
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Wave numbers:  specify the number of the wave source 

center points, for example, if the value is 1, then 

it is equal to the effect of throwing a stone into the 

quiet lake surface. If the value is greater than 3, 

then you basically cannot see the location of 

those wave sources. 

Center: it is the coordinate location of wave source. 

Usually you need not to adjust it. 

Wave length: the distance between wave crests. 

Wave amplitude:  it is the wave amplitude. 

 

Wave effect 

§9.8.2 Material Library 

InteriCAD VR provides a material library. It has two functions: 

1. It provides lots of common materials and user can directly specify 

them to models.  
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2. User can directly save any material in a scene to the libraries. 

Introduction to material library interface: 

Select Material Library command and an interface appear, shown as the 

following: 

       

Catalog area includes three material libraries: system mat library, user 

define mat library and current scene 

System mat library——the system own material library, which includes 

a large number of materials. User cannot edit or modify this library. 

User define mat library——user can save his own materials to this 

library and edit them freely. 

Current scene——bill of materials in the current scene. 

 

The preview area can preview the information of texture map in the 

currently selected material  

Set material： 

Function: after selecting any material from a library, use the command 

to attach it to some object in the scene. 

Basic operations: 

1） After selecting a material, click Set material button; 

2） Then left click the model surface that is to be attached by this 

Preview area 

Catalog 
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material. 

You also can drag it to the model surface. 

Open 

Function: it is used to open material library file (file format: *.mlb). You 

can simultaneously open multiple .mlb files, each of which will 

generate a user-defined material library. You can find their 

corresponding library files. 

§9.8.3 Fit Map 

For painting and carpets, etc., the size of texture mapping coordinate is 

completely consistent with the maximal size of object surface. You can use this 

command to conveniently process such kind of texture mapping. 

            

 From the Material select FitMap. 

 You can see a prompt: select a surface:. Select the 

surface to be adjusted. Click OK and a dialogue box 

appears, shown as the following: 

 

 Input an angle in Orientation for rotating texture 

mapping. 

 The Number indicates how many texture mappings will 

be filled to that surface.  

 Mirror: U direction and V direction. 

§9.8.4 Edit Map 

InteriCAD VR can carry out the following edit operations to texture mapping 
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coordinate. 

1. Move texture mapping coordinate: 

 From the Material menu select Editmap, then Move. 

 You can see a prompt: Select a surface:. Left click that surface to be 

edited. After selecting, click the right button or press Enter to determine. 

This selection operation is completely the same as that of ACAD. 

 Left click a point as the base point for moving.  

 Move the mouse, and you can find that the texture mapping also moves 

following the mouse，then, click left button to confirm the modification.  

2. Rotate texture mapping coordinate: 

 From the Material menu select Editmap, then Rotate. 

 You can see a prompt: Select a surface:. Left click that surface to be 

edited. After selecting, right click or press Enter to determine. 

 Left click a point as the center point for rotating.  

 Move the mouse, and you can find that the texture mapping also rotates 

following the mouse. click left button to confirm the modification. 

3. Scale texture mapping coordinate: 

 From the Material menu select Editmap, then Scale. 

 You can see a prompt: Select a surface:. Click that surface to be edited 

using the left button. After selecting, click the right button or press Enter 

to determine. This selection operation is completely the same as that of 

ACAD. 

 Click a point using the left button as the base point for scaling, and then 

click another point as the reference point. 

 Move the mouse, and you can find that the texture mapping also scales 

following the mouse.  

 

4. Mirror texture mapping coordinate: 

 From the Material menu select Editmap, then Mirror. 

 You can see a prompt: Select a surface:. Left click that surface to be 
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edited. After selecting, right click or press Enter to determine. 

 Left click a point as the first point of mirror centerline, and then click 

another point as the other point of mirror centerline. 

 

5. Copy texture mapping coordinate: 

You can use this command to copy texture mapping coordinate to some 

objects or surfaces, that is, copy the texture mapping coordinate used by an 

object or other surface.  

 From the Material menu select Copy.  

 Move the mouse cursor to an object surface proving texture mapping 

coordinate and keep left click the button .Now the mouse changes to 

another icon , shown as the following figure. 

 Drag it to the object surface on which the texture mapping coordinate will 

be copied. Release the left button, and then the texture mapping 

coordinate has been copied to it. 

Note: the copy of texture mapping coordinate is to copy that of on an object 

completely to B object and this process is independent of their shapes. But A 

and B must be in same coordinate system. 

§9.8.5 Reset Map 

When some fabric material has been assigned to a sofa, you should also 

control how its texture is presented on that model, for example, the texture size 

and texture mapping mode. As long as this material has used color texture 

mapping, we can control how this color texture mapping Wraps the model.  

A. Four types of texture mapping coordinate 

The mode for color texture mapping to Wrap model is coordinate. InteriCAD VR 

provides totally four types of texture mapping 

coordinate: 

Auto Map: 

According to each surface‟s direction of object, 
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automatically align every surface to project. Also, you can control the size of 

image. 

 

Plan Map: 

Project an image to object‟s surface with the 

mode of projector. But you can only project to 

one surface, and images not in this surface 

will be distorted. Also you can control the 

size of image on the surface and the start position of image. Usually it 

is used in such objects as floor, wall, ceiling, which have only one 

surface. 

 

Cylinder Map: 

It is used to project an image to a cylinder object and 

the cylinder surface will be wrapped by this image 

except top surface and bottom surface. You also can 

control the size of image. 

 

Sphere Map: 

It is used to project an image to a sphere.  

Note that the concept of texture mapping coordinate 

is pertinent to the color texture mapping material and 

it is meaningless to adjust texture mapping coordinate 

for some material without color texture mapping. 

Basic operations: 

1. How to set auto texture mapping coordinate: 

 From the Material menu select Resetmap, then Auto Map. 

 Left click relevant surface and right click. 

Note: this operation will automatically clear out existing texture mapping 

coordinate setting on the selected surface. The default size of auto texture 
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mapping coordinate is 500×500×500. 

  

2. How to set plan texture mapping coordinate: 

 From the Material menu select Resetmap, then Plan Map. 

 Left click relevant surface and right click. 

Note: this operation will automatically clear out existing texture mapping 

coordinate setting on the selected surface. The default size of plan texture 

mapping coordinate is 500×500. 

 

3. How to set cylinder texture mapping coordinate: 

 From the Material menu select Resetmap, then select Cylinder Map. 

 Left click relevant surface and right click. 

Note: this operation will automatically clear out existing texture mapping 

coordinate setting on the selected surface. 

 

4. How to set sphere texture mapping coordinate: 

 From the Material menu select Resetmap, then Sphere Map. 

 Left click relevant surface and right click to enter. 

 

B. Relations between four types of texture mapping coordinate and UCS 

The texture mapping coordinate is closely relevant to user coordinate system 

(UCS). The status of UCS may have the same texture mapping coordinate 

produce completely different effect.  

Relation between plan texture mapping coordinate and UCS: 

The origin of UCS is projection location point and the red axis (Z-axis) specifies 

the projection direction of texture mapping coordinate. The UCS of the first 

view, shown as fellows, is on the top surface of that cube, while that of the 

second view is on the front surface. From the two views, you can observe that 

the red axis should determine the projection direction of texture mapping. In 

addition, the origin of UCS corresponds to the left lower corner point. 
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The green axis (X-axis) of UCS is consistent with the horizontal direction of 

texture mapping, while the blue axis (Y-axis) is consistent with the vertical 

direction. 

         

 

The relation between auto texture mapping and UCS is similar to that of 

plan texture coordinate. 

 

Relation between cylinder texture mapping coordinate and UCS:  

The origin of UCS is at the center axis of cylinder texture mapping and the red 

axis is superposed with the center axis. The second view, shown as fellows, 

has produced serious distortion of entire texture map because the origin of 

UCS is not close to the center of that cylinder. 
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Relation between sphere texture mapping coordinate and UCS:  

The origin of UCS is that of sphere texture mapping coordinate. 

§9.8.6 Random Material 

In order to let designers devote more time on creation rather than making, 

InteriCAD VR provides an excellent tool, Intelligent Match-color, which has the 

following capabilities: 

1． It can call existing match-color plan for interior ceiling, floor and 

walls. 

2． It can gradually change color and automatically replace texture 

mapping for single object. 

3． User can random add and edit match-color library using the 

developed database. 

 

Operation: 

1． Automatic match-color and selecting for ceiling, 

floor and walls in a scene 

 From Material menu select Random Material 

and a dialogue box shown as the following 

appears. 

 

 

 

 

 

 Right click on the ceiling to set the 

Ceiling surface. In the popup menu 

select Ceiling surface. 
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 Repeat the above to set floor and walls. 

 In the Room Style select corresponding 

scene room. 

 

 Click Auto change color button. 

 Now the scene automatically applies some 

plan in the library to replace materials of ceiling, floor and walls. At 

the lower part of the dialogue box, you can see the plan number 

currently used. 

 Click Stop button to stop selection, and now you can input a 

satisfactory plan. 

 Shown as the following figure, input 4 in the field, then click 

forward or  backward button to switch to plan 4. 

 

 You can also click the arrow button to browse all plans and 

choose from them. 

 

 

Manually forward b

l 
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2． Learn how to change color of a single object 

 Right click any object, and select Change Color option from the 

popup menu. 

 

 Now the panel automatically switches for color changing. 

 

 Click Auto Change Color to cycle color, and you can also activate 

saturation and lightness to change. 

 Click Stop button to stop auto change color, and you can also drag 

slider to change color using the mouse. 

3． Learn how to change texture map for a single object 

 Right click the object surface, and choose Select Map menu. A 

dialogue box appears, asking you to select a directory. 

 

 After selecting corresponding directory, a dialogue box appears. 

The dialogue box is similar to Expert match-color dialogue box 

and their operations is basically the same. 
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 In addition, to make the operation more convenience. This menu 

is generated by clicking the right button to provide Restore to 

original material and Clear map function. Note: Restore to original 

material function can only return the dialogue box to its original 

status. If after adjustment you close the Intelligent Match-color, 

then the system cannot return to the most original material 

information when you open it again. 

 

4． Save match-color plan 

 First specify the ceiling, ground and wall. Only at that time can the 

Add to lib button be activated. 

 Click the Add to lib button, and input relevant information in the 

popup box, and click Ok to save it. All information can be 

searched through the Search function. Note: you may not select 

Room style. If you directly input some information into the field, 

then it will create a new directory. 

 

 After inputting these parameters, click Ok. Close the entire 

Intelligent Match-color. When you open it again, you will find the 

new-added plan. 

5． Maintenance to match-color plan 

The match-color library is based on database, so its management, edit 
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and backup function are very easily to use.  

 Edit or delete existing plan 

Operation: 

1. Click Lib Maintain, and a dialogue box popup, shown as the 

following: 

 

2. In the Name & class field select a plan to be edited or deleted. 

3. If you want to edit the plan, click Modify, then you can modify its 

name, description and details. However, the materials used by 

this plan cannot be changed. 

4. If you want to delete the plan, click Delete button. If you 

subsequently click OK, then the plan has been deleted. 

 

 Backup of plan database and texture mapping, and merge of 

databases 

1. Backup function can backup currently selected plan. The backup 

file is colorplan.dat. Note that if you have already saved a backup 

file, you can repeatedly backup other plans into the file, and 

needn‟t to set it every time.  

2. Backup all can backup the entire match-color library. 

3. Merge function can merge databases for backup file. 

4. Pickup Map can backup all mappings used by the plan to a 

directory. Note that only those mappings under the CAD search 

path can be found. The other files that cannot be found will be 

indicated in a .txt file. 
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§9.9 Tiling 

§9.9.1 Tiling Design 

Layout ceramic slices on object surface in Render. 

Basic operations: 

1． Select the Tiling Design command from the Tiling menu; 

2． Left click to select the object surface to layout ceramic slices. For example, 

the floor surface in the following image; 

 
3． System will start the 2D Design module automatically, and then import the 

selected surface; 



InteriCAD T5 User Manual 

 350 

 

4． layout ceramic slices in 2D Design module, and then use Update VR 

command to export them to Render; 

 
5． System switches to Render module automatically, and the ceramic slices 

have been applied to corresponding surface. 
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§9.9.2 Clear Tiling 

Delete all the ceramic slices on a surface in Render module. 

Basic operations: 

1. Select the Clear Tiling command from the Tiling menu; 

2. Left click to select the surface to delete all the ceramic slices on it. 

§9.9.3 Apply Tiling Plan 

Use existing plan in the Tile Plan library to directly layout ceramic slices on a 

wall surface in Render module. 

Basic operations: 

Select the Apply Tiling Plan command from the Tiling menu; 

It pops up the Tile Plan dialog box. Select a plan in it; 
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Double click on an item, and left click to select a surface. And then system will 

apply selected plan to that surface; 
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§9.9.4 Replace Tile 

Change existing ceramic slices to selected library item. 

Basic operations: 

1． Select the Replace Tile command from the Tiling menu; 

2． Left click on a ceramic slice to be replaced; 

3． It pops up the Select ceramic dialog box; 

 

4． Double click on an item, or left click on it and click OK button; 

5． It pops up a dialog box, you can choose whether to replace all the same 

ceramic slices on the surface or only the selected ceramic slice; 

6． Select an option and click OK button. System will replace the ceramic slice with 

selected library item. 

§9.9.5 Split Surface 

Split a surface in Render module. 

Basic operations: 
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1. Select the Split Surface from Tiling. 

 
2. Select the surface you want to split according to the prompt.  

3. There are three types to split: 

By Region 

There are two options to create region. One is to select Rectangle and other is 

to select Polygon. Pick the point to define an area, right click to finish. Next, 

press Split to separate the surface. 

By Height 

Input a value in the box beside or press the button accordingly to define a 

height in the scene. Next, press Split to separate the surface. 

By Line 

You can either input the exact coordinates of two points or click the two buttons 

accordingly to define a line to separate the surface. Next, press Split to 

separate the surface. 
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§9.9.6 Extrude Surface 

Extrude a surface in Render module. 

Basic operations: 

1. Select Extrude Surface from Tiling. 

2. Select a surface needed to be extruded, right click to confirm. 

3. Input the distance to extrude in the command window, press Enter to 

confirm. 

§9.9.7 Quotation 

Basic operations: 

1. Select the Quotation command from the Tiling menu; 

2. It pops up the Tiles Quotation dialog box. 

 

3. Press the Quotation button, and then it produces the same print manager 

as in 2D Design module; 
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4. You can modify this report list and print it out. 

§9.10 Light Setting 

InteriCAD VR uses radiosity render theory and 

all the light sources are based on physical 

optics. The integrated function is suitable for 

the lighting designer to make lighting analysis 

of the scene. 

There are totally four kinds of light sources in 

InteriCAD VR: general light, target spot, day 

light and photometric web, among which 

general light, target spot and photometric web 

are solid light sources. What is called solid 

light source is that the light source is real 3D 

model and after radiosity calculation, this 3D 
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model will shine as the light source in the physical world.  

General Light:  Diffusion Light 

Spot Light:     Emit directional rays and all the rays will concentrate in 

the circular cone. In addition, you can use direct lighting 

option to calculate clear shadow and light source illumination 

boundary. You can get real effect only after you make 

raytrace calculation. 

Sunlight: Parallel light, and all the rays are emitted parallel. You can get 

real effect only after you make raytrace calculation. 

IES:           Light source in IES format. 

§9.10.1 New Light 

From the Light Setting menu select New Light 

The mouse will become a blue cross. Use the left button to single click the 

corresponding surface. 

Right click to end operation. Please note that the operation of set light 

source can only set the surface as general light or remove the light source 

property of the surface. The settings of target spot entrance or day light 

entrance need to be completed in the operation of editing light source. 

§9.10.2 Clear Light Property 

Clear Light Property could cancel the light property of surface. 

From Light Setting menu select New Light. 

The mouse will become a blue cross. Use the left button to single click the 

corresponding surface. 

§9.10.3 Edit Light 

Select Edit Light from the Light Setting menu, or single click . The light 
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source edit dialogue box will appear. 

Now the mouse will become a selective frame and all the light sources on the 

screen will be displayed in red lines. 

Left click the corresponding light source and the selected light source will be 

displayed in yellow line. 

If there is more than one type of light sources in current selection, the Edit Light 

Source dialogue box will be displayed as the following image:   

 

There are two options for next step: 

1. Choose an item from the pull-down menu of Type, all selected light 

sources will be change to one type. 

2. Remove certain light sources to make current selection contains only 

one type of light source. 

 

Below is the instruction of the light source parameters:  

Name:      The name of the current light source 
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Type:       You can select the type of light source: general light, target 

spot and day light (entrance) 

RGB：     Use red, green and blue system to adjust the color of the light 

source. 

HSV：     Use the hue, saturation and value system to adjust the color of 

the light source. 

Power:      This is the intensity of the light source. Its unit is related to 

the physical type of the light source. For example, wattage is 

the unit of lamp power. 

Source Type: The type here refers to the physical type of the light source. 

For example, the incandescent lamp and fluorescent lamp that 

are both of 100w, the latter is much brighter than the former 

because the fluorescent lamp‟s ratio of electrical energy to 

luminous energy is higher than that of the incandescent lamp. 

The system has integrated the light intensity standard of electric 

lighting handbook. Generally, you should select the type of light 

source according to the actual situation. E.g.: common lamp 

should be incandescent lamp; Daylight lamp should be straight 

fluorescent lamp. 

Target Spot (H):   Control the horizontal lighting direction of day light and 

target spot. 

Target Spot (V):  Control the vertical lighting direction of day light and 

target spot. 

Beam Spread:         The coning angle lighted by target spot. 

Falloff: Target spot uses direct lighting option and will have clear 

light source boundary. This option cans smoother the 

light source boundary. 

Calculate Direct Lighting: This option is only valid for target spot. If you 

activate this option, target spot light will have clear 

shadow and lighting boundary after raytrace 
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calculation. 

Show Selected Only:  If this option is selected, only the name and 

power of currently selected light source will be 

displayed. 

Switch Off:  This light source will not be calculated in radiosity 

calculation. 

Eps:  Set the eps of this light source in radiosity 

calculation. 

Length: Set the minimum length of this light source in 

radiosity calculation. 

 

The following illustrates the setting of target spot: 

1. From the Light menu select Light property and Light source edit dialogue 

box appears. 

2. You can see that all the light sources are displayed in red lines and the 

mouse will become a selection cursor. You can use the left button to 

directly select and adjust light source. Now select a general light. 

3. The selected light source will be displayed in yellow line. All the 

parameters of the selected light source will appear in the light source edit 

dialogue box. First, we change its type to target spot light. 

Now you can see the conical projection area of target spot light clearly. 

Change the color of the light source, and the color of the cone is changing 

simultaneously. 

Single click the Pick button and left click on the other side of the floor. You 

can control the projection center of target spot. You can also control the 

projection direction using the sliding bar of target spot light (horizontal) and 

target spot light (vertical). 

Adjust the emission angle of target spot light to control the dimension of 

the coning angle. 

From the operations above, you can see that it is visual to set target spot 
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light.  

§9.10.4 Sunlight Setting 

1. From Light Setting single click Sunlight Setting 

Activate Activate Sunlight Effect. Note: This option must be activated, 

or day light will not perform calculation. 

Sunray (horizontal) sliding bar is 

used to adjust the horizontal 

incident angle of the sunray. 0 

degree indicates to sunray from the 

east, which corresponds to the 

negative direction of X-axis in 

ACAD plane drawing. 90 degrees 

correspond to the negative 

direction of Y-axis. 180 degrees 

correspond to the positive direction 

of X-axis and 270 degrees 

correspond to the positive direction 

of Y-axis. 

Sunray (vertical) sliding bar is to adjust the vertical incident angle of 

the sunray. For example, in summer noon, the sunray is basically 

vertical and the angle is from 85 to 90 degrees, while the sunray angle 

in early morning should be around 10 degrees. 

The background matching with day light is an intelligent module. It can 

be seen as a huge hemisphere. There is sky in the spherical surface 

and the bottom of the hemisphere is ground. What is called intelligent 

is that the combination use of background and the vertical incident 

angle of sunray. E.g.: when the vertical incident angle of sunray is 5 

degrees, the background sky is the sky of dusk; when the vertical 

incident angle of sunray is 60 degrees, the background sky is the sky 
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of bright blue. 

Atmospheric controls the sunray degree of the weather. The higher the 

value is, the finer the sky is. 

2. Preview button can preview the condition of the background. 

3. Click Exit button. 

 

Day Light Setting 

1. Select New Light from Light Setting menu, and then select the window 

glass to set as light source. 

2. From Light Setting menu select Sunlight Setting. 

3. Activate Activate Sunlight Effect. Note: This option must be activated, 

or day light will have no effect. 

4. Single click Exit button. 

5. From the Light Setting menu select Edit Light. 

6. Select the light source on the window and set its type as Day light 

(opening). Determine the incident angle of sunray using Pick button. 

Then exit. 

 

Note: when using this method to calculate the radiosity, use the 

default activated Calculate sunlight through option to raise the 

efficiency of radiosity calculation because the outer wall of the model 

will not be calculated in radiosity calculation. Only the day light within 

the board shape light source boundary will be calculated. 

The advantage of method 1 is that it is simple to set and is suitable for 

the scene with multi windows. Its disadvantage is that the setting of 

day light direction is not visual and the efficiency of radiosity 

calculation is not high. The advantage of method 2 is that the setting of 

day light direction is very visual and is suitable for the scene with one 

or two windows. Furthermore, its efficiency of radiosity calculation is 

high. Its disadvantage is that one more board should be built when 
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modeling. 

At last we will learn the setting of photometric web. 

An IES file is an analysis of a lamp, recording its luminous flux on each 

direction. It indicates the distribution and utilization of light in the space. 

Using IES light source in VR is to use IES file to control irradiation of the 

source. The two barrel lights below used two different IES file. 

      

Basic Operation: 

1. Switch type from General Light to 

Fixture in Edit Light Source dialog, a 

new window will pop up for selecting an 

IES file. The software provides several 

familiar IES types under 

InteriCADT5\vr\IES. After the IES file is 

selected, a green wireframe will appear 

on the lamp to indicate IES‟ irradiation 

area and energy distribution. 
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2. The light source use lum as its luminous flux unit. The actual 

brightness in scene is much related to the IES file itself. 

3. Illuminating angle (vertical / horizontal) and pick button have the same 

function of target spot, are used to control the light source‟s 

illuminating angle. 

4. IES can be set as 3 types: point / surface / linear light source. The 

latter two needs size definition for light source. 

5. The preview of IES is at the bottom left of the dialog. Click Select File 

to change IES file. 

Note: 

1. It’s not necessary to apply IES to every lamp. For example, you can 

use IES on wall lamps, leaving alone lamps in the middle of the room. 

2. IES is defaulted to use direct irradiation, which means in raytrace it 

would generate very sharp shadows. 

3. You should notice that when using IES to a lamp, light source will also 

leave shadow on the surface of the lamp. You can eliminate the 

shadow by changing the lamp’s material, which means setting 

reflection to 0. 

We can also use texture to realize some special light effects, as shown below: 
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This function is to place a glass board with pattern before the target spot light, 

shown in the picture. You can make the effect of some stage illuminations 

easily using this function. As you can perform radiosity, the effect generated by 

this function is more real. 

 

Basic Operations: 

1.  First create a Photometric Web texture mapping file, shown in the 

picture. Please note that the pattern that can be projected is the 

internally tangent circle part of this texture mapping. 

2. The operation is simple: assign this texture mapping to the solid 

model of target spot light using the method of assigning material 

directly. 

3. Its projection boundary is within the divergence angle of target spot 

light. All the patterns in the internally tangent circle part of the texture 

mapping will be projected. There is no need to set the texture 

mapping coordinate. 

 

Note: 

1. We will provide some Photometric Web texture mappings in the 

system: *\InteriCAD\ fashion maps\ for-light. And it is convenient to 

make this texture mapping by PHOTOSHOP or others software. 

2. You can use Photometric Web texture mapping only when it is target 



InteriCAD T5 User Manual 

 366 

spot light. Activate the Calculate Direct Lighting option of target spot 

light so that there will be clear pattern after raytrace. 

 

 The Management of Light Source Group and Adjustment 

InteriCAD VR provides light source grouping function and supports up to 

10 groups. You can redefine the group freely. The operation is the same as 

the common real-time strategy game, which is very convenient. 

The light source, grouping status and light intensity parameter can be 

displayed directly on the workspace. Shown as the following figure, these 

three spot lights have been set in one group named 3. The light intensity of 

all the three spot lights is 4 watt. 

 

Basic Operations: 

Select Lighting Edit command, the light source grouping status and its light 

intensity parameter will be displayed. 

First, left click light source (red color objects), and then add it with the 

operation SHIFT + left click. To remove the light source, also SHIFT + left 

click. 

Select the light source that will be grouped and use CTRL + (0~9) to make 

these light sources become one group. For example, CTRL + 1 means the 

name of this light source group is 1. 

It is very convenient for you to call the grouped light source. E.g.: Three 

groups, which are 1, 2, 3, have been grouped in the scene and you can 

select group 1 by simply clicking key 1 on the keyboard. 

The combination of groups is also very convenient. For example, you want 

to combine group 1 and group 2.   Single click key 1 on the keyboard to 
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select group 1 and press SHIFT + 2. So the group 1 and group 2 have 

been selected. Then press CTRL + 1 again to combine the two groups into 

one group. 

Modification of Light Group 

You can simultaneously modify the parameters of the selected light 

sources. 

Basic Operations: 

First, select the light source that will be adjusted from a group or directly 

choose multiple light sources. 

The operation is same as adjusting single light source except the use of 

Pick button. It can focus the illuminating center points of several target spot 

to one point. Shown as the following figure: 

 

The target spot light do not fit to this condition, you can use horizontal and 

vertical sliding bars of the incident angle to adjust it. 

§9.10.5 Lighting List 

Display all lights list in the scene. After selecting you can enter the Edit light 

menu.  

Select Lighting List from Light Setting menu. The Light source list box will pop 

up. 
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§9.10.6 Smart Light 

We have induced some light arrangement scheme from our analysis of lots of 

users‟ work. According to the area and the structure, the system selects 

scheme automatically to create preview picture for your choice. 

Basic operations: 

1. From Light Setting menu, select Smart Light. 

2. Four preview pictures with different light arrangement scheme and 

rendering effect appear in the popup dialogue box, select one. 

3. Click Setting, set up the value. 

 

Light Mode:           choose to determine day or light effect 

Note: The window and door in the scene must be set as light. 

Radiosity Times:       the calculating time for radiosity.  

Output Dimension:      the dimension of the output 
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§9.10.7 Smart Light Setting 

When using Smart Light command, all existing light sources will be turned off 

by default setting. 

Select Smart Light Setting command from Light Setting menu, and then use 

cursor to select certain light sources, left click to keep it being turned on.       

Basic operations: 

1.    Left click to select target light source, multiple selection is enabled. 

2.    Left click on selected light source again to remove it from current 

selection.    

3.    Right click to confirm the selection, and the command will be 

finished. 

4.    To change the setting, run Smart Light Setting command again. 

 

§9.10.8 Special Light 1 

Select Special Light 1 from Light Setting. According to the prompt, select the 

position of the lamp and then orientation points. You can select at most four 

orientation points. The system can automatically generate four shot lamps on 
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the appointed positions, which shoot to the four orientation points. The default 

value of lamp height is 2200mm and power is 40 watt. 

§9.10.9 Special Light 2 

Select Special Light 2 from Light Setting. According to the prompt, select the 

position of the lamp and then orientation points. You can select at most four 

orientation points. The system can automatically generate four shot lamps on 

the appointed positions, which shoot to the four orientation points. The default 

value of lamp height is 2200mm and power is 500 watt. 

§9.10.10  Delete Special Light 

Select Delete Special Light from Light Setting, and then the system will delete 

all special lights in the scene. 

§9.11 Render 

§9.11.1 Start Radiosity 

When performing render calculation, the light 

calculation can be the same as that of the 

physical world reflection. When the light 

illuminate a surface, it will be reflected by the 

surface again until the light attenuate 

completely.  

After the scene has been prepared (front and 

back surface, material and lighing have all been 

set), you can perform radiosity. Single click 

Raodisity button . In the popup dialogue box, 

the system provides three calculation methods 
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to control the times of radiosity. In addition, it also provides two calculation 

precisions to control the quality of the image. 

§9.11.1.1 Three Calculation Method 

1. Continue until stop button is pressed: as the radiosity calculation is 

repeatedly, the more the number of calculation times is, the better the 

effect is. To stop the calculation of this method, press “stop” button. 

2.  Stop running after () times: 

    This option can control the number of times that the calculation will be 

performed and then the radiosity calculation will be terminated 

automatically.  

3.  Stop running after () minutes: 

This option can control the time that the calculation will be performed 

and after that the radiosity calculation will be terminated automatically. 

These three options can be used according to your personal custom. 

You can still go on calculating using the exist calculation result after the 

radiosity calculation terminates, so it is recommended that you calculate 

first using customized number of calculation times. If the effect is good, 

you can single click “radiosity” button again to continue calculating. 

§9.11.1.2 Three Calculation Precisions: 

1.  Normal Precision: 

The process to the surface is relatively reasonable. The effect will be 

good after twice or three times of calculation and correspondingly, the 

calculation time need is less. Meanwhile, it uses less system resource, 

especially the memory usage. 

2.  High Precision: 

The subdivision level of the surface is much higher than normal 

precision. The shadow effect of light and transition effect of halo are rich 
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than normal precision. Correspondingly, the required number of 

calculation times is higher than the normal precision. In addition, it 

requires more system resource as the number of surfaces that will be 

calculated is higher. 

3．User Define 

Before using user-defined precision, you should understand how the system 

performs radiosity: When enter virtual roaming, the surface is divided 

according to division length parameter in InteriCAD VR. If the default precision 

is 800, all the surfaces will be divided to the patch whose length of the right 

angle side is 800. 

Radiosity will subdivide the patch surface whose length of the right angle side 

is 800. The patch that is far away from the light will not be subdivides, for 

example. The precision parameter here that controls the surface subdivision is 

epsilon. When the value of the light energy received by a patch surface 

exceeds this parameter, the patch surface will be continuously divided. The 

smaller the area of the patch surface is, the less the light energy it can receive.  

The division continues until the value of the light energy is smaller than the light 

energy limit parameter. No matter how many times it calculates, the patch 

surface will not be subdivided. The value of epsilon supports scientific notation, 

for instance, 1e-006 is 0.000001. Under the same lighting condition, the 

smaller the value is, the smaller the area of the subdivision surface is. 

The second parameter is subdividing length. This parameter controls the size 

of the minimum subdivision surface. Without this parameter, the surface that is 

very near to the light source will be subdivided endlessly, which can cause the 

system out of resource. Furthermore, if the scene is very big, such as a scene 

of 1000 square meters, a higher subdivide length should be used to raise 

working efficiency. 

In addition, during radiosity calculation, different epsilon and subdivide length 

can be applied to the direct surface illuminated by the light source and the 

indirect surface illuminated by the second reflection light. As the light energy is 
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abundant for the surface that illuminated by the light source, the effect may be 

good using high precision and small subdivide length; as the light energy is 

relatively small for the second reflection light, using lower precision and higher 

subdivide lengthen will improve the radiosity calculation efficiency. 

The third parameter is diffuse factor. This factor has great affect on the radiosity 

calculation result. Take a scene with many light sources and many white 

surfaces as an example. After some times of radiosity calculation, the whole 

scene will become no levels. Because the indirect light will illuminate the part 

that originally has shadow. As the shadow becomes unclear or pale in color, the 

whole scene will become no levels. 

The diffuse factor is used to control the attenuation level of indirect light. Value 

1 of this parameter means the pure white material will reflect 100% light energy 

for secondary lighting. Value 0 means this surface will absorb all the light, 

which equals no indirect lighting. This parameter should be specified according 

to solid conditions. For the scene that has numerous light sources, this value 

can be lower down. In most cases, the default value 0.9 is ok. 

Under most circumstances, the effect will be good using normal precision while 

the high precision takes much longer calculation time. It will take the current 

mainstream computer several minutes to calculate a moderately scene using 

normal precision and half an hour for high precision. The value of user define 

precision can be set between these two values as a compromise scheme. 

§9.11.1.3 Sky method 

Indoor 

When render the interior environment, please Indoor Sky Method. If we have 

defined the sunlight, please choose Calculate Sunlight Though Opening Only. 

In this way, we can improve the render speed. 

 

Ourdoor 
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When render the exterior environment, please choose Outdoor Sky Method. 

Note: Sky Setting command must be activated when rendering exterior 

environment. For sunshine effect: please choose Activate Sunlight Effect and 

Activate Sky Effect. For cloudy weather, please choose Activate Sky Effect.  

When you choose Outdoor in Sky method, you will find there are three kinds of 

Sky Light Precision, the higher the value, the better effect we will get. But if you 

input higher value, the system will be slow because InteriCAD is occupying 

more and more computer resource when rendering.   

Note: when using this method to calculate radiosity, you must remove the 

activate status of Calculate sunlight through. Otherwise you cannot see the 

effect. 

 

In some cases, to cancel radiosity calculation is to return to the status before 

using radiosity from the status after using that. For example, you may do this 

when you find that the orientation of some face is not right. When this happens, 

you have to return to the status before using radiosity to adjust the surface. Do 

as follows: 

 From the Render menu select Reset Radiosity. 

 In the popup dialogue box, single click Y. 

 

Before radiosity calculation, you should set the subdivide length and 

epsilon. The radiosity calculation dialogue box provides an integral setting. 

But it is not enough. E.g.: the ceiling board lighted by the light trap should 

represent homogeneous graduation effect light. But neither normal nor 

high precision subdivide length can fulfill this requirement. So you can set 
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the ceiling board surface to be calculated according to a higher subdivide 

length. The system provides this function. Do as follows: 

 Select Surface Radiosity Setting from Optimize menu. 

 Left click the surface that will be adjusted, with pressing Shift for 

multiple selection. 

 Right click then the Surface option dialogue box will pop-up. 

 

 Default precision follows global setting. Remove ticks before 

Global, and input appropriate precision value. 

§9.11.2  Raytrace & Partial Raytrace 

Raytrace technology in InteriCAD VR can affect day light, target spot light and 

material (such as highlight material, metal and glass), etc. And the effect is real 

while the calculation speed is fast. 

Besides that, day light, target spot light will have clear shadow and lighting 

boundary only under raytrace option. Furthermore, all the special effect texture 

mappings need the support of raytrace. It is recommended that the final result 

be export using raytrace. 

Raytrace calculation can be performed before and after radiosity.  The table 

below is the comparison of the two: 

raytrace before radiosity raytrace after radiosity 

The effect is not very real The effect is real 

Only the target spot that calculates the 

direct light can function. 

All the light source lighting effects of 

InteriCAD VR can be reflected  
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One ambient light performs main 

lighting effect in the scene 

No ambient light, all the lightings are 

received using radiosity calculation 

Save time Take more time than the former 

 

Raytrace after Radiosity: 

 After you perform radiosity to the scene, you should perform raytrace 

preview calculation first. 

 Single click Raytrace button  , or use Partial raytrace , switch to 

Raytrace label to get the result more quickly. 

 

 As it is preview calculation, it is ok to use the quick default method. 

 Single click the OK button, the system will perform raytrace calculation to 

the perspective workspace. If you are not satisfied with the effect, for 

example, the mirror effect of the material is too strong, you can modify the 

property of the material directly. Save the final result until you are satisfied 

with the effect. 

Raytrace before Radiosity: 

 Single click Raytrace button  , or use Partial raytrace  to get the 

result more quickly 

 As it is preview calculation, it is ok to use the quick default method. 

 Single click the OK button, the system will perform raytrace calculation to 

the perspective workspace. If you are not satisfied with the effect, for 
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example, the mirror effect of the material is too strong; you can modify the 

property of the material directly. In addition, in the scene, only the target 

spot light and day light that can calculate direct lighting will function. Adjust 

the setting of the ambient light and it will change the effect intensity of 

target spot light and day light. 

 From the Render menu select Environment Setting. 

 Set corresponding parameter in the appeared dialogue box. 

Ambient light intensity is displayed in scientific counting method. 

The default value is 5E-005. If you want to increase the ambient 

light, you can adjust the value to 1E-004 so that the light intensity 

can be increase. 

 

 Save the final result until you are satisfied with the effect. 

Photon Map Raytrace 

Based on the original Raytrace, the new Photon Map Raytrace has made in 

rendering a comprehensive upgrade. It brings a complete elimination of 

interference and light leak, simplifying operation and reducing the difficulty of 

modeling.  

 

The table below is the comparison of the two: 

Raytrace Photon Map Raytrace 

Can be performed before and after 

radiosity 

Can only be performed after 

radiosity 

Need more time to render a clean 

scene; Radiosity is the main calculation 

process 

Do not need to render a clean scene 

first; Ratrace is the main calculation 

process 
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Need optimization to eliminate 

interference and light leak. 

Don‟t need optimization to eliminate 

interference and light leak. 

Bump effect and Gloss effect need to 

resort to direct light function and are 

lack of realness. 

Bump effect and Gloss effect don‟t 

need to resort to direct light function 

and are of strong realness. 

Need to set up parameters for Antialias. 

The higher the value is, the longer it 

takes to calculate.   

Do not need to set up parameters for 

Antialias. 

Use one-time calculation method; 

quality of rendering is determined by 

the result of Radiosity. 

Use cumulative method of 

calculation, the longer the 

calculation time is, the better the 

rendering quality is. 

Rendering quality in detail is lack of 

realness. 

Rendering quality in detail is of 

strong realness. 

 Single click Raytrace button  , or use Partial raytrace , switch to 

Photon Map Raytrace label to get more precise result. 

 

 Input the number of times of calculation before stop, program will start 

Raytrace for the scene and stop automatically according to the setting. If 

click Infinite, Raytrace process must be stopped by hand. Click OK to start 

calculation. 

§9.11.3  Stop 
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Stop calculation when performing raytrace or radiosity. 

Basic operations: 

Select Stop from Render. 

 

§9.11.4  Instant Render On/Off 

To get satisfying light effects in Render, User would frequently start radiosity 

and reset radiosity. On the other hand, User can not edit blocks after radiosity. 

This is an obstacle for improving User‟s work efficiency. For this reason, 

InteriCAD T5 developed the Instant Render technology to show lights while 

editing, improves User‟s work efficiency greatly. 

Steps: 

1. Select Instant Render On/Off from Render menu. It is set to off at default. 

Clicking this command for the first time turns on Instant Render, the next 

time turns it off. 

2. When Instant Render is turned on, the software will display real-time light 

effect. But this mode supports only point / linear / surface light source in 

Target Spot type, and IES light source. 

3. In this mode, you can move freely with lights on, and do all kinds of edit. 

4. After you have done any edit to light, or edit to object that would 

significantly change light effects, remember to select Instant Render 

Refresh from Render menu to update light effects. 

§9.11.5  Instant Render Refresh 

Update light effects after any edit has been done to light. 

Basic operations: 

Select Instant Render Refresh from Render. 

§9.11.6  Set Background 
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This mode is used in interior design.  

Select Set Background from Render, Background Option dialog will pop up. 

1. Sky: This is the default background mode which will show the 

background in blue.  

2. Color: You can change the background color you want in this mode.  

3. Texture: You can select a jpg, tif, or bmp format picture as the 

background.  

Mirror Background Mode  

This mode is used in exterior design.  

1. Sky: This is the default setting of the background while doing the exterior 

design. All the windows or glass will appear to be blue while looking from 

outside.  

2. Brightness: You can change reflective color of the windows or glass as well 

as the brightness in this mode. 

 

§9.11.7  Light Adjustment 

From the Render menu single click Light adjustment or click  button. 

The following dialogue box will appear before using radiosity and you can 
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adjust the brightness of the whole scene. 

 

 

The following dialogue box will appear after radiosity. 

The effect previewed in this dialogue box is 

completely the same as that of after using raytrace, 

and the preview effect will change with the 

adjustment immediately. 

 

Basic Operations: 

1. Drag the Brightness slider to adjust the 

brightness of the whole scene and the preview picture will change without 

delay. The usage is visual. 

2. Drag the Exposure slider to adjust the exposure of 

the whole scene. 

3. Drag the Contrast slider to adjust the contrast of the 

whole scene. 

4. Drag Black and White sliders to adjust image levels. 

5. The function of Auto button is to have the system 

calculate an appropriate brightness automatically. 

 

§9.11.8  Light Adjustment 

without Radiosity 

 From the render menu single click Light Adjustment Without Radiosity 

command. 

 

Basic Operations: 
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1. Drag the Brightness slider to adjust the brightness 

of the whole scene and the preview picture will 

change without delay. The usage is visual. 

2. Drag the Exposure slider to adjust the exposure of 

the whole scene.  

3. Drag the Contrast slider to adjust the contrast of the 

whole scene. 

4. Drag Black and White sliders to adjust image levels. 

5. The function of Auto button is to have the system 

calculate an appropriate brightness automatically. 

After using radiosity, the effect of this command is 

completely the same as that of light adjustment 

command. 

§9.11.9  Environment Setting 

 From the Render menu select Environment Setting. 

 Set corresponding parameter in the appeared dialogue box. 

Ambient light intensity is displayed in scientific counting method. 

The default value is 5E-005. If you want to increase the ambient 

light, you can adjust the value to 1E-004 so that the light intensity 

can be increase. 

 

 Save the final result until you are satisfied with the effect. 

 

§9.11.10 Reset Radiosity 

In some situations, you need cancel the radiosity computation, that is, 
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return to the status before radiosity from the status after radiosity. For 

example, if you find that the orientation of some faces is wrong, then you 

need return to the status before radiosity to adjust the obverse/reverse, as 

the following operations:  

 Select Reset Radiosity command from Render menu. 

 Click Yes in the popup dialog box. 

 

§9.11.11 Plot Area Preview 

This shows how the image will look when it is saved. 

Basic operations: 

 Select Plot Area Preview command from Render menu, a dialogue box will 

pops up: 

 

 Choose an image size in the pull-down menu of Usage, or choose User 

Defined to specify the image size manually; 

 Tick Preview option and click OK button, the size of the printing image will 

be changed. 
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 To exit the preview status, run Plot Area Preview command again, unpick 

the Preview option and click OK button. 

 

§9.11.12 Save Image 

 Move to a proper position with satisfactory view angle. 

 Single click the Save Image button  or select Save Image from 

Render menu 

 Determine the path and file name in the popup dialogue box. 

 Determine the resolution of the effect drawing in the dialogue box. If you 

use the printer to print the drawing, resolution 150 is more than sufficient. 
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Then select the image size that will be printed. 

 

 

 Choose a calculation method 

1. Raytrace 

a. The common setting of Antialias Pixel Point is 2x2 or 3x3 and 

Raytrace Max Depth is 5.  

b. As the time of calculation with blur effect will increase by 5 to 8 times, 

you can select quick mode to disable blur effect. 

c. Enable Shadow prediction can accelerate the speed of raytrace but 

errors may occur.Snapshot is general effect drawing. 

2. Photon Map Raytrace 

a The common setting of Raytrace Max Depth is 3. 

b As the time of calculation determines the rendering effect, the value of 

Scan times should not be less than 20. 

c Enabling Infinite will require manual operation to stop the calculation. 

 Set picture output type in Output Methods 

a. Snapshot is standard color picture. 

b. 3D glass is to make the 3D effect drawing that can be viewed by 3D 
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glasses. 

c. Panorama drawing is the drawing using the current position point as 

center and embrace 360 degrees to calculate the whole scene. You 

can use 3D Panoto to view it. 

 After all the options have been determined, single click OK button. The 

final result completes after the system automatically finishes calculation. 

§9.11.13 Additional Scan 

If using Photon Map Raytrace method to save an image with the name 

XXX.jpg. A file named XXX.jpg.buf will be created in the same directory. 

The XXX.jpg.buf file contains information of the finished image. Additional 

Scan command could use this information to render a better image base 

on the original one.  

 

Basic operations: 

 Select Additional Scan command from Render menu, a dialogue box will 

pops up; 

 

 Click  button to choose target image, make sure that the buf file is in 

the same directory, and the camera view should be the same as the target 

image; 

 Input a value in the input box of Additional Scan Times, click OK button; 

 Specify the name and path of new image; please do not replace the 

original file. 
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§9.11.14 Batch Render 

In InteriCAD T5, users can output a batch of renderings with Batch render 

function. All cameras of the renderings should be saved with View >> Save 

Camera at first. Please see the image below. 

 

Cameras of the renderings are to 

be saved. 
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Then Select Batch Render from Render, and then a dialog shows as below. 

 

Below are detailed instructions of Batch Render dialog. 

Radiosity Option Button: To show the Render Parameter option dialog for 

radiosity. These options will be used to the renderings to be saved.  

Raytrace Option Button: To show the Options dialog for raytrace. These 

options will be used to the renderings to be saved.  

Radiosity Check Box: If you have run Radiosity (Lights On) and get 

satisfied result, please cancel the check box, otherwise, please tick the 

check box and setup options for radiosity with Radiosity Option button. 

Image Size: Size of the renderings to be saved. 

Camera List: A list of cameras that are saved with View >> Save Camera. 

They could be copied to Render Cameras by -> button, or removed from 

Render Camera by <- button. Batch Render function will saved a rendering 

for each camera that is copied to Render Camera. 

Auto Brightness Check Box: To decide if Batch Render adjusts 

brightness of the renderings automatically before they are saved. If you 
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have run Radiosity (Lights On) and get satisfied result, please cancel the 

check box, otherwise, ticking the check box is recommended.  

Save MRS File When Finish: To decide if save the MRS file again after 

running Batch Render. If Radiosity check box is cancel, this option will gray 

out. 

Make Script File: To save the renderings. After it is clicked, a dialog shows 

as below to save the script. The rendering files will saved in a folder 

xxx_render together with the script file. xxx is the file title of the script file. 

 

Accept the folder and file name, and then a dialog shows as below. 

 

Click Yes to save the renderings. Below are saved images of above 

example. 
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§9.11.15  Channel Picture 

Output Channel Picture for further modification. There are three methods of 

output: by surface, by material, solid color with texture. 

Basic operations: 

1. Select Export Channel Picture from Render menu. 

2. Input file name and save path. 

3. Set output size and export method. 

 

 

 

4. Click OK to export. Results of different export methods are shown as 

below: 

 （By Surface） 
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 （By Material） 

          （Solid Color With Texture） 

§9.11.16  Hand Drawing 

There are two methods of export: Use Texture or No Texture 

Basic operations: 

1. Select Hand Drawing from Render menu 

2. Input file name and save path 

3. Set output size and export method. 
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4. Click OK to export, results are shown as below: 

 Use Texture 
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 No Texture 

§9.11.17  Export Dxf 

Export DXF file to give clients a better view of the scene‟s 3D structure and 

export 3D frame, 2D frame drawing and DXF from any angle for further edit in 

modeling, AutoCAD, BtoCAD. 

Basic operations: 

1. Select Export Dxf from Render menu, and then you can take a look at the 

preview in the pop-up dialogue. 

  （3Dframe） 
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      (2D frame drawing) 

2. Click Save, and input file name and save path. Result is shown as below: 



InteriCAD T5 User Manual 

 395 

 

§9.11.18  Net Render  

Note: This function is only available in network version. 

Preparation: 

1. All involved computers, at least two, should be installed InteriCAD T5. 

2. Authorization code of Net Render module is required for all involved 

computers. 

3. All involved computers should be in the same network segment and same 

group, for example, the IP should be 192.168.1.xx. 

4. Make sure all involved computers could be able to connect to each other, 

and Render.exe would not be blocked by firewall or any antivirus program. 

Operations: 

1. Divide all involved computers into two parts: set one as mater, and all the 

other as server. 

2. Run Render/Net Render Server on all servers, and give a unique user 

name for each server. Click Modify button to update. 

3. Open a mrs file on master, perform Radiosity, and then run Render/Net 

Render Monitor. 
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4. Click Start rendering button. 

 

Note: 

1． If it’s the first time to run Net Render module, system may ask you whether 

to block it or not, please choose unblock. 

2． If master cannot send the project to all servers, please restart the 

command on both sides. 

§9.12 Animation 

To make animation is one of current trends. InteriCAD VR provides simple but 

practical functions of making animation. 

System provides totally 5 methods of making animation: 

1. Record the condition that walking with the mouse. 

2. Set a polyline as the path of the camera. The orientation of the camera lens 

keeps the same as that of the tangent line of the polyline. 

3. Set two polylines, one as the path of the camera and the other as the path 

of the target point. 
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4. Set a polyline as the path of the camera. Set a fixed point as the target 

point. 

5. Set path in the top view of vender workspace. 

 

These 5 methods of setting animation have their own advantages. The third 

and fourth methods are recommended. 

Method 1: this method is the freest and the most visualized. But it is hard to 

use the mouse smoothly. When preview the animation, you can see that the 

picture dithering is big. 

Method 2: this method is easy to realize. But there will still be picture dithering 

at the position of polyline arc. 

Method 3: The setting is relatively complex as you have to draw two polylines. 

But the picture basically doesn‟t dither. 

Method 4: the picture is fluent and is suitable for the animation of single object 

or furniture decoration plan. 

Method 5: easy to realize. 

 

§9.12.1  Record 

1. Single click Record button . 

2. Then you can walk in the scene willfully. Note: you’d better walk in 

wireframe mode and the control of mouse is relatively easy. 

3. After you finish walking, single click Record button again to finish 

recording. 

§9.12.2  Select Path 

Basic Operation of Setting a Polyline as the Path of the Camera: 

1. Switch to Modeling and draw a line using Polyline command. 
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2. Switch back to the InteriCAD VR interface. From Animation menu 

select Select Path command. 

3. The default option Set Path For Camera in the pop-up dialogue box is 

ok. Single click the Select path button, and then the system will switch 

to Modeling automatically. 

 

 

4. Under the prompt of Select camera path select the polyline that has 

been drawn just now. 

5. The height of polyline drawn directly in the plane drawing should be 0. 

But the height of the camera path should not be 0. It is recommended 

that the starting height of the camera should be around 1500 to 

simulate the height of a people‟s eyes. So the default setting is ok. 

6. Input the total number of frames of the animation. 

7. Single click the OK button. 

 

Basic Operations of Setting the Path of Camera and Target Path 

1． Switch to Modeling and use polyline command to draw one polyline as the 

path of the camera and the other polyline as the path of the camera target 

point. 
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2． Switch back to the InteriCAD VR interface. From Animation menu select 

Select Path. 

3． In the pop-up dialogue box, select Set Path For Camera + Path For Target 

option. Then from Camera Height single click Select Path button, and then 

the system will switch to Modeling automatically. 

4． Under the prompt of Select camera path, select the already drawn polyline 

as the camera path. 

5． The height of polyline drawn directly in the plane drawing should be 0. But 

the height of the camera path should not be 0. It is recommended that the 

starting height of the camera should be around 1500 to simulate the height 

of a people‟s eyes. So the default setting is ok. 

6． From Target Height single click Select Path button. Set the target path 

using the same method of setting camera path. The height of the target 

path should be the same as the camera path in most cases. So, there will 

be the effect of plan view. 

7． Input the total number of frames of the animation. 

8． Single click the OK button. 

 

Basic Operations of Setting Camera Path and Target Point as Fixed 

Point 

1． Switch to Modeling and use polyline command to draw one polyline as the 

path of the camera. 

2． Switch back to the InteriCAD VR interface. From Animation menu single 

click Select Path. 

3． In the appeared dialogue box, select Set Path For Camera + Target Point 

option. Then from Camera Height single click Select Path button, and then 

the system will switch to Modeling automatically. 

4． Under the prompt select camera path, select the already drawn polyline as 

the camera path. 

5． Input the starting height of the camera path. 
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6． From Target Point Height single click Pick Point button, and then the 

system will switch to Modeling automatically. Left click in the top view of 

Modeling to determine one point as the target point. 

7． Input the height of the fixed point. 

8． Input the total number of frames of the animation. 

9． Single click the OK button. 

 

After finishing setting the animation path, you should perform animation 

preview to view the roughly effect. 

Animation preview is very important. The effect previewed is completely the 

same as that of the saved animation. If the picture dithers (dropped frames) in 

the preview, the saved animation file will have the same effect. Furthermore, 

the most important is the total number of frames determine the time of the 

animation. For example, if the total number is 300 frames and the preview play 

in 30frame/second, the time of the animation is 300÷30=10seconds. If the 

length of the polyline that is used as the path of the camera is 200 meters, the 

animation will make people feel that it is running like the wind at the speed of 

20meters/second. Note: if you feel the moving speed of the camera is too fast 

or too slow, don‟t adjust the number of frames per second but add or delete the 

total number of frames. 

§9.12.3  Set Path 

Select Set Path from Animation, the 3D view will switch to top view 

automatically, and then you can draw a path by left clicking on the screen. The 

image below shows an example, and the ordinal numbers indicate the order of 

clicking. 
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Right click to finish drawing the path. And then a dialog shows as below. 

                               

If Yes, that means you are staring at the same position when you are walking 

along the path. If No, that means you are looking ahead when you are walking 

along the path. After that, another dialog shows as below for more parameters 

of the path. 

                         

Each option is explained as below. 

Camera Height: You might treat it height your eyes. 

Ground Detection: Assume we input 1500 for Camera Height. If it is checked, 

when you are walking on a tread 200mm protruding from the ground, Camera 

The path 
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Height becomes 1700 accordingly. If unchecked, Camera Height keeps 1500 

constantly. 

Number of Frames: Larger number will lead to smoother result of the 

animation but bigger size of it, and also need more time to render it. If no 

special requirement, we recommend the default number. 

After accepting the options, another dialog shows to tell T5 if preview the 

animation or not right now. 

                               
After the operations above, you can: 1. save the path, 2. preview the animation, 

3. make an animation. 

§9.12.4  Load Path 

Select Load Path from Animation, and then a dialog show as below, to get the 

file to be loaded. 

                        

 

§9.12.5  Save Path 

Select Save Path from Animation, and then a dialog show as below, to 

designate the folder and input the file name to save the path. 
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§9.12.6  Preview Animation 

1. Switch to wireframe mode after you set the animation. Then single click 

 Preview animation. 

2. In the appeared dialogue box, remove the activate status of Disable speed 

con option, which means do not use speed control and preview the 

animation at the fastest speed that the computer can run. 

 

3. Constant is set to 30 in common cases. 

4. Single click OK and the preview starts. It is allowed to switch to color mode 

or texture mode during preview. 

5. Right click to stop the animation preview. 
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§9.12.7  Make Animation 

1. After the animation preview completes, 

2. From the Animation menu select Make Animation. 

3. Set the save path and file name in the appeared dialogue box. 

4. Set the compression format of the animation. High quality compression 

formats are recommended, such as MPEG4 and Intel Indeo_Video. 

 

5. Compression Quality is usually set to 100, while deselecting Key Frame 

and Data Rate. 

6. Set the resolution ratio of the animation. 512x384 or 640x480 in common 

cases, or just select DVD format. 
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Set the Playback to 15 if you want to play the animation on the computer or 

set it to 30 if you want to make the animation to DVD. 

In other effects, antialias will increase the total saving time. It is 

recommended to use antialias (2X2) to get better effect. 

It is the same as making effect drawing that whether to use Quick Mode 

and Shadow Prediction. 

Save Every Frame function will export every frame of the animation for 

furthur edit. 

7． The system will start calculating automatically if you single click OK. 

8． The time needed to save the animation will appear in the status bar. We 

can single click Stop again to terminate the file saving process at any time.  

 

Note: the animation file save to the frame at which the process is terminated. 
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§9.13 Optimize 

§9.13.1  Optimize Surface 

Radiosity calculation is to subdivide the object surface into many small patch 

surfaces to calculate, and define the patch brightness display according to the 

condition that each patch receives luminous energy. If there is a surface 

intersecting with another one on the model surface (it is generally called 

interfere in the following contents), part of the patch surface that is subdivided 

by the intersection part will be sheltered by the interfered surface. And the 

luminous energy received by this patch surface is much less than the patch 

surface that is not interfered, which cause the brightness of this patch surface 

is much darker than the patch surface that is not interfered. Furthermore, the 

render quality will be affected. System provides surface optimization function to 

solve this problem. 

Basic operations: 

1. Select Optimize Surface from Optimize menu. Then cursor will turn into 

。 

2. Click the surface you wish to optimize, hold Shift to add more. 

3. Right click to confirm your selection, then software will start calculation 

automatically. Cursor will turn back to original style after operation is 

done. 

Note: 

Even if the selected surface is not intervened, the software will reset the 

surface to patches. You can change patch size through FileSettingVR 

Option, enter value for Mesh Size in the dialog. 
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§9.13.2  Optimize Option 

Set the minimum length of patch. 

Basic operations: 

1. Select Optimize Option from Optimize menu, then the Optimization Option 

dialog will pop up. 

2. Set the Min Cut Length for optimization, click OK to confirm. 

§9.13.3  Optimize Model 

For large-sized models or non-optimized 3D MAX models, if frequently used, 

might lead to excessive size of MRS file. Optimize Model function can be used 

to decrease surfaces of the model without prejudice to the appearance of it, 

hence to improve the calculating speed. 

Basic Operations: 

1.   Select Optimize Model from Optimize menu, and then left-click on a 

model, right-click to confirm. 

2    Enter a value in the pop-up dialog box. This value will determine the ratio 

between the surfaces of optimized model and those of original one. E.g.: value 

60 means surfaces for the optimized model is 60% to the original one. It is 

recommended that the input value range is between 30 and 90. 
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3.   Click OK to start calculating. The calculating time is depended on the 

complexity of the model.  

4    After calculation, the automatically pop-up dialog box will display 

optimization result; click Yes to keep the result, click No to ignore it.  

§9.13.4  Optimize Display 

If our current operation affects the display of workplace, the software will 

refresh the active window to assure the accuracy of display. If we operate in a 

huge or complicated scene, refresh rate will drop dramatically. Although we can 

change to wireframe mode to optimize speed, it will bring troubles for our 

operation. The software has provided functions to solve this problem. 

 Replace Blocks by Cuboid 

Replace all blocks in scene with cuboids, decrease the number of patches 

to increase refresh rate. The cuboid‟s size is equal to the block‟s maximum 

extension (only effective to mm objects) 

 Replace Selected by Cuboid 

Replace selected object with cuboid, decrease the number of patches to 

increase refresh rate. The cuboid‟s size is equal to the block‟s maximum 

extension (only effective to mm objects) 

 Return to Block 

Return Cuboid to Block. 

Note: 

Remember to return cuboid to block before radiosity, or radiosity will be 

calculated according to cuboids, and you can’t return to block after radiosity. 

 

InteriCAD VR also provides the command that can detach coplane surface and 

patch. The function of the two commands is to appoint the material 

conveniently. For example, you can appoint different materials to the six 

surfaces of a wall. 
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§9.13.5  Surface Radiosity Setting 

 Select Surface Radiosity Setting from Optimize menu. 

 Left click the surface that will be adjusted, with pressing Shift for 

multiple selection. 

 Right click then the Surface option dialogue box will pop-up. 

 

 Default precision follows global setting. Remove ticks before 

Global, and input appropriate precision value. 
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Chapter 10 Online Cloud Library 

Online Cloud Library is a brand new system developped by YFCAD, aiming to 

provide more efficient customized modeling service to individual users.  

Introduction 

Online Modeling Service contains 3 parts: Make Model, Check Model, and 

Recharge. 

 Make Model. This is for submitting model information.  

 Check Model. This is for checking the progress of modeling. Users can 

also send their feedbacks about the model to YFCAD. 

 Recharge. This is for the basic cost of the service. 

Basic Operations: 

Part1: Make Model  

1.  Double click destop icon  or icon  

under InteriCADT5\Imodel\iModelService or to run the application. 
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2. Fill in the detailed information of the model. Those blank boxes with „*‟ 

should not be empty. 

 

3. Click Next to continue or click Back to go back to the previous step. 

 

4. More material about the model is required, such as preview (*.jpg 

minimal size 800x600, Front view, Side view, Top view and 3D 
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perspective view are required), texture (*.jpg or *.bmp or *tif). Other 

material provided (e.g. *.dwg, *max. *dxf) will speed up the process. 

Click Add to add relevant material or just drag&drop to the dialog box. 

Click Remove to delete those you don‟t want to add. 

 

5. Click Next to continue or click Back to go back to the previous step. 

 

6. Select the type of the model. Price will be lower if you tick Share my 

model. Write down your requirements about the model under 

Decoration box, such as texture, other details, etc. 
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7. Click Next to continue or click Back to go back to the previous step. 

8. A list of detailed model information will be shown in the dialog.  

 

9.   Once you confrim, click Submit to upload the material to YFCAD. 
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Part2: Check Model  

1. Click  and switch to My Order to check how 

many models you have uploaded to YFCAD.  
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2. If the model you uploaded is proved, system will show its name and 

status (Submit). However, if the model material you uploaded is not 

enough or unqualified, you can check the preview image with Failure 

status and then double click to check the necessary material. The 

material required for the model will be listed in the dialog below. 

 

3. Click Feedback and you can continue to upload the necessary material 
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for the model.  

4. Meanwhile, you can also write down your comments to YFCAD once 

you have any question about the models. 

 

 

 

5. Click My Model to check the progress. Finished models will be shown 

here. 
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6. System will automatically download the model from YFCAD once it is 

finished. However, you can click Download to download the model 

again if you can not see it in the Online Cloud Library. 

 
7. Enter VR (3D) of InteriCAD T5 and switch to Online Cloud Library. 

Your required models will be shown and ready to be used. 
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Part3: Recharge  

Note: This service is still under construction.  

 

 

Note: Any further update about the manual, please contact us at support@yfcad.com. 
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